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Safety Guidelines

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

| AADANGER

indicates that death or severe personal injury will result if proper precautions are not taken.

AAWARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

A\CAUTION
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

CAUTION
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

NOTICE

indicates that an unintended result or situation can occur if the corresponding information is not taken into
account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to
property damage.

Qualified Personnel

The device/system may only be set up and used in conjunction with this documentation. Commissioning and
operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes
in this documentation qualified persons are defined as persons who are authorized to commission, ground and
label devices, systems and circuits in accordance with established safety practices and standards.

Prescribed Usage

Trademarks

Note the following:

AAWARNING

This device may only be used for the applications described in the catalog or the technical description and only
in connection with devices or components from other manufacturers which have been approved or
recommended by Siemens. Correct, reliable operation of the product requires proper transport, storage,
positioning and assembly as well as careful operation and maintenance.

All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the
owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the
information in this publication is reviewed regularly and any necessary corrections are included in subsequent
editions.

Siemens AG Ordernumber: 6AV6 691-1DM01-2AB0 Copyright © Siemens AG 2008.
Automation and Drives ® 04/2008 Technical data subject to change
Postfach 48 48

90327 NURNBERG

GERMANY
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Purpose of the operating instructions

These operating instructions provide information based on the requirements defined by
DIN EN 62079 for mechanical engineering documentation. This information relates to the
place of use, transport, storage, mounting, use and maintenance.

These operating instructions are intended for the following user groups:

Operators

The operator operates and monitors the system during the process control phase.
The following chapters are relevant to the operator:

— Operator controls and displays
— Operating a project

— Operating recipes

— Operating alarms
Commissioning engineers

The commissioning engineer integrates the HMI device into the system and ensures the
operating capability of the HMI device for the process control phase.

All the operating instructions are relevant for the commissioning engineer.

Depending on the use of the HMI device, certain chapters may not be of relevance to the
commissioning engineer, e.g. the chapter "Maintenance and care".

Service technicians
Service technicians rectify faults that occur during the process control phase.
The entire set of operating instructions is relevant to service technicians in principle.

Depending on the use of the HMI device, however, certain chapters may not be relevant
to them, e.g., the chapter on "Maintenance and care".

Maintenance technicians

Maintenance technicians carry out regular maintenance work during the process control
phase. The chapter on "Maintenance and care" is relevant to maintenance technicians.

The chapter "Safety instructions, standards and notes" should be particularly heeded by all
person groups.

The help integrated in WinCC flexible, the WinCC flexible Information System, contains
detailed information. The information system contains instructions, examples and reference
information in electronic form.

Mobile Panel 277 IWLAN
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Basic knowledge required

General knowledge of automation technology and process communication is needed to
understand the operating instructions.

It is also assumed that those using the manual have experience in using personal computers
and knowledge of Microsoft operating systems.

Scope of the operating instructions

These operating instructions apply to the Mobile Panel 277 IWLAN HMI device in
combination with the WinCC flexible software package.

Position in the information landscape

These operating instructions form part of the SIMATIC HMI documentation. The following
information provides you with an overview of the SIMATIC HMI information landscape.

User manuals

WinCC flexible Micro

Describes basic principles of configuration using the WinCC flexible Micro
Engineering System.

WinCC flexible Compact/ Standard/ Advanced

Describes basic principles of configuration using the WinCC flexible Compact
Engineering System/WinCC flexible Standard/WinCC flexible Advanced.

WinCC flexible Runtime
Describes how to commission and operate your runtime project on a PC.
WinCC flexible Migration

— Describes how to convert an existing ProTool project or WinCC project to
WinCC flexible.

Communication

— Communication Part 1 describes the connection of the HMI device to SIMATIC PLCs.
— Communication Part 2 describes the connection of the HMI device to third-party PLCs.

Getting started

WinCC flexible for first time users

Based on an example project, this is a step-by-step introduction to the basics of
configuring screens, alarms, recipes and screen navigation.

WinCC flexible for power users

Based on an example project, this is a step-by-step introduction to the basics of
configuring logs, project reports, scripts, user management, multilingual projects and
integration in STEP 7.

WinCC flexible options

Based on an example project, this is a step-by-step introduction to the basics of
configuring the WinCC flexible Sm@rtServices, Sm@rtAccess and OPC server options.

Mobile Panel 277 IWLAN

Introduces project design for WLAN communication step by step using a sample
structure.

Mobile Panel 277 IWLAN
Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0
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Operating instructions

Online availability

Operating instructions for SIMATIC HMI devices

— OP73,0P77A,0P 77B

— TP 170micro, TP 170A, TP 170B, OP 170B

— OP 73micro, TP 177micro

- TP 177A, TP 177B, OP 177B

- TP 270, OP 270

- TP 277,0P 277

- MP270B

- MP 277

- MP 370

- MP377

Operating instructions for mobile SIMATIC HMI devices
— Mobile Panel 177

— Mobile Panel 277

— Mobile Panel 277 IWLAN

— Mobile Panel 277F IWLAN

Operating instructions (compact) for SIMATIC HMI devices
- OP77B

— Mobile Panel 177

— Mobile Panel 277

Operating instructions for SIMATIC accessories

— Industrial USB Hub 4

Function manual

— Fail-safe operation of the Mobile Panel 277F IWLAN

Technical documentation on SIMATIC products and SIMATIC systems is available in PDF
format in various languages at the following addresses:

Screens

The HMI device is sometimes shown in the form of photographs in these operating

SIMATIC Guide Technical Documentation in German:

"http://www.ad.siemens.de/simatic/portal/html_00/techdoku.htm"

SIMATIC Guide for Technical Documentation in Enalish:

"http://www.ad.siemens.de/simatic/portal/html_76/techdoku.htm"

instructions. The photographs of the HMI device may differ slightly from the factory state of
the HMI device.

Mobile Panel 277 IWLAN

Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0


http://www.ad.siemens.de/simatic/portal/html_00/techdoku.htm
http://www.ad.siemens.de/simatic/portal/html_76/techdoku.htm

Preface

Conventions

Configuration and runtime software differ with regard to their names as follows:
e "WinCC flexible 2007" for example, refers to the configuration software

The term "WIinCC flexible" is used in a general context. The full name, for example
"WiInCC flexible 2007", is always used when it is necessary to differentiate between
different versions of the configuration software.

o "WinCC flexible Runtime" refers to the runtime software that can run on HMI devices
The name "Mobile Panel 277 Wireless" is the umbrella term for the following HMI devices:
® Mobile Panel 277 IWLAN

® Mobile Panel 277F IWLAN

The following text notation will facilitate reading these operating instructions:

Notation Scope

"Add screen" e Terminology that appears in the user interface, for example
dialog names, tabs, buttons, menu entries

e Inputs required, for example limit values, tag values
e Path information

"File > Edit" Operational sequences, for example, menu commands, context
menu commands

<F1>, <Alt+P> Keyboard operation

Please observe notes labeled as follows:

Note

Notes contain important information concerning the product, its use or a specific section of
the documentation to which you should pay particular attention.

Registered trademarks

Names labeled with a ® symbol are registered trademarks of the Siemens AG. Other names
used in this documentation may be trademarks, the use of which by third parties for their
own purposes could violate the rights of the owner.

e HMI®

e SIMATIC®

e SIMATIC HMI®

e SIMATIC ProTool®
e WinCC®

Representatives and offices

If you have any further questions relating to the products described in this manual, please
contact your local representative at the Siemens branch nearest you.

Your Siemens representative can be found at "http://www.siemens.com/automation/partner".

Mobile Panel 277 IWLAN
Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0
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Training center

Siemens AG offers a variety of training courses to familiarize you with automation systems.
Please contact your regional training center, or our central training center in 90327
Nuremberg, Germany, for details.

Phone: +49 (911) 895-3200

Internet: "http://www.sitrain.com"

Technical support
You can find technical support for all A&D projects

Using the support request form on the web at:
"http://www.siemens.de/automation/support-request”

Phone: + 49 180 5050 222
Fax: + 49 180 5050 223

Further information about our technical support is available on the Internet at
"http://www.siemens.com/automation/service".

Service & Support on the Internet

Service & Support provides additional comprehensive information on SIMATIC products
through online services at "http://www.siemens.com/automation/support":

® Newsletters with the latest information about your products

® A large document base is available using our Service & Support search engine
e A forum for global exchange of information by users and experts

® Current product information, FAQs and downloads

® Your local Automation & Drives representative

e Information about field service, repairs, spare parts and much more under the heading
"Services"

Recycling and disposal

Due to the low levels of pollutants in the HMI devices described in these operating
instructions, they can be recycled. For environment-friendly recycling and disposal of your
old equipment, contact a certified disposal facility for electronic scrap.

Mobile Panel 277 IWLAN
Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0 7
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Overview 1

1.1 Product overview

Expanded possible fields of application — with Mobile Panel 277 IWLAN
The SIMATIC Mobile Panel 277 IWLAN permits mobile operation at any point in the system.

The HMI device communicates with the PLC via WLAN. The Mobile Panel 277 IWLAN is
battery-powered. With the Mobile Panel 277 IWLAN the operator can operate the system
wirelessly at almost any location on the machine or system.

The simple battery-powered operation and ergonomic design of the HMI device permit safe
working with the Mobile Panel 277 IWLAN over extended periods.

The HMI device is equipped with a zone recognition function. The use of zone-specific
process displays assists the operator when operating the system.

The Mobile Panel 277 IWLAN offers short commissioning times, a large user memory and
high performance. The HMI device is optimized for projects based on WinCC flexible.

The Mobile Panel 277 IWLAN has the following features:
® Wireless operation with
— IWLAN interface via PROFINET
— Battery operation
® Zone recognition
7.5" TFT screen with 64k colors
18 function keys with LED
Extended HMI functions

Mobile Panel 277 IWLAN
Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0 15



Overview

1.2 Design of the HM/ device

1.2

1.21

Introduction

Front view

16

Design of the HMI device

Mobile Panel 277 IWLAN

The Mobile Panel 277 IWLAN is available in two design variations:
® With touch screen and function keys

e Also with handwheel, key-operated switch and two illuminated pushbuttons

Note
The Mobile Panel 277 IWLAN is intended to be operated with a battery.

The following figure shows the Mobile Panel 277 IWLAN. This can vary, depending on the
delivery status of the HMI device.

©

LED display

Display with touch screen
ON/OFF button

Covers for the labeling strip guides
Key-operated switch, optional
llluminated pushbutton, optional
Membrane keyboard

CECNONCNCNONONC)

Handwheel, optional

Mobile Panel 277 IWLAN
Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0



Overview

1.2 Design of the HM/ device

Side view

O] Handle

Rear view
On the reverse side you will find the type plate and approvals.

Handle

Connection compartment cover
Connection for tabletop power supply unit
Battery compartment cover

Charging contacts for charging station

®@Oe 66000

USB connector

The Mobile Panel 277 IWLAN can be securely fitted in a charging station.

Mobile Panel 277 IWLAN
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1.2 Design of the HM/ device

1.2.2 Accessory kit and other accessories

Accessory kit

Protective foil

Labeling strips

Memory card

The accessory kit is supplied with the HMI device.

The accessory kit for the HMI device contains the following:
® Main battery

® Bridging battery

® Cover cap with rubber seal

® Screws for fixing the cover cap

® | abel for cover cap

Additional documents may be enclosed with the accessory kit.

A protective foil kit can be ordered for the HMI device with the order number
6AV6 671-5BC00-0AXO.

The protective foil prevents the touch screen from being scratched or soiled.

Labeling strips can be ordered as accessories with the order number
6AV6 671-5BF00-0AX0. Stickers for the cover caps can also be supplied, in addition to the
labeling strips. The cover caps cover the slot openings for the labeling strips.

Note
Multimedia card

The multimedia card of the SIMATIC S7 PLC cannot be used.

Only use the SD memory cards or multimedia cards tested and approved by Siemens.

SIMATIC PC USB FlashDrive

Main battery

18

The SIMATIC PC USB FlashDrive is a mobile form of data storage with a high data
throughput, designed for industrial use.

The HMI device is designed to be operated by a battery. The main battery can be ordered
with the order number 6AV6 671-5CL00-0AXO0.

Mobile Panel 277 IWLAN
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1.2 Design of the HM/ device

Bridging battery

The bridging battery allows you to change the main battery during operation.

Charging station

The charging station is used to charge the battery in the HMI device and to safely store the
HMI device. You can also charge a main battery in each of the two charging compartments.
The charging station is designed to be used in the system.

The charging station can be ordered with the order number 6AV6 67 1-5CE00-0AXO0.

Tabletop power supply unit

You can operate the HMI device with a tabletop power supply unit. The tabletop power
supply unit is only suitable for an office environment. The tabletop power supply unit,
including main supply conductors (EU, US, UK, Japan), can be ordered with the order
number 6AV6 671-5CN00-0AX1.

Transponder

One or more transponders form zones in the system. The transponder can be ordered with
the order number 6AV6 671-5CM00-0AX0.

You can find more information about this on the Internet at:
"http://mall.automation.siemens.com"

1.2.3 Battery

Purpose
The HMI device is supplied with a main battery and a bridging battery.

Main battery and bridging battery

When fully charged, the main battery guarantees approximately 4 hours' operation time in
normal operation. After this time, the battery must be either changed or recharged.

You can change the main battery while the HMI device is operating. The bridging battery
supplies the power while the main battery is being changed.

While the power is being drawn from the bridging battery, the following features are
deactivated:

e Display backlighting

® Membrane keyboard

® Touch screen

e Function key LEDs

® |lluminated pushbuttons
e USB interface

Mobile Panel 277 IWLAN
Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0 19
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Overview

1.2 Design of the HM/ device

Charging options
To charge the main battery, you have the following possibilities:
® |n the HMI device while it is in the charging station
® |n the charging compartment of the charging station

® |n the HMI device when connected to the tabletop power supply unit

See also
Charging batteries in the charging compartment (Page 100)
Inserting, charging and changing the battery (Page 68)

1.24 Charging station

The following figure shows the charging station.

Lock

Hook for hooking in the HMI device

Charging compartment for one main battery each
Charging contacts for the HMI device

LED display

Power supply connection

®@Oe 66000

Mobile Panel 277 IWLAN
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Overview
1.3 Configuration and process control phase

Functions
The charging station performs the following functions:
® (Charging the batteries in the charging compartments of the charging station
e Supplying power to the HMI device
® (Charging the main battery fitted in the HMI device
e Safe storage of the HMI device

The lock prevents unauthorized removal of the HMI device from the charging station.

Accessory kit
The accessory kit is supplied with the charging station.
The accessory kit for the HMI device contains the following:
® |ock
e Key set for lock
® Counterpart for power supply connector

Additional documents may be enclosed with the accessory Kkit.

See also
Charging station (Page 100)

1.3 Configuration and process control phase

Introduction
You must follow the phases below in order to use an HMI device in the system:
® Configuration phase

® Process control phase

Configuration phase

The HMI device project, which includes the plant screens, is created during the
configuration phase.

The following actions are carried out as part of the configuration phase:
® Creating the project

e Testing the project

e Simulating the project

® Backing up the project

Mobile Panel 277 IWLAN
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Overview

1.3 Configuration and process control phase

After the configuration phase, the project is transferred to the HMI device by the
configuring PC.

- — > -
——=\ 980V
Configuring PC Mobile Panel 277 IWLAN

Process control phase

Once the project is transferred to the HMI device, the operator operates and monitors current
processes in the process control phase. The HMI device is connected to a PLC in the plant
and exchanges values with this PLC. The plant screens on the HMI devices are used to
provide a clear overview of the active processes.

The following figure shows an example of a system structure with the
Mobile Panel 277 IWLAN.

S§7 300 S7 400

il i

PROFINET >

L

i | U U
’ s 1| )
/0 as PROFINET 10 SCALANCE

ET 200S device Access Point

Mobile Panel 277 IWLAN

See also
Preparing and backing up a project|(Page 168)
Operating a project (Page 195)

Mobile Panel 277 IWLAN
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1.4 Transponder

14 Transponder

Zones

You can divide your system into zones.

A zone is a physical range for operator control and monitoring inside a plant and which is
registered by the HMI device. A zone is formed by one or more transponders.

Determining the current zone

Purpose

The assignment of transponders to zones is defined in the project.

Each transponder has a unique ID. The transmitting range of the transponder approximates
to a lobe shape with a range of approximately 8 m.

Distances are measured as follows:

e The HMI device sends signals in the current project

® The transponder responds to the signal from the HMI device and sends its ID to the
HMI device

® The HMI device evaluates the ID and only measures the distance between it and the
configured transponder(s)

Thus the HMI device determines which zone it is in.

Depending on the project design, the HMI device displays zone-specific process displays
and allows image objects to be operated in a zone-dependent manner.

Note

You can also operate the Mobile Panel 277 IWLAN in a system without zones. In this case,
no transponders are required in the system.

Installation and connection

Accessory kit

See also

You must install the transponders in the system such that the zones are covered by the
transmitting ranges of the relevant transponders.

The transponders are battery-operated.

The accessory kit is supplied with the transponder.
The accessory kit for the transponder contains the following:
® 3 AA mignon batteries, 1.5V

Additional documents may be enclosed with the accessory kit.

Setting transponder ID and inserting the battery (Page 51)
Zones (Page 45)

Radiation characteristic of the transponder|(Page 279)

Mobile Panel 277 IWLAN
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1.5 Functional scope with WinCC flexible

1.5 Functional scope with WinCC flexible

The following tables show the objects that can be integrated into a project for a
Mobile Panel 277 IWLAN.

Note

The specified values are maximum values of the individual objects. Simultaneous use of
multiple objects with their maximum value can lead to problems in the active project.

Alarms
Object Specification Mobile Panel 277 IWLAN
Alarm Number of discrete alarms 4,000
Number of analog alarms 200
Length of the alarm text 80 characters
Number of tags in an alarm Max. 8
Display Alarm line, Alarm window,
Alarm view
Acknowledge error alarms individually Yes
Acknowledge several error alarms simultaneously 16 alarm groups
(group acknowledgment of alarm groups)
Edit alarm Yes
Alarm indicator Yes
ALARM_S Display S7 alarms Yes
Alarm buffer retentive Alarm buffer capacity 512 alarms
Simultaneously queued alarm events Max. 250
View alarm Yes
Delete alarm buffer Yes
Line-by-line printing of alarms Yes

Tags, values and lists

Object Specification Mobile Panel 277 IWLAN

Tag Number 2,048

Limit value monitoring Input/Output Yes

Linear scaling Input/Output Yes

Text list Number 500 "

Graphics list Number 400 "

1 The maximum total of text and graphics lists is 500.

Mobile Panel 277 IWLAN
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1.5 Functional scope with WinCC flexible

Screens
Object Specification Mobile Panel 277 INLAN
Screen Number 500

Fields per screen 200

Tags per screen 200

Complex objects per screen (e.g. bars) 10

Template Yes
Recipes
Object Specification Mobile Panel 277 INLAN
Recipe Number 300

Data records per recipe 500

Entries per recipe 1,000

Recipe memory 64 KB

Location"

e Memory card
e USB memory stick
e Network drive

1 The number of recipe data records might be restricted by the capacity of the storage medium.

Logs
Note
The HMI devices are suitable for the logging of relatively small volumes of data.
Manage the data in several adjacent archives in a segmented circular log. The use of a large
circular log has a negative effect on performance.
Object Specification Mobile Panel 277 IWLAN
Logs Number of logs 20
Number of sub-archives with segmented circular log 400
Entries in each log including all partial logs 10,000
Filing format CSV with ANSI character set
Location™ e Memory card

e USB memory stick
o Network drive

1) The number of entries in the log may be restricted by the capacity of the storage medium.

Mobile Panel 277 IWLAN
Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0
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1.5 Functional scope with WinCC flexible

Safety
Object Specification Mobile Panel 277 IWLAN
User administration Number of user groups 50
Number of users 50
Number of authorizations 32

Infotexts
Object Specification Mobile Panel 277 IWLAN
Infotext Length (no. of characters) 320

(depending on font)

For alarms Yes
For screens Yes
For screen objects Yes

(for example for 1/O field, switch, button, invisible button)

Additional functions

Object Specification Mobile Panel 277 IWLAN
Monitor setting Touch screen calibration Yes
Brightness setting Yes
Language change Number of languages 16
VBScript User-specific extension of the functionality Yes
Number of scripts 50
Graphic object Vector and pixel graphics Yes
Trends Number 300
Task planner Number of tasks 48
Text objects Number 10,000
Direct keys PROFINET IO direct keys Yes

Device-specific functions

Object Specification Mobile Panel 277 IWLAN
Battery Displaying battery status Yes
WLAN quality Displaying WLAN quality Yes
Zone quality Displaying zone quality Yes
Zone name Displaying zone names Yes
Mobile Panel 277 IWLAN
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1.6 Software options

1.6 Software options

The following software options are available for the HMI device:
® WinCC flexible /Sm@rtService

The Sm@rtService option enables you to access a remote HMI device from the
HMI device or PC via Ethernet.

e WinCC flexible /Sm@rtAccess

The Sm@rtAccess option enables you to set up communication between different
HMI systems.

® WinCC flexible /Audit

The Audit option extends the HMI device to include functions for recording operations in
an audit trail and electronic signature.

1.7 Communication
Number of connections
Connection Mobile Panel 277 IWLAN
Number using a bus connection 6
Number of connections based on 8
"SIMATIC HMI HTTP Protocol"

Note

In the following cases, you must not enable PROFINET IO in the Control Panel:
¢ Use of PLCs from other manufacturers

PLCs

The following table shows the PLCs which can be used with the HMI devices and the
protocols or profiles which can be used.

PLC Protocol Mobile Panel 277 IWLAN
SIMATIC S7 PROFINET Yes
SIMATIC HMI HTTP Protocol | HTTP/HTTPS (Ethernet) Yes
Allen-Bradley E/IP C.Logix Ethernet IP Yes

OPC Yes

Mobile Panel 277 IWLAN
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1.7 Communication
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Safety instructions, standards and notes 2

2.1 Safety instructions

Safety regulations

A WARNING

Strictly observe all instructions in these operating instructions at all times. Otherwise,
hazardous situations can arise or the safety mechanisms in the HMI device can be
rendered ineffective.

Observe the safety and accident prevention instructions applicable to your application in
addition to the safety instructions given in this manual.

A WARNING

The configuration engineer for a machine or system PLC must take precautions so that an
interrupted program can be restarted normally after communication errors, voltage dips or
power failures. Dangerous operating conditions must not occur, even temporarily.

If faults in the system can cause bodily injury or significant property damage, additional
measures must be taken outside of the system. These measures must also ensure safe
operating conditions in the system in the event of a fault.

The system's configuration engineer must take precautions to ensure that memory changes
that could lead to a dangerous situation can only be undertaken by authorized persons.

Safety measures during operation

A WARNING
Exclusive operating right

Ensure that the system cannot be operated by another control unit while you are operating
it with the HMI device.

Mobile Panel 277 IWLAN
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Safety instructions, standards and notes

2.2 Standards, certificates and approvals

Proper use

A WARNING

Commissioning of the HMI device is forbidden until it has been absolutely ensured that the
machine which is to be operated with the HMI device complies with Directive 98/37/EC.

High frequency radiation

NOTICE

Unintentional operating situations

High-frequency radiation, for example from cellular phones, can lead to undesirable
operating situations.

2.2 Standards, certificates and approvals

Certifications

CE approval

30

A\caution

The following overview shows possible approvals.

The only valid approvals for the HMI device, the charging station, the tabletop power supply
unit and the transponder are those shown on the label on the rear panel.

C€

The HMI device, charging station, tabletop power supply unit, and transponder satisfy the
requirements and protection objectives of the EC Directives below. The HMI device,
charging station, and transponder comply with the harmonized European standards (EN)
published in the Official Journals of the European Union for programmable logic controllers:

e 73/23/EWG "Electrical equipment for use within specific voltage limits"
(Low-Voltage Directive)

® 2004/108/EC Electromagnetic Compatibility Directive (EMC Directive)

® Specific absorption rate in accordance with EN 50932

Mobile Panel 277 IWLAN
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2.2 Standards, certificates and approvals

EC Declaration of Conformity

The EC Declarations of Conformity are available to the relevant authorities at the following
address:

Siemens Aktiengesellschaft
Automation & Drives

A&D AS RD ST PLC

PO Box 1963

D-92209 Amberg, Germany

UL approval

Underwriters Laboratories Inc., to
e UL 508 (Industrial Control Equipment)
® (CSA C22.2 No. 142 (Process Control Equipment)

The approval is only valid in the case of battery operation or when stationary in the
charging station.

Marking for Australia

0 N117

The HMI device, charging station, tabletop power supply unit, and transponder satisfy the
requirements of Standard AS/NZS 2064 (Class A).

Wireless approval
The HMI device wireless approvals for the various countries are located as follows:
® On the rear of the HMI device

® |n the product information supplied together with the HMI device

Mobile Panel 277 IWLAN
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2.3 Operating safety

2.3

Standards

32

Operating safety

The HMI device complies with the following standards:
e EN 60204-1
Safety of Machinery — Electrical Equipment of Machines
e EN61131-1and EN 61131-2
Programmable Controllers
® The HMI device was tested for EMC in accordance with the following standards:
— EN 61000-6-4, Generic standard — emitted interference
— EN 61000-6-2, Generic standard, Immunity, industrial environments
— EN 61131-2, Programmable Controllers

e EN 300328 V1.6.1, EN 300 440-1 V1.3.1, EN 301 893, EN 301 489-1,
EN 301 489-17, FCC Part 15.245, 15.247, 15.407

Wireless approval
e EN 50 360, IEEE 1528-X, EN 50371, EN 50 392
Radiation protection requirements (SAR/EMF)
If the HMI device is used in a system, the following standards are fulfilled:
e prEN 1921, Industrial automation systems — safety of integrated manufacturing systems
e EN 12417:2001, Machine tools — safety — machining centers
e UL 508, Industrial Control Equipment
® (CSA C22.2 No.14, Industrial Control Equipment

Mobile Panel 277 IWLAN
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2.4 Power supply

24 Power supply

Safety specifications

CAUTION
Damage to the HMI device

Only operate the HMI device with approved components:
o Batteries

e Charging station

e Tabletop power supply unit

Charging station

A WARNING
Injury or material damage

The charging station corresponds to safety class Ill according to EN 61131-2 or EN 50178.

The 24 VDC power supply must be ensured by safely isolating the low voltage from
hazardous voltages, e.g. by using a safety transformer or equivalent equipment.

Protect the power supply circuit with a 7 A fuse.

Allowance should be made for the loss of voltage on the connection cable during
dimensional analysis of the supply!

Please refer to the technical data for the supply voltage requirements.

A WARNING

Injury or material damage

Configure the 24 VDC supply for the charging station correctly, otherwise components of
your automation system can be damaged and persons may be injured.

Use only voltage generated as protective extra-low voltage (PELV) for the 24 VDC supply
of the charging station.

CAUTION
Safe electrical separation

Use only power supply units with safety isolation complying with IEC 60364-4-41 or
HD 384.04.41 (VDE 0100, Part 410), for example according to the PELV standard, for the
charging station's 24 VDC supply.

The supply voltage must be within the specified voltage range. Malfunctions in the charging
station may otherwise result.

Applies to non-isolated system design:

Connect the connection for GND 24 V from the 24 V power supply output to equipotential
bonding for uniform reference potential.

Mobile Panel 277 IWLAN
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2.5 Nofes about usage

Tabletop power supply unit

CAUTION

Please note that the mains connector must be removed for a complete disconnection from
the mains.

The tabletop power supply unit is only suitable for an office environment.

The device is designed for operation on grounded power supply networks
(TN systems to VDE 0100, Part 300, or IEC 364-3).

Operation is not authorized on ungrounded or impedance-grounded power networks
(IT networks).

2.5 Notes about usage

Use in industry

Residential use

34

The HMI device is designed for industrial use. For this reason, the following standards
are met:

® Requirements for emissions EN 61000-6-4: 2001
® Requirements for interference immunity DIN EN 61000-6-2: 2005

Note

The HMI device is not suitable for use in residential areas: If you use the HMI device in
residential areas, the radio/TV reception may be impeded.

If the HMI device is used in a residential area, you must take measures to achieve
Limit Class B conforming to EN 55011 for RF interference.

A suitable measure for achieving the required RF interference level for Limit Class B
includes for example:

e Use of filters in electrical supply lines

Individual acceptance is required.

Mobile Panel 277 IWLAN
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2.6 Electromagnetic compatibility

2.6 Electromagnetic compatibility

Introduction

The HMI device, the charging station, the transponder, and the power supply satisfy, among
other things, the requirements of the EMC laws pertaining to the European domestic market.

EMC-compliant installation

Conditions for fault-free operation include EMC-compatible assembly of the charging station
and the use of interference-proof cables. The "Directives for interference-proof installation of
PLCs" and the "SIMATIC NET, Fundamentals of Industrial WLAN" manual also apply to the

assembly of the charging station.

Pulse-shaped interference

The following table shows the electromagnetic compatibility of modules with regard to
pulse-shaped interference.

Pulse-shaped Applies to charging station with and without Degree of severity
interference plugged-on HMI device and power supply (230 VAC)
Checked with
Electrostatic discharge | Air discharge: 8 kV 3
in accordance with Contact discharge: 6 kV
IEC 61000-4-2
Bursts 2 kV supply line 3
(high-speed transient
interference)
in accordance with
IEC 61000-4-4

High-power surge pulses in accordance with IEC 61000-4-5, external protective circuit required
(refer to S7-300 PLC, Installation, chapter "Lightning and overvoltage protection")

Asymmetrical coupling |2 kV power cable 3
DC voltage with protective elements

Symmetrical coupling 1 kV power cable 3
DC voltage with protective elements
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2.6 Electromagnetic compatibility

Sinusoidal interference

The following table shows the EMC behavior of the modules with respect to sinusoidal
interference. This requires the HMI device to meet the specifications and directives for
electrical installation.

Sinusoidal interference Test values Degree of severity
HF radiation 80 % amplitude modulation at 1 kHz 3
(in elect;omagnetir(]: fields) | e to 10 V/m in the range 80 MHz to 1.0 GHz
in accordance wit .
IEC 61000-4-3 e t010 V/m in the range 1.4 GHz to 2.0 GHz
e to1V/minthe range from 2.0 GHz to 2.7 GHz
HF conductance on Test voltage 10 V, with 80 % amplitude modulation 3
cables and cable shields | of 1 kHz in the 150 kHz to 80 MHz range
in accordance with
IEC 61000-4-6

Emission of radio interference

The following table shows the emitted interference from electromagnetic fields in accordance
with EN 55011, Limit Class A, Group 1, measured at a distance of 10 m.

From 30 to 230 MHz <40 dB (V/m) quasi-peak
From 230 to 1,000 MHz < 47 dB (V/m) quasi-peak

Additional measures

Before you connect the HMI device to the public network, ensure that it is compliant with
Limit Class B in accordance with EN 55022.

Specific absorption rate SAR
® Recommendation 1999/519/EC; Exposure of the public to EMF
® Limit values for Europe according to EN 50932
® Limit values for USA in accordance with FCC OET Bulletin 65 Supplement C
— 2.0 W/kg within 10 g of tissue (in accordance with ICNIRP guideline)
— 1.6 W/kg within 1 g of tissue (in accordance with IEEE/FCC)
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2.7 Transport and storage conditions

2.7 Transport and storage conditions

Mechanical and climatic transport conditions

The shipping conditions of this HMI device exceed requirements in accordance with
IEC 61131-2. The following specifications apply to devices that are shipped and stored in the
original packaging.

The climatic conditions comply with the following standard:
e |EC 60721-3-2, Class 2K4 for transport
The mechanical conditions are compliant with IEC 60721-3-2, Class 2M2.

The following table shows the transport and storage conditions for the HMI device, charging
station, tabletop power supply unit and transponder.

Type of condition Permitted range

Drop test (in transport package) <1m

Temperature From -20 to +60 °C
Atmospheric pressure From 1,080 hPa to 660 hPa,

corresponds to an elevation —1,000 to 3,500 m

Relative humidity Applies to HMI device:
From 10 % to 90 %, without condensation

Applies to charging station and transponder
from 35 % to 85 %, without condensation

Sinusoidal vibration in accordance with 5 Hz to 9 Hz: 3.5 mm
IEC 60068-2-6 9 Hz to 500 Hz: 9.8 m/s?

Shock in accordance with IEC 60068-2-29 250 m/s2, 6 ms, 1,000 shocks

NOTICE

Device failure

In the following cases, ensure that no moisture (dew) can settle on or in the HMI device,
charging station or transponder:

e Transportation of the HMI device in low temperatures

e Under extreme temperature variations

The HMI device must have acquired room temperature before it is put into operation.
Do not expose the HMI device to direct radiation from a heater in order to warm it up.

If dewing has developed, wait approximately four hours until the HMI device has dried
completely before switching it on.

The following points must be adhered to in order to ensure a fault-free and safe operation of
the HMI device:

® Proper transportation and storage
® Proper installation and mounting
® (Careful operation and maintenance

The warranty for the HMI device will be deemed void if these stipulations are not heeded.
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2.7 Transport and storage conditions
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Planning application

3.1 Application and ambient conditions

Mechanical and climatic conditions of use

The HMI device is designed for use in a location protected from the effects of the weather.
The conditions of use are compliant with requirements to DIN IEC 60721-3-3:

® (Class 3M3 (mechanical requirements)

® (Class 3K3 (climatic requirements)

Use with additional measures
In the following cases the use of the HMI device requires additional measures:

® |n locations with a high degree of ionizing radiation

® In locations with difficult operating conditions, for example due to:
— Corrosive vapors, gases, oils or chemicals
— Electrical or magnetic fields of high intensity

® |n systems that require special monitoring, for example:
— Elevators

— Systems in especially hazardous rooms

Mechanical ambient conditions

The following table shows the mechanical ambient conditions for the HMI device in the form
of sinusoidal vibration.

Frequency range in Hz Constant Occasional
10<f<58 Amplitude 0.0375 mm Amplitude 0.075 mm
58 <f< 150 Constant acceleration 0.5 g Constant acceleration 1 g

Reducing vibrations

If the HMI device is subjected to greater shocks or vibrations, you must take appropriate
measures to reduce acceleration or amplitudes.

We recommend fitting the charging station of the HMI device to vibration-absorbent material
(on metal shock absorbers, for example).
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3. 1 Application and ambient conditions

Testing mechanical ambient conditions

The following table provides information on the type and scope of tests for mechanical
ambient conditions:

Tested for

Test standard

Comments

Vibrations

Vibration test in accordance
with IEC 60068, part 2-6
(sinusoidal)

Applies to HMI device, charging station and
transponder:

Type of vibration:

Transitional rate of the frequency: 1 octave/minute.
10 <f<58,

constant amplitude 0.075 mm

58 <f< 150,

constant acceleration 1 g

Vibration duration:

10 frequency cycles per axis in each of the three
mutually vertical axes.

Shock

Shock testing in accordance
with IEC 60068, Part 2 -27

Applies to HMI device, charging station and
transponder:

Type of shock: half-sine

Shock intensity:
Peak value 15 g, duration 11 ms
Direction of impact:

3 shocks in * directions in each of the three mutually
vertical axes

Falling

Drop testing in accordance
with EN 60068-2-32

Applies only to the HMI device, with and without battery:
1.2m

Climatic ambient conditions for the HMI device
The following table shows the permitted climatic ambient conditions for use of the HMI

device:

Ambient conditions

Permitted range

Comments

Temperature
e Operation
e Storage/transport

e FromO0to40°C
e From-20to 60 °C

Relative humidity

10 to 80 %, without
condensation

Corresponds to relative humidity, load degree
2 in accordance with IEC 61131, part 2

Atmospheric pressure

1,080 hPa to 795 hPa

Corresponds to an elevation of
—1,000 to 2,000 m

Pollutant concentration

S02: < 0.5 vpm;
Relative humidity < 60 %,
no condensation

Check: 10 cm3/m3; 10 days

H2S: < 0.1 vpm;
Relative humidity < 60 %,
no condensation

Check: 1 cm3/m3; 10 days
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Planning application

Climatic ambient conditions for the charging station
The following table shows the permitted climatic ambient conditions for use of the charging

station.

3.1 Application and ambient conditions

Ambient conditions

Permitted range

Comments

Temperature
e Operation
e Storage/transport

e FromO0to40°C
e From-20to 60 °C

Relative humidity

10 to 80 %, without
condensation

Corresponds to relative humidity, load degree
2 in accordance with IEC 61131, part 2

Atmospheric pressure

1,080 hPa to 795 hPa

Corresponds to an elevation of
-1,000 to 2,000 m

Pollutant concentration

S0O2: < 0.5 vpm;
Relative humidity < 60 %,
no condensation

Check: 10 cm3/m3; 10 days

H2S: < 0.1 vpm;
Relative humidity < 60 %,
no condensation

Check: 1 cm3/m3; 10 days

Ambient climatic conditions for the transponder

The following table shows the permitted climatic ambient conditions for use of the

transponder:

Ambient conditions

Permitted range

Comments

Temperature
e Operation
e Storage/transport

e FromOto50°C
e From-20to 60 °C

Relative humidity

10 to 80 %, without
condensation

Corresponds to relative humidity, load degree
2 in accordance with IEC 61131, part 2

Atmospheric pressure

1,080 hPa to 795 hPa

Corresponds to an elevation of
-1,000 to 2,000 m

Pollutant concentration

S02: < 0.5 vpm;
Relative humidity < 60 %,
no condensation

Check: 10 cm3/m3; 10 days

H2S: < 0.1 vpm;
Relative humidity < 60 %,
no condensation

Check: 1 cm3/m3; 10 days
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Planning application
3.2 Mounting location and clearance of charging station

3.2 Mounting location and clearance of charging station

Selecting a mounting location for the charging station
The charging station is designed for vertical installation.

CAUTION

In order to ensure that the HMI device can be hooked in securely, select a vertical surface
or one inclined slightly to the rear as the mounting surface.

The HMI device can fall down if it is not securely hooked in.

NOTICE

To charge the batteries, the ambient temperature/battery temperature must not exceed
40 °C The higher the temperature, the longer it will take for the battery to charge.

Find a place with a cool ambient temperature for the charging station. If necessary, allow
the battery to cool first.

Note
Positioning
Observe the following points when selecting the mounting location:
e The display must not be exposed to direct sunlight
e Ergonomic mounting height
The position must satisfy the following conditions:
— Ergonomic operation of the HMI device while it is in the charging station
Ease of insertion of the HMI device into the charging station and removal from the
charging station

Mobile Panel 277 IWLAN
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3.2 Mounting location and clearance of charging station

Maintaining clearances
The following clearance is required around the charging station:

60

460

All dimensions in mm
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3.3 Information on insulation tests, protection class and degree of profection

3.3 Information on insulation tests, protection class and degree of
protection

Test voltages

Insulation strength is demonstrated in the type test with the following test voltages in
accordance with IEC 61131-2:

Circuits with a nominal voltage of Ue to other | Test voltage
circuits or ground

<50V 500 VDC

Protection against foreign objects and water

Note

The HMI device only complies with the quoted safety classes if the plugs in the cable entries
have sealing caps.

Degree of protection in accordance with Description

IEC 60529

Front panel and rear panel HMI device:
e |P65
For the charging station and transponder:
e |P65

3.4 Rated voltages

The following table shows the permissible rated voltage and the relevant tolerance range for
the charging station.

Nominal voltage Tolerance range
+24 VDC 19.2 V10 28.8 V (-20 %, +20 %)

The following table shows the possible, permissible rated voltage for the tabletop power

supply unit.
Nominal voltage Tolerance range
230 VAC 170 to 264 V
120 VAC 85t0 132V
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Planning application
3.5 Required properties of the WLAN connection

3.5 Required properties of the WLAN connection

Please observe the installation guidelines when installing the WLAN network. You will find
more details on this in the system manual "SIMATIC NET, Fundamentals - Industrial
Wireless LAN", Chapter "Network architecture”.

We recommend that you plan the WLAN coverage in the plant in such a way that no more
than 4 HMI devices are located in the radio link of an Access Point.

Wireless standard
As a general rule the use of WLAN according to IEEE 802.11a is recommended.

Use of transponders

If the system is divided into zones and transponders are in use, WLAN according to
IEEE 802.11a must be used.

Ad hoc mode
Ad hoc mode cannot be used in conjunction with the Mobile Panel 277 IWLAN.
3.6 Zones
3.6.1 Division of the system into zones
Zone

You can divide your system into zones.

A zone might be where part of a particular industrial process is carried out, e.g. assembly of
parts. Zone-specific process displays and possible operations can be configured in the
project.

Note

You can also operate the HMI device in a system without any zones being defined in the
system. In this case, no transponders are required in the system.
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3.6 Zones

Rules governing zones

Example

Transponder

See also

46

A maximum of 254 zones is possible. A zone requires at least one transponder. A zone can
be formed by a maximum of 255 transponders. Each transponder can only be assigned to
one zone. Zones must not overlap.

A zone is defined by the maximum distance of the HMI device from one or more
transponders. The same maximum distance applies to all transponders in a zone.
The assignment of transponders to zones is defined in the project.

The following figure shows an example with two zones.
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(0) Zone 1, formed by 2 transponders
® Zone 2, formed by 1 transponder

Each transponder has a unique ID. The transmitting range of the transponder approximates
to a lobe shape with a range of approximately 8 m.

The ID is set directly on the transponder. The set ID must match the project
parameterization.

Distances are measured as follows:
® The HMI device sends signals in the current project

® The transponder responds to the signal from the HMI device and sends its ID to the
HMI device

® The HMI device measures the distance between it and the configured transponder(s)

Thus the HMI device determines which zone it is in.

Setting transponder ID and inserting the battery (Page 51)
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3.6.2

Overview

3.6 Zones

Detecting zones

All zones are within the WLAN area. The WLAN area is the area in the system where the
HMI device can communicate with other communication devices over a wireless local area
network.

Zones must not overlap. Zones are formed by transponders.

Distance measurement between HMI device and transponder

The transmitting range of the transponder and the receiving area of the HMI device
approximate to a lobe shape with a range of approximately 8 m. More information can be
found in chapter Radiation characteristic|(Page 279)|.

O\

Distance measurement between the HMI device and the transponder is only possible if both
devices are within the other's receiving area. The table below shows when distance
measurement is feasible. In the figures, the HMI device is shown as a circle and the
transponder as a square.

HMI device in Yes

transponder's

transmitting range

Transponder in HMI Yes No Yes

device's receiving area

Result Distance Distance measurement | Distance measurement
measurement not possible not possible

successful
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3.6 Zones

Aligning the HMI device to the transponder

In order for the HMI device and the transponder to be able to detect one other, the
HMI device must be aligned to the transponder so that the transponder is in the main count
direction of the HMI device's antenna.

The HMI device's antenna has a lobe-shaped beam. An illustration can be found in Chapter
Radiation characteristic (Page 279).

The lobe shape of the beam means that the permissible angle of deviation from the main
count direction before the HMI device loses connection with the transponder depends on
how far the HMI device is from the transponder.

The further away the HMI device is from the transponder, the more accurately it must be
aligned to the transponder. Only a very small angle of deviation from the main count
direction of the HMI device is permissible.

The closer the HMI device is to the transponder, the greater the deviation from the main
count direction can be.

At a distance of 8 m, the permissible angle of deviation is about 20°. At a distance of 4 m,
the permissible angle of deviation is about 110°.

The diagram below shows an example of the possible angle of deviation from the main count
direction, depending on the distance from the transponder.
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Mounting and connecting

4.1 Checking the package contents

4

Check the package contents for visible signs of transport damage and for completeness.

NOTICE

Do not install parts damaged during shipment. In the case of damaged parts, contact your
Siemens representative.

The documentation belongs to the HMI device and is required for subsequent

commissioning. Keep the supplied documentation to hand throughout the entire service life
of the HMI device. You must pass on the enclosed documentation to any subsequent owner
or user of the HMI device. Make sure that every supplement to the documentation that you

receive is stored together with the operating instructions.

The following is supplied along with the HMI device:

Additional documents may be included in the delivery.

Mobile Panel 277 IWLAN

HMI device

Main battery

Bridging battery

Cover cap with rubber seal
Screws for fixing the cover cap

Label for cover cap
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Mounting and connecting

4.2 Mounting the charging stafion

4.2 Mounting the charging station

Requirements

Procedure

Result

See also

50

® 4 x M6 cylinder head screws, with nuts if required
® You have selected a location with a low ambient temperature

To charge the batteries, the ambient temperature/battery temperature
must not exceed 40 °C

® You have selected a position for the charging station that is easy and safe to reach

® You have selected a good ergonomic height for the charging station

Proceed as follows:

1. Place the charging station from the front onto the mounting surface.
2. Mark the fastening holes with a marking-off tool.

3. Drill 4 through holes or 4 x M6 threaded holes.
4

. Mount the charging station.
The charging station is now mounted.

Mounting location and clearance of charging station (Page 42)
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4.3 Setting transponder ID and inserting the battery

4.3 Setting transponder ID and inserting the battery

Introduction
To operate the transponder you must first insert the batteries and set the transponder ID.

The transponder ID is read and evaluated by the HMI device in the current project.

Requirements
® Torx screwdriver, size T10
® Screwdriver, size 0

e 3 AA mignon batteries, 1.5V, included in delivery

Procedure for opening the transponder

@®  Screws
® Cover

1. Loosen the four marked screws.
2. Lay the cover aside.

The cover is designed in such a way that the screws cannot be lost.
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4.3 Setting transponder ID and inserting the battery

Rotary coding switch and batteries

The following figure shows the position of the 4 rotary coding switches and the batteries in
the transponder.

@fa I

0] Rotary coding switch
® Batteries

Example for setting the transponder ID

O oo ul O oo ul O °1|;° ul O oo ul
0] Rotary coding switches for 4th decade, Set value: 3
MSB: most significant byte
® Rotary coding switches for 3rd decade Set value: A
® Rotary coding switches for 2nd decade Set value: 2
0] Rotary coding switches for 1st decade, Set value: 7

LSB: least significant byte
The figure shows the set transponder ID 3A27H, i.e. 14,887, in decimal format.
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Mounting and connecting

4.3 Setting transponder ID and inserting the battery

Procedure
CAUTION
ESD
When working in the open housing, ensure that current-carrying conductors do not come
into contact with electrical circuits.
Note the ESD instructions.
Proceed as follows:
1. Insert the batteries as shown on the printed circuit board.
2. Set the transponder ID with the help of a screwdriver.
Please note the MSB and LSB markings on the printed circuit board.
Set the hexadecimal transponder ID. The values permitted in hexadecimal format are
1 to FFFE, i.e. decimal format from 1 to 65,534.
3. Screw down the cover on the transponder.
NOTICE
Damage to thread
The transponder housing is made of plastic. Therefore, the mounting hole threads
cannot handle the same amount of stress as a comparable metallic housing. If the
screws are tightened more than 20 times, there is risk of damage to the threads.
Only tighten the screws with the permitted torque of 0.4-0.5 Nm.
Result
The batteries have been inserted in the transponder. The transponder ID is now set.
See also

Detecting zones (Page 47)
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4.4 Mounting the transponder

44 Mounting the transponder

Requirements

® 2 x M4 cylinder head screws, with nuts if required

® The batteries have been fitted in the transponder and the ID is set

® You have selected a position that provides good illumination for the desired area

The transmitting range of the transponder and the receiving area of the HMI device
approximate to a lobe shape with a range of approximately 8 m. More information can be
found in chapter Radiation characteristic (Page 279)|.

1. Place the transponder from the front onto the mounting surface.

. Mark the fastening holes with a marking-off tool.

2
3. Drill two through holes or two threaded holes M4.
4

Procedure

Proceed as follows:

. Attach the transponder.

Result

The transponder is now mounted.
See also

Detecting zones (Page 47)
4.5 Electrical installation

Electrical connections

The following connection options are available:

HMI device

Charging station Tabletop power supply unit

Configuring PC

Yes

Supply voltage

Yes Yes

54
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4.6 Connection of the charging station to the power supply

4.6 Connection of the charging station to the power supply

Requirements

The charging station is mounted according to the specifications in this document.

Cable plug included in the scope of supply

® Three-core cable, flexible, 0.75 mm?

® End sleeves
Pin assignment
Pin Assignment
1 +24 VDC
2 n.c.
3 GND 24 V
4 PE

Procedure for mounting the cable plug
1. Screw the cables to the contacts in the socket insert and mount the socket.

The following figure shows an exploded view of the cable plug:

Socket insert
Coupling bush
Seal

Fastening case

®®e 0 0

Cable seal
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4.7 Connecting the HMI device

Procedure for connecting the charging station
1. Connect the supply line to the power supply.

2. Connect the cable plug to the counterpart on the charging station.

Result

The charging station is now connected to the power supply. The "POWER" LED lights up
green when the power supply to the charging station is within the nominal range.

See also
Rated voltages (Page 44)

4.7 Connecting the HMI device

471 Opening and closing the connection compartment

Introduction
Before you begin:

CAUTION
Malfunctions

If the HMI device is switched on and lying on its front, the key-operated switch or
illuminated pushbutton can trigger. This can result in malfunctions.

Place the HMI device with the front side facing down on a flat, clean surface to protect
against damage.

NOTICE

Unintentional switching off of the HMI device

When you open the connection compartment, remove the main battery. This failure of the
main battery is bridged by the bridging battery, if fitted. The maximum bridging time is
5 minutes. If you exceed the bridging time, the HMI device will switch off.

Do not exceed the bridging time!

NOTICE

Pay attention to cleanliness. Foreign bodies or liquids must not come into contact with the
printed circuit board or penetrate the inside of the HMI device.
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4.7 Connecting the HMI device

Requirements
Cross-head screwdriver, size 2

Battery compartment and connection compartment

Locking latch

Connection compartment cover
Connection for tabletop power supply unit
Battery compartment cover

Charging contacts for charging station
USB interface

®©@Oe 66000

Note
Sequence for opening

Always remove the battery compartment cover first and remove the main battery before
opening the connection compartment cover.

Procedure for opening the battery compartment
Proceed as follows:
1. Pull up the locking latch on the battery compartment cover.
The battery compartment cover can now be opened.

2. Remove the battery compartment cover.
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4.7 Connecting the HMI device

Result

The battery compartment is open. The main battery, if fitted, is visible.

CAUTION

Damage to the HMI device
The connection compartment cover is connected to the HMI device's housing by wiring.

Open the connection compartment cover carefully.

Procedure for opening the connection compartment

58

CAUTION

The connection compartment may only be opened by trained skilled personnel for service
purposes.

CAUTION

Damage to the HMI device

When the connection compartment is open the HMI device is vulnerable to damage from
mechanical influences and live parts. If a bridging battery is fitted in the HMI device or the
tabletop power supply unit is connected, some parts of the HMI device will still be
electrically live.

Please observe the following:

If you have connected a tabletop power supply unit, isolate the unit from the HMI device
if possible.
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4.7 Connecting the HMI device

CAUTION

Damage to the HMI device

When the connection compartment is open the HMI device is vulnerable to damage from
electrostatic discharge.
ESD

When working in the open housing, ensure that current-carrying conductors do not come
into contact with electrical circuits.

Note the ESD instructions.

1. Remove the main battery (if fitted) using the ribbon.

The bridging battery and the memory card, if fitted, are now visible.
2. Unscrew the six screws approximately 1 cm out of the cover.

The cover is designed in such a way that the screws cannot be lost.

3. Open the cover.

Result
The connection compartment is open.

Connection compartment cover
Rubber seal

Wiring to charging contacts
Antenna

Contacts for main battery

Only insert the memory card and bridging battery into the connection compartment!
Do not insert any other objects in the connection compartment.
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4.7 Connecting the HMI device

Notes for closing

NOTICE

Damage to thread

The HMI device housing is made of plastic. Therefore, the mounting hole threads cannot
handle the same amount of stress as a comparable metallic housing. If the screws are
tightened more than 20 times, there is risk of damage to the threads.

Only tighten the screws with the permitted torque of 0.4-0.5 Nm.

NOTICE

Damage to wiring at charging contacts

When closing the connection compartment cover, be careful not to trap the wiring at the
charging contacts.

NOTICE

IP65 degree of protection not fulfilled

Ensure that the seals belonging to the connection compartment cover and battery
compartment cover are present during mounting.

After completing the connections, check whether the covers are fitted on the USB interface
and the terminal for the tabletop power supply unit.

Procedure for closing the connection compartment and battery compartment

Result

60

1. Place the cover on the connection compartment.
Be careful with the wiring to the charging contacts.
2. Tighten the 6 cover screws.

3. Insert the main battery.

4. Replace the cover on the battery compartment.

The fastener of the battery compartment cover must engage below the locking latch.

The connection compartment and battery compartment of the HMI device are now closed.
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4.7 Connecting the HMI device

4.7.2 Interfaces of the HMI device

The following figure shows the interfaces of the HMI device.

DR @ ® ®

Connection for tabletop power supply unit
Cable connector for wiring to charging contacts
RJ45 jack for PROFINET

Reset button

Connection for bridging battery

USB interface

®@e 60600 06

CAUTION
IP65 degree of protection not fulfilled

If you want to use the RJ45 interface, you must first open the connection compartment.
If the connection bay is open, degree of protection IP65 is not fulfilled.

Only use the RJ45 jack for the connector of the configuring PC when resetting to factory
settings.

NOTICE
Switching off the HMI device
Pressing the reset button will cause the HMI device to switch off completely.

USB jack and connector for tabletop power supply unit
The USB jack and the connector for the tabletop power supply unit are shown as plugs.

Mobile Panel 277 IWLAN
Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0 61



Mounting and connecting

4.7 Connecting the HMI device

473 Connecting the configuring PC

Requirements
® For connection via PROFINET (LAN via RJ45 interface):
The connection compartment on the HMI device is open.
® For connection via PROFINET (WLAN):

Note

You must connect the HMI device to the configuring PC in infrastructure mode.
An ad hoc network is not possible.

The HMI device must be in an area with sufficient WLAN quality. It must be possible for
the configuring PC to be contacted via WLAN.

Connection graphic

The following figure illustrates the connection between the HMI device and the configuring
PC. You can transfer the following data between the HMI device and a configuring PC:

® Project
® HMI device image

e Additional project data

00O
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PROFINET | PC
USB | PG
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4.7 Connecting the HMI device

NOTICE

USB connection sequence

Observe the following sequence when connecting by USB:
1. HMI device

2. PC

USB Host-to-Host cable

Only use the driver for the USB host cable, which is included in the WinCC flexible
package. Never use the driver supplied with the USB Host-to-Host cable.

Restoring factory settings

Note

To update the operating system and reset to factory settings, you must connect the
HMI device to the configuring PC via the RJ45 interface.

Note

For a point-to-point connection, use a cross cable. The HMI device and the PC can also be
part of a LAN network.

NOTICE
IP65 degree of protection not fulfilled

If you connect the configuring PC directly to the HMI device through the RJ45 interface, you
must open the connection compartment. If the connection bay is open, degree of protection
IP65 is not fulfilled.

NOTICE

Damage to the HMI device

Pay attention to cleanliness. Foreign bodies or liquids must not come into contact with the
printed circuit board or penetrate the inside of the HMI device.

Only connect a configuring PC directly to the HMI device for a short period.

The ports are described in the specifications.

See also
Description of interfaces on the HMI device (Page 278)
Interfaces of the HMI device (Page 61)
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4.7 Connecting the HMI device

474 Connecting the PLC

Introduction

Only use approved components to connect a SIMATIC S7 PLC. You can find more
information about this, for example on the Internet at: "http://mall.automation.siemens.com".

Connection graphic

The following figure shows the connection between the PLC and the HMI device.

I

00O

(o] f s

Vi

See also

o

o

)

SIMATIC S7

)

PROFINET

PLCs from other
manufacturers

Description of interfaces on the HMI device (Page 278)

Interfaces of the HMI device (Page 61)

Communication (Page 27)
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Mounting and connecting

4.7 Connecting the HMI device

4.7.5 Connecting the printer

Introduction
Printers are connected to the HMI device via WLAN.

The current list of recommended printers for the HMI devices can be found on the Internet
under "http://support.automation.siemens.com/WW/view/de/11376409".

Observe the supplied printer documentation when you connect the printer.

Connection graphic

Note
It is not possible to connect a printer to the HMI device's USB interface.

The following figure illustrates the connection between the HMI device and a printer.
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See also
Description of interfaces on the HMI device (Page 278)
Interfaces of the HMI device (Page 61)
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4.7 Connecting the HMI device

4.7.6

Connecting USB devices
The following devices can be connected to the USB port of the HMI device:
® External mouse
e External keyboard

e USB memory stick

Note when connecting

See also

66

NOTICE

Devices with a separate power supply

Except for the configuring PC or PC, do not connect any device with a separate power
supply to the USB interface. You can connect the configuring PC or PC to the USB
interface for transferring, saving and restoring data.

NOTICE

Additional load for battery

Devices without a separate power supply cause additional load on the battery when they
are connected to the USB interface. This will reduce the battery's operation time.

NOTICE

Functional problem
If USB devices overload the interface, malfunctions might occur.

Observe the values for the maximum load of the USB interface. You will find the values in
the technical specifications.

NOTICE

Access to USB interface is not possible

The USB interface is disabled while the main battery is being changed. During a main
battery change it is not possible to export recipes and archives to a USB memory stick,
for example.

Make sure no one tries to access the USB interface while the main battery is being
changed.

Description of interfaces on the HMI device (Page 278)
Interfaces of the HMI device (Page 61)
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4.7 Connecting the HMI device

4.7.7 Connecting the tabletop power supply unit

Introduction
The tabletop power supply unit is used to power the HMI device and to charge the battery in
the HMI device in 120 V and 230 V networks. The setting of the voltage range takes place
automatically. The tabletop power supply unit is connected with the power supply cable by
the input connector.
CAUTION
Danger of overheating
Do not cover the tabletop power supply unit.
CAUTION
Please note that the mains connector must be removed for a complete disconnection from
the mains.
NOTICE
Only use the tabletop power supply unit approved for the HMI device. The tabletop power
supply unit is only suitable for an office environment.
The tabletop power supply unit is supplied with power supply cables for the following
countries:
e UK
e US
e EU
® Japan
Procedure
1. Remove the cover from the plug of the HMI device.
2. Connect the tabletop power supply unit to the HMI device.
3. Connect the tabletop power supply unit to the mains with the correct power supply cable.
See also

Rated voltages (Page 44)
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4.8 Inserting, charging and changing the battery

4.8 Inserting, charging and changing the battery

4.8.1 Safety instructions

A\caution
Fire and explosion hazard

In the following cases, there is a risk of fire and, in extreme cases, explosion!
¢ Incorrect charging and discharging of the battery

e Reverse polarity

e Short-circuit

Only charge the bridging battery in the HMI device.

Only charge the main battery in the HMI device or in the charging compartment of the
charging station.

A\caution
Danger of injury

If used incorrectly, fluid can leak from the battery. Avoid contact with the battery fluid.
If fluid comes into contact with the skin, rinse with water.

If fluid comes into contact with the eyes, rinse with water and seek medical advice.

A\cauTion

The battery is a lithium ion battery. The following safety notes apply to these rechargeable
batteries:

e Do not crush

¢ Do not expose to heat and do not burn

e Do not short-circuit

¢ Do not take apart

e Do notimmerse in liquid — the battery might crack or burst.

e Store unused batteries away from the following items, which can cause the contacts to
be bridged.

— Paper clips

— Coins

- Keys

— Nails

— Screws or other small metal objects

Mobile Panel 277 IWLAN
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4.8 Inserting, charging and changing the battery

CAUTION

Malfunctions

If the HMI device lies on its front, the key-operated switch or illuminated pushbutton can
trigger. This can result in malfunctions.

ESD

When working in the open housing, ensure that current-carrying conductors do not come
into contact with electrical circuits.

Note the ESD instructions.

NOTICE

Only use batteries that are approved for the HMI device.

NOTICE

Pay attention to cleanliness. Foreign bodies or liquids must not come into contact with the
printed circuit board or penetrate the inside of the HMI device.

Place the HMI device with the front side facing down on a flat, clean surface to protect
against damage.

Disposal
Used lithium ion batteries are special waste. Please dispose of used lithium ion batteries
properly according to the appropriate regulations. Label transport packaging with the words:
"USED LITHIUM BATTERIES".

See also

ESD guideline |(Page 285)
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482 Inserting batteries for the first time

NOTICE

To charge the batteries, the ambient temperature/battery temperature must not exceed
40 °C The higher the temperature, the longer it will take for the battery to charge.

Find a place with a cool ambient temperature for the charging station. If necessary, allow
the battery to cool first.

The batteries are delivered uncharged.
Please note that a battery is subject to a natural self-discharge. The self-discharge can lead
to a complete discharge over long periods of disuse.

Requirements for inserting the bridging battery
You have opened the battery compartment and connection compartment of the HMI device.

Procedure for inserting the bridging battery
Observe the safety information!

Proceed as follows:

1. Plug the bridging battery's plug connector into the interface in the connection
compartment.
The plug connector is coded. There is no risk of incorrect connection.

2. Insert the bridging battery.
3. Align the line as shown in the figure. Ensure that the line runs underneath the cable entry.

Result
The bridging battery is now fitted.
The following figure shows the bridging battery inserted in the connection compartment.

®

@ Cable routing

Mobile Panel 277 IWLAN
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4.8 Inserting, charging and changing the battery

Requirements for inserting the main battery
The connection compartment is open.

The battery compartment is open.

Procedure for inserting the main battery
1. Place the main battery in the battery compartment.

2. Close the battery compartment.

Result
The main battery is inserted.

The following figure shows the main battery in the battery compartment.

Charging the battery

The batteries are charged automatically whenever the HMI device is placed in the charging
station or connected to the tabletop power supply unit.

See also
Safety instructions (Page 68)

Opening and closing the connection compartment (Page 56)
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4.8 Inserting, charging and changing the battery

4.8.3

Displaying battery status
The battery's charging condition can be displayed in the following ways:
® On the main battery itself
e By the BAT LED on the HMI device
® |n the "OP" dialog box, "Battery" tab in the Control Panel
® |n a running project, if configured

Procedure for displaying the charging condition on the main battery itself

See also

72

The LED display on the main battery consists of 5 LEDs.

@ Pushbutton
® LED display

Briefly press the pushbutton on the battery.

The LEDs on the LED display will briefly light up to show the charging condition. The LEDs
will light up according to the charging status. If all the LEDs light up, the battery is fully
charged. If no LEDs light up, the battery is flat.

Displaying battery status (Page 162)
Displaying battery status (Page 209)
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484

Introduction

Requirements

4.8 Inserting, charging and changing the battery

Changing the main battery

A\caution

Possible failure of HMI device while main battery is changed

If the bridging battery can no longer be charged, the HMI device will switch off the next time
the main battery is changed.

Change the bridging battery at least every 5 years.

Note
Change the main battery in good time!

We recommend that you replace the battery once it can only be charged to 50 %. This is the
case after approximately 500 complete charging cycles.

A charging cycle is complete when the battery is fully charged.
Example:

The battery has a charging condition of 80 %. It needs another 20 % before it is fully
charged. The battery is charged. This charging process counts as one fifth of a complete
charging cycle.

We recommend keeping an inventory of spare main batteries.

You can replace the main battery during operation. The bridging battery supplies power to
the HMI device while the main battery is being changed. The maximum buffer time is
5 minutes.

While the power is being drawn from the bridging battery, the following features are
deactivated:

e Display backlighting

® Touch screen

® The function keys and associated LEDs

® The illuminated pushbuttons and handwheel
e USB interface

NOTICE

Access to USB interface is not possible

The USB interface is deactivated while the main battery is changed. Make sure no one
tries to access the USB interface while the main battery is being changed.

You have opened the battery compartment of the HMI device
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Procedure
Observe the safety information.
Proceed as follows:
1. Remove the main battery using the ribbon.
2. Insert the new main battery.

3. Close the battery compartment.

Result
The main battery has been changed.

Disposal

Used lithium ion batteries are special waste. Please dispose of used lithium ion batteries
properly according to the appropriate regulations. Label transport packaging with the words:
"USED LITHIUM BATTERIES".

See also
Safety instructions (Page 68)
Maintenance and care (Page 267)
Inserting batteries for the first time (Page 70)

Opening and closing the connection compartment (Page 56)

485 Changing the bridging battery

Introduction
The bridging battery is charged automatically in the following cases:
e The HMI device is placed in the charging station
® The main battery in the HMI device is sufficiently charged

® The HMI device is connected to the tabletop power supply unit

A\caution
Possible failure of HMI device while main battery is changed

If the bridging battery can no longer be charged, the HMI device will switch off the next
time the main battery is changed.

Change the bridging battery at least every 5 years.
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Requirements

Procedure

Result

Disposal

See also

4.8 Inserting, charging and changing the battery

NOTICE

Bridging of main battery not possible

After the bridging battery is changed it must first be recharged before the main battery
can be bridged.

Do not change the main battery immediately after changing the bridging battery.
Check the charging status of the bridging battery first.

The "Battery" tab in the "OP" dialog box in the Control Panel displays the charging status
and temperature of the main battery and bridging battery.

® The project on the HMI device is complete and the HMI device is switched off
® You have opened the battery compartment of the HMI device

Observe the safety information!

Proceed as follows:

1. Remove the main battery using the ribbon.

Open the connection compartment.

Disconnect the plug connector of the bridging battery.

Remove the bridging battery.

o~ weDbd

Plug the plug connector of the new bridging battery into the interface in the connection
compartment.

The plug connector is coded. There is no risk of incorrect connection.
Insert the new bridging battery.

Align the lines.

Close the connection compartment.

Insert the main battery.

= © © N o

0. Replace the cover on the battery compartment.
The fastener of the battery compartment cover must engage below the locking latch.

The bridging battery has been changed.

Used lithium ion batteries are special waste. Please dispose of used lithium ion batteries
properly according to the appropriate regulations. Label transport packaging with the words:
"USED LITHIUM BATTERIES".

Safety instructions (Page 68)

Inserting batteries for the first time (Page 70)
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4.9 Switching on and testing the HMI device

Requirements

In order to switch on the Mobile Panel 277 IWLAN, one of the following requirements must
be met:

® The batteries have been charged and inserted in the HMI device
e The HMI device is placed in the charging station

e The HMI device is connected to the tabletop power supply unit

Procedure
Proceed as follows:
® To switch the HMI device on, briefly press the ON/OFF button.
The "PWR" LED lights up.
The screen lights up. A progress bar is displayed during startup.
The Loader is displayed once the operating system has started. If a charged battery is
present, the BAT LED lights up green. If the HMI device does not start, it is possible that
the battery is empty or no battery is fitted.
Transfer
Skart
Control
Panel
Taskbar
Transfer

The HMI device automatically switches to "Transfer" mode during initial startup under the
following conditions:

e No project is loaded on the device
® At least one data channel has been configured

On first commissioning, there is no project on the HMI device and no data channel has
been parameterized.

Mobile Panel 277 IWLAN
76 Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0



Mounting and connecting

4.9 Swifching on and testing the HM/ device

While communication is being established, the following dialog box is displayed:

Transfer ... .

Zonnecting ko host L.,

Cancel

1. Press "Cancel" to stop the transfer.

Result
The Loader appears again.

Starting and transferring a project

Note

When restarting the system, a project may already be loaded on the HMI device. The system
then skips Transfer mode and starts the project.

If you want to transfer another project, for example, exit the project. To do this, use the
corresponding operating element.

Please refer to your system documentation to check whether additional information on this
subject is available there.

Function test

Check whether the HMI device is fully functional. The HMI device is fully functional when one
of the following states is indicated after switching on:

® The Transfer dialog box is displayed
® The Loader appears

® A project is started

Switching off the HMI device

To switch the HMI device off, press the ON/OFF button on the HMI device for at least
4 seconds. Any active project is automatically terminated.

See also
Inserting batteries for the first time (Page 70)
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Operator controls and displays

5.1 Overview

The following figure shows the operator controls and displays of the
Mobile Panel 277 IWLAN. This can vary, depending on the delivery condition of the
HMI device.

®

©

LED display

Display with touch screen
ON/OFF button

Covers for the labeling strip guides
Key-operated switch, optional
llluminated pushbutton, optional
Membrane keyboard

CEONONCNCNONONC)

Handwheel, optional
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5.1 Overview

Operator control functions

The functions assigned to the function keys, the handwheel, the key-operated switch and the
illuminated pushbuttons are determined during configuration. The above-mentioned operator
controls do not function outside of a project.

Evaluation and selection of the operator controls
The following information can be transferred between the HMI device and the PLC:
e Direction pulses of the handwheel
e Status of the function keys
e Status of the key-operated switch
e State of the illuminated pushbuttons
e State of the function keys and illuminated pushbutton LEDs
There are two ways of transmitting information:
e Direct keys

e System functions of WinCC flexible

Standard input unit

The standard input unit on the HMI device is the touch screen. All operating elements
required for touch operation are displayed on the touch screen once the HMI device has
started.

NOTICE
Damage to the touch screen

Never touch the touch screen with pointed or sharp objects. Avoid applying excessive
pressure to the touch screen with hard objects. Both these will substantially reduce the
useful life of the touch screen and even lead to total failure.

Always operate the HMI touch screen with your fingers or with a touch pen.
Damage to the keyboard

Pressing the keys with a hard instrument considerably reduces the service life of the key
mechanism.

Always use your fingers to operate the keys of your HMI device.
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5.2 Displays on the Mobile Panel 277 IWLAN

Introduction

On the front of the HMI device there are 5 LEDs that show the states of the HMI device and
communication.

—®

0] LED display

Note
The SAFE and RNG LEDs have no function on the Mobile Panel 277 IWLAN.
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5.3 Power management

Meaning of the LED displays

The LEDs are only activated when the HMI device is switched on.

Functions

Designation

Color

Meaning

PROFIsafe
communication

SAFE

The SAFE LED is always off.

Power

PWR

Green

The "PWR" LED only lights up or flashes when the
HMI device is switched on.

The PWR LED lights up in the following instances:
e The main battery is fitted and charged
e The HMI device is in the charging station

e The HMI device is connected to the tabletop
power supply unit

The "PWR" LED flashes when the HMI device is in
the "Power Save 2" state.

Communication

COM

Green

The "COM" LED remains off as long as no
WLAN network is configured.

The "COM" LED flashes when the HMI device is
attempting to establish a connection to a

WLAN network.

The "COM" LED lights up when the HMI device has
established a connection to a WLAN network.

Effective range

RNG

The RNG LED is always off.

Battery status

BAT

Green/red

The "BAT" LED goes out under the following
circumstances:

e The main battery is empty
e The main battery is not installed

The "BAT" LED flashes when the main battery is
being charged.

The "BAT" LED lights up red when the main battery
has a charging status of less than 10 %.

The "BAT" LED lights up green when the main
battery has a charging status of at least 10 %.

The HMI device is equipped with a power management function. If you do not operate the
HMI device for a configurable time interval, power management will switch the HMI device to
power save mode. This extends the operation time of the HMI device until the next battery

See also

Power management (Page 82)
5.3 Power management
Introduction

change or charging of the battery.
82
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5.3 Power management

States
Power management has two levels of power saving:
e "Power Save 1"
Reduces the brightness of the touch screen.
® "Power Save 2"
— The touch screen is switched off.
— The function keys and associated LEDs are switched off.
— The handwheel and the illuminated pushbuttons are switched off.
— Other power save measures are activated.
In WIinCC flexible, power management is parameterized in "Device settings" under "Power
management".
® "Power Save 1" corresponds to the "Reduce brightness" setting.
® "Power Save 2" corresponds to the "Switch off screen” setting.
Power management recognizes the following status change:
State LED display Successful action for resulting state | Resulting state
HMI device The "PWR" LED is off. Briefly press the ON/OFF button HMI device ON
OFF The "BAT" LED is off.
HMI device ON | The "PWR" LED Automatically, after a configured time | "Power Save 1"
lights up. interval if no operations are carried
out.
Briefly press the ON/OFF button "Power Save 2"
Press the ON/OFF button for at least | HMI device OFF
4 seconds
"Power Save 1" | The "PWR" LED Operation on touch screen or using | HMI device ON
lights up. Reduces the function keys
brightness of the touch | grjefly press the ON/OFF button "Power Save 2"
screen.
Automatically, after a configured time | "Power Save 2"
interval if no operations are carried
out
Press the ON/OFF button for at least | HMI device OFF
4 seconds
"Power Save 2" | The "PWR" LED flashes. | Briefly press the ON/OFF button HMI device ON
The touch screen is Press the ON/OFF button for at least | HMI device OFF
switched off. 4 seconds
If you press the ON/OFF button for at least 4 seconds, the current project on the HMI device
will be terminated and the HMI device will switch off.
Note
In "Power Save 2" state it is not possible to connect any devices to the RJ45 interface.
See also

Setting the screen saver (Page 133)
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54 Operator controls

541 Handwheel

Introduction
The hand wheel is an optional operator control on the Mobile Panel 277 IWLAN.
The handwheel can be turned without a stop and does not have a zero position.
@
0] Handwheel with recess
Operation

To facilitate operation, the handwheel has a small recess.
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542 Key-operated switch

Introduction
The key-operated switch is an optional operator control on the Mobile Panel 277 IWLAN.
The key-operated switch is used to lock functions that can be triggered from the
Mobile Panel 277 IWLAN.
@
0] Key-operated switch
Operation

The following figure shows the three switch positions of the key-operated switch, 1-0-11.

The key can be removed in the switch setting 0.

Remove the key after use. This avoids possible damage to the key if the HMI device
falls down.

Note

The key to the key-operated switch is supplied together with the HMI device. The key does
not have an HMI device-dependent coding. This means the key is usable on any
Mobile Panel 277 IWLAN.
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5.4 Operator controls

543

Introduction

544

5441

llluminated pushbutton

The illuminated pushbuttons are optional operator controls of the Mobile Panel 277 IWLAN.
The illuminated pushbuttons are available for fast digital inputs.

"

@ llluminated pushbutton

Evaluation of the operator controls

Overview

Operator controls

86

The following information can be transferred between the HMI device and the PLC:
® Direction pulses of the handwheel

e Status of the function keys

e Status of the key-operated switch

e State of the illuminated pushbuttons

e State of the function keys and illuminated pushbutton LEDs

There are two ways of transmitting information:

® Direct keys

® System functions of WinCC flexible

Note
The following sections are intended for the configuration engineer of the HMI device.
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5.4.4.2

Introduction

Evaluating operator controls as direct keys

5.4 Operator controls

You can configure the operator controls of the HMI device as direct keys.

The states of the following operator controls are available directly in the I/O area of the PLC:

® Direction pulses of the handwheel

® The switching state of the function keys

® The switching state of the key-operated switch

® The switching state of the illuminated pushbuttons

Byte assignment

The following figure shows the assignment of the keys (inputs) and LEDs (outputs) to the
bytes in the PLC process image.

Check whether additional information is available in your plant documentation.

Button bits LED bits

7 6 5 4 3 2 1 0 Byte 7 6 5 4 3 2 1 0

F8 |F7 | F6 | F5|F4 [F3 [F2|F1 n F8|F7|F6|F5|F4|[F3|F2|F1

F16|F15(F14|F13|F12|F11|F10| F9 n+1 F16|F15|F14|F13[F12|F11|F10| F9
F18|F17 n+2 F18|F17

T2 T1]S1|S0 n+3 T2 | T1

7161151141312 11]]10 n+4

D7 (D6 | D5|D4 (D3| D2|D1|DO0O n+5

71615413 (2]1 0 n+6

15114 (1312|1110 9 [ 8 n+7

2312221120119 18 |17 |16 n+8

313012928 |27 (26|25 |24 n+9

F Bit for function key

S Bit for key-operated switch

T Bit for left illuminated pushbutton

T2 Bit for right illuminated pushbutton

| Bit for handwheel pulses, forwards

D Bit for handwheel pulses, backwards

The bytes "n+6" to "n+9" contain the direct key bits for the touch buttons.
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5.4 Operator controls

Bit coding

88

The following tables show the bit coding for function keys, key-operated switch, illuminated
pushbutton and handwheel:

e Bit coding of function keys

State F1to F18
Not pressed 0
Pressed 1

® Bit coding of function key LEDs

State F1to F18
LED not illuminated 0
LED is illuminated 1

® Bit coding of key-operated switch

State S1 S0 Key position
Position 0 0 0 In middle position
Position | 0 1 Turned in clockwise direction up to stop
Position I 1 0 Turned counter-clockwise up to stop

® Bit coding of illuminated pushbuttons

State T T2
Not pressed 0 0

Pressed

® Bit coding of illuminated pushbutton LEDs

LED status T1 T2
Off 0 0
On permanently

® Bit coding of handwheel
— A setpoint is not specified for the handwheel.
— After start-up of the HMI device, the bytes "n+4" to "n+5" are set to zero.

Rotation of the handwheel produces positive or negative pulses depending on the
rotation direction. The number of positive pulses are stored in bits 10 to 17. The number
of negative pulses are stored in bits DO to D7. The values are entered in binary format,
where bit 0 is the lowest and bit 7 is the highest valued bit.

A complete handwheel revolution yields 50 pulses.

— Every pulse of the handwheel is added to byte "n+4" or "n+5" depending on the
direction of rotation. There are no negative values. When the possible value range is
exceeded, there is an overflow:

If a value of 255 is increased by one pulse, a value of 0 results.
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5.4 Operator controls

Example of bit coding for handwheel

The following table includes an example for rotation direction determination. The pulses are
stored in bytes "n+4" and "n+5" and are measured during the points in time t1 to ta.

The numbers in the following table represent a byte in the PLC.

Evaluation time Handwheel Evaluation
Pulses, forwards Pulses, backwards
t1 255 (& -1) 245 (2 -11) --
t2 10 245 (2 -11) Pulses, forwards: 11

Pulses, backwards: 0
Resulting value: +11

ts 10 4 Pulses, forwards: 0
Pulses, backwards: 15
Resulting value: -15

ta 15 5 Pulses, forwards: 5
Pulses, backwards: 1

Resulting value: +4

The difference in pulses at times t, and tn+1 allows you to determine the resulting value and
thus the direction of rotation.

Establish the following values:
® Number of pulses, forwards
— Attime tn
— Attime th+1
o Number of pulses, backwards
— Attime tn
— Attime tn+1

From this, you determine the resulting value. This is calculated as:

Pulses, forwards, tn+1
— Pulses, forwards, tn
— Pulses, backwards, tn+1
+ Pulses, backwards, tn
= Resulting value
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5.4 Operator controls

Reaction time

See also

The bytes "n+4" and "n+5" must be retrieved on the PLC side within a second and cyclically.
This ensures that no more than 256 pulses can be added between two scans of the
handwheel. For 256 pulses, approximately 4.5 revolutions of the handwheel are required.

The rotary pulse encoder supplies a maximum of 200 pulses per second.

NOTICE

Sample cycle time

The input pulses should take effect immediately on the PLC and cause a response in the
system. Set a scan cycle < 100 ms in the PLC in order to achieve this.

Direct keys (Page 197)

5443 Activation of function key LEDs using system functions

Application

Bit assignment

90

LEDs are integrated in the HMI device's function keys F1 to F18. The integrated LEDs can
be controlled from the PLC.

The LEDs can assume the following states:
o Off

® Flashing slowly

® Flashing quickly

e On

You can use the LED to signal to the user that a function key should be pressed, in a
running project.

The following table shows the possible states of the LEDs and the corresponding entries in
bit n+1 and bit n of the LED tags.

Bit n+1 Bitn LED status
0 0 Off
Flashing quickly

Flashing slowly

0
1
1

- O |-

ON (continuous)
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5.4 Operator controls

5444 Evaluation of the handwheel with system functions

Application

The handwheel is an optional operator control of the HMI device. You can enter incremental
values in a running project with the handwheel.

Note
Do not configure limit values in WinCC flexible for tags assigned to the handwheel.

Evaluation of the incremental values

Example

If the signals of the handwheel are assigned to a WinCC flexible tag, then the forward and
backward increments will be set off against each other. The absolute value of the increments
is given. The maximum or minimum value of the increments until an overflow depends on the
type of tags assigned.

A complete handwheel revolution yields 50 pulses. The rotary pulse encoder supplies a
maximum of 200 pulses per second.

® The handwheel has a starting value of 120 increments.
® You rotate the wheel 10 increments forwards and 3 increments backwards.

This results in a new value of 127 increments.

5445 Evaluation of the key-operated switch with system functions

Application

Bit assignment

The key-operated switch is an optional operator control of the HMI device. The key-operated
switch serves to lock functions in a running project which can be triggered by means of the
HMI device.

The following table shows the bit assignment for the tag of the key-operated switch:

Bit 1 Bit 0 Key position
0 0 Central position
0 1 Turned in clockwise direction up to stop
1 0 Turned counter-clockwise up to stop

Note

If you use a tag of the "Boolean" type for the key-operated switch, the following assignment
applies:

¢ Status "0": Central position of the key-operated switch

e Status "1": Key-operated switch turned clockwise or counter-clockwise to the stop
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5.5 Using a memory card with the HM/ device

5446 Evaluation and activation of the illuminated pushbuttons

Application

Bit assignment

The illuminated pushbuttons are optional operator controls of the HMI device. The integrated
LEDs can be controlled from the PLC.

The LEDs can assume the following states:
o Off

® Flashing slowly

® Flashing quickly

e On

You can use the LEDs to signal to the user that a function key should be pressed in a
running project.

The following table shows the bit assignment for the status tags of the illuminated
pushbuttons:

Bit 0 Status of the illuminated pushbutton
0 Not pressed
1 Pressed

The following table shows the bit assignment for the LED tags of the illuminated
pushbuttons:

Bit n+1 Bit n LED status
0 0 Off
0 1 Flashing quickly
1 0 Flashing slowly
1 1 ON (continuous)

5.5 Using a memory card with the HMI device

Introduction

92

The following can be saved to the memory card of the HMI device:
® Logs

® Recipes

® Operating system

® Applications

® Additional specifications

The memory card can be inserted and removed during operation. Do not remove the
memory card while data is being accessed by an application, e.g. during backup or recipe
transfer.

Mobile Panel 277 IWLAN
Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0



Operafor controls and displays

Instructions

5.5 Using a memory card with the HM/ device

CAUTION

Malfunctions

If the HMI device lies on its front, the key-operated switch or illuminated pushbutton can
trigger. This can result in malfunctions.

NOTICE

Switching off the HMI device

When you insert or remove the memory card, remove the main battery. This failure of the
main battery is bridged by the bridge battery, if fitted. The maximum buffer time is

5 minutes. If you do not replace the main battery after 5 minutes, the HMI device will
switch off.

Do not exceed the buffer time!
ESD guideline

When working in the open housing, ensure that current-carrying conductors do not come
into contact with electrical circuits.

Note the ESD instructions.

Note
Multimedia card

The multimedia card of the SIMATIC S7 PLC cannot be used.

NOTICE

Pay attention to cleanliness. Foreign bodies or liquids must not come into contact with the
printed circuit board or penetrate the inside of the HMI device.

Place the HMI device with the front side facing down on a flat, clean surface to protect
against damage.
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5.5 Using a memory card with the HM/ device

Requirements
® You have opened the battery compartment of the HMI device
® The main battery is removed

® You have opened the connection compartment of the HMI device

@
@

©) Slot
® Memory card symbol

Procedure for inserting a memory card
Proceed as follows:
1. Insert the memory card into the slot.

Pay attention to the memory card symbol when inserting the memory card. An arrow on
the memory card indicates the front side and the direction of insertion. When the memory
card is correctly inserted into the slot, it stands approx. 3 mm proud of the slot.

Using a memory card for the first time

NOTICE
Data loss

If the HMI device asks you to perform formatting the first time you use a memory card,
back up any existing data on the memory card first.

Proceed as follows in order to prevent data loss:

1. Cancel the formatting procedure by pressing "ESC".

Remove the memory card from the HMI device.

Back up any data that you do not want to lose on the memory card.
Insert the memory card into the HMI device.

o > N

Format the memory card on the HMI device.

Mobile Panel 277 IWLAN
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5.6 Labeling the function keys

Procedure for removing a memory card

Proceed as follows:

1.

o~ e

See also

Pull the memory card out of the slot.

Close the connection compartment.

Replace the main battery.

Close the HMI device's battery compartment.

Store the memory card in a safe place.

Opening and closing the connection compartment (Page 56)

5.6 Labeling the function keys

Introduction

You can label the function keys as required for your project. Use labeling strips to do so.

NOTICE

Do not write on the keyboard to label the function keys.

Printing labeling strips

WinCC flexible comes with a range of labeling strip templates. You will find further
information regarding the location of the templates in the WinCC flexible Online Help.

Any printable and writable foil can be used as labeling strips. Use transparent foil so that the
LEDs of the function keys can be seen. The permitted thickness of the labeling strip is
0.13 mm. Paper should not be used as labeling strips.
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5.6 Labeling the function keys

Labeling strip dimensions

Labeling strip on right:

2 x45° All dimensions in mm
R5
19 15 ECE
05 | 15 19.6 3x3 I3-5
124.5
135
Labeling strip on left:
2 x 45°
ls.s
9
! 15 T e
05 | 15 19.6 3x3 R5
124.5
135
Labeling strip at bottom:
2 x 45°
ls.s
112 15 T |16
05 | 15 20 3x3 R5
167
177

96

Mobile Panel 277 IWLAN
Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0



Operafor controls and displays
5.6 Labeling the function keys

Procedure for attaching the labeling strips
The following steps apply for the initial attaching of labeling strips.
Proceed as follows:
1. Lay the HMI device on its reverse side.

2. Remove the label @ from the cover caps.

—

3. Unscrew both cover caps.
4. Pull the labeling strips out of the guides.
5. Inscribe the labeling strips in accordance with the system.
Wait for the printed labeling strips to dry before you insert them.
6. Push the labeling strips into the guides.
7. Screw both cover caps back on.
Screwed on cover caps with inserted rubber seals satisfy degree of protection IP65.
8. Place the label on to the cover caps.

Procedure for exchanging the labeling strips

Should the exchange of labeling strips become necessary, these can be reordered.

See also

Accessory kit and other accessories|(Page 18)

Mobile Panel 277 IWLAN
Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0 97



Operafor controls and displays

5.7 Holding the mobile panel and fixing it to the wall

5.7 Holding the mobile panel and fixing it to the wall

Holding the HMI device

The following figure shows the position of the arms relative to the HMI device, taking the
example of the Mobile Panel 277F IWLAN.

The depicted posture enables you, for example, to have freedom of movement while
servicing the monitored system.

The HMI device is equally easy to hold for right-handers and left-handers because it is
designed symmetrically. The free hand can be used to operate the operator controls on the
front side.

Note
Holding the HMI device

Please observe the following:

To allow the HMI device to evaluate the current zone, the HMI device and the transponder
must be able to detect each other. Always align the HMI device towards the transponder.
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5.7 Holding the mobile panel and fixing it fo the wall

Accommodating the HMI device

A charging station is available for safe accommodation of the HMI device. The HMI device
can be used as a stationary HMI device when it is hooked into the charging station.
The HMI device's battery is charged in the charging station.

See also
Detecting zones (Page 47)
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5.8 Charging station

5.8.1 Charging batteries in the charging compartment

Introduction

You can charge one main battery in each of the two charging compartments of the charging
station. The batteries are charged independently of each other.

—o ©)

0] Locking latch for charging compartment cover
® Charging compartment
® LED display

Procedure for inserting the battery in the charging compartment
Proceed as follows:
1. Pull up the locking latch on the charging compartment cover.
The cover can now be opened.
2. Place the battery in the charging compartment.

3. Close the charging compartment.

Result

The battery is charged automatically whenever the charging station is connected to the
power supply unit. The LED display shows the battery's charging status.

Mobile Panel 277 IWLAN
100 Operating Instructions, 04/2008, AV6 691-1DM01-2AB0



Operafor controls and displays

5.8 Charging station

Procedure for removing the battery from the charging compartment
Proceed as follows:
1. Pull up the locking latch on the charging compartment cover.
The cover can now be opened.
2. Remove the main battery using the ribbon.

3. Close the charging compartment.

5.8.2 Displays on the charging station

Introduction

There are 3 LEDs on the charging station. The LEDs show the states of the batteries in the
charging compartments and of the power supply unit.

Meaning of the LED displays

Designation | Color Meaning
BAT 1 Green The "BAT 1" LED is off when there is no battery in the first charging
compartment.

The "BAT 1" LED flashes when the battery in the first charging
compartment is being charged.

The "BAT 1" LED lights up when the battery in the first charging
compartment is 95 % charged.

BAT 2 Green The "BAT 2" LED is off when there is no battery in the second charging
compartment.

The "BAT 2" LED flashes when the battery in the second charging
compartment is being charged.

The "BAT 2" LED lights up when the battery in the second charging
compartment is 95 % charged.

POWER Green/red | The "POWER" LED is off when there is no voltage supply to the
charging station.

The "POWER" LED lights up green when the power supply to the
charging station is within the nominal range.

The "POWER" LED lights up red when there is an overvoltage or
undervoltage at the charging station.
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5.8 Charging station

5.8.3 Locking the charging station

Introduction
The lock prevents unauthorized removal of the HMI device from the charging station.

@ Lock barrel with key
® Lock
® Hook for hooking in the HMI device

Procedure for locking the charging station
Proceed as follows:
1. Slide the lock down to the appropriate cut-out in the charging station.
2. Turn the key by 90 degrees.
3. Remove the key.

Result
The charging station is locked. You cannot remove the HMI device.
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5.8 Charging station

Procedure for unlocking the charging station
Proceed as follows:
1. Insert the key into the lock barrel.
2. Turn the key by 90 degrees.
3. Slide the lock upwards.

Result
You can now remove the HMI device.

See also
Charging station (Page 20)

Mobile Panel 277 IWLAN
Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0 103



Operafor controls and displays

5.8 Charging station
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6.1 Loader

Loader
The following figure shows the Loader.

Transfer
Stark
Control
Panel
Taskbar

The buttons on the Loader have the following function:
® The "Transfer" button sets the HMI device to transfer mode

The transfer mode can only be activated when at least one data channel has been
enabled for the transfer.

® Press the "Start" button to start the project on the HMI device

If you do not perform an operation, the project on the HMI device will automatically start
after a delay, depending on settings.

® Press the "Control Panel" button to open the HMI device Control Panel
You can change various settings in the Control Panel, for example the transfer settings.

® Press the "Taskbar" button to activate the taskbar with the Windows CE start menu open
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6.1 Loader

The following figure shows the open start menu.

0] Symbol for parameter assignment for the WLAN network
® Symbol for displaying IP information about the LAN connection
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6.1 Loader

Open Loader
The following options are available to open the Loader:
® The Loader appears briefly after starting the HMI device
® The Loader appears when the project is closed
If configured, use the relevant operating element to close the project.

Please refer to your system documentation to check whether additional information on
this subject is available there.

Password protection

NOTICE

If the password is no longer available, you cannot do the following until you have updated
the operating system.

¢ Making changes to the Control Panel
e Operating the Windows CE task bar

All data on the HMI device will be overwritten when you update the operating system!

You can protect the Control Panel and taskbar from unauthorized access. When password
protection is enabled, the message "password protect" is displayed in the Loader.

Password protection prevents maloperations and increases security for the system or
machine.

If the password is not entered, only the "Transfer" and "Start" buttons are operable.
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6.1 Loader

Internet Explorer
Internet Explore for Windows CE is installed on the HMI device.

Note

Internet Explorer for Windows CE and the Internet Explorer version which can run on a PC
differ in terms of functionality.

For further information, please refer to Microsoft's website.

See also
Switching on and testing the HMI device (Page 76)
Changing password protection |(Page 127)
Programming the data channel (Page 141)
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6.2 WLAN

6.2 WLAN
6.2.1 Overview
Introduction

The properties of the WLAN networks can be entered in the "WLAN" dialog box. Open the
"WLAN" dialog box in Windows CE.

WLAN connection

In the case of a WLAN connection, the configuration engineer for the current project can
specify the following:

® The WLAN networks to which the HMI device connects
The configuration engineer can specify up to 3 WLAN networks
® Priority assignment of WLAN networks

e \Whether the HMI device is permitted to connect with other WLAN networks

Procedure

You have activated the taskbar in Windows CE and opened the following dialog box with the
"WLAN Settings" or " icon.

IP Information | wireless | Country Code | Rate Contral |

Internet Protocol (TCPfIP)
Address Type: Static

IP &ddress: 192.168.53.11
Subriet Mazk: 255.255.255.0

Default Gateway:

The dialog box shows the parameters of the WLAN connection that are set in the
"WLAN'-Settings" dialog box in the Control Panel. If you have not yet parameterized the
connection, the boxes will be empty.

Select the "Details..." button to open a dialog box which provides more detailed information
about the established network connection.
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Set country code

NOTICE
The correct country setting is essential for operation complying with the approvals. The
selection of a country other than the one where you are using the system is subject to

criminal penalties.

For WLAN communication, the frequency bands are split into channels differently in different

countries.
1. Change to the "Country Code" tab.

| IP Information | Wireless | Cauntry Cade | Rate Contral |

Select Country

2. Select the required country code from the "Country Code" selection box.

3. Confirm your entries.
The dialog closes.

Result
The country code for the WLAN connection has been set.
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6.2 WLAN

Setting the transmission rate for WLAN
Use the register "Rate Control" to change the transfer rate of the HMI panel, if necessary.

| IP Information | wireless | Country Code | Rate Cortrol |
Rate Contral
Maxirnum Data Rate |54 Mbit El
NOTICE

Communication not possible.
Deselect the "Auto" check box only in case of transfer problems.

If you want to change the transfer rate, please contact your network administrator.
Communication between HMI Panel and Access Point is not possible in case of incorrect

settings.

Deselect the "Auto" check box.

Select the desired data transfer rate in the Maximum Data Rate selection box.
Confirm your entries.

Confirm the message of the HMI device.

Restart the HMI device.

ok N~

See also
Required properties of the WLAN connection |(Page 45)

Restarting the HMI device (Page 137)
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6.2 WLAN
6.2.2 Parameterizing the WLAN connection

Introduction

You can define the parameters for the WLAN connection and also create new
WLAN connections.

Requirements

You have opened the "WLAN" dialog box, "Wireless" tab, by touching either the
"WLAN Settings" icon or the T icon.

If no connection to a WLAN network exists, all available WLAN networks are listed.

If a connection to a WLAN network exists, the following WLAN networks are displayed:
® The WLAN network to which the connection exists

® All parameterized networks

WLAN oK
IP Information | Wirsless | Country Code | Rate Contral |

Select a network and press connect or right-click for more
options, To add a new network, double-click "add Mew',

Y add B @
mbly Line 4 (preferred) O
1 Assembly Line 9 {preferred)

Status: Connected to Assembly Line 4 ——@

Signal Strength:  Excellent @

| Connect | | Configure

"Add New" entry
Existing and parameterized WLAN networks
Status information, shows the WLAN network to which the HMI device is connected

® e 0 0

Signal strength of the selected network
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6.2 WLAN

Procedure for creating a WLAN network, parameterize the WLAN network and establish a connection

1.
2.

© N o g M

Mobile Panel 277 IWLAN

If you want to create a new WLAN network, select "Add New".

If you want to configure an existing WLAN network or connect the HMI device to a
WLAN network, select the desired network.

Use the "Configure" or "Connect" button to open the "Wireless Network Properties"
dialog box.

Wireless Metwork Properties

Metwork name (S5I00: |.-'-‘n.ssernhl\,f Line 4

[[] This is a computer-to-computer (ad hoc) netwark;
wirgless access points are not used

Wireless network key (WEP)

This network reguires a key for:
Encryptiar: |ﬁES

=]
=]

Luthentication: |Wp,a.\2

Metwork key: |********

Key index: |1

|:| The key is provided automatically

IEEE 802.1X Authentication
Enable 802, 1¥ authentication on this netwiark

EAP type: |TL5 EI

| OK || Cancel |

Note

If the HMI device has detected the WLAN network, the encryption and the authentication
process for this network will already be shown in the dialog box.

If necessary, you must also enter the appropriate password in the "Network key" text box.
After you have entered the password, it is shown in encrypted form.

If necessary, select the encryption you are using under "Encryption".

If necessary, select the required authentication process under "Authentification".
If necessary, enter the password for the WLAN network under "Network key".

If necessary, select the type of authentication protocol under "EAP type".
Confirm your entries.

The dialog closes. The parameterized WLAN network is added to the list of preferred
networks.

If the HMI device is connected to the WLAN network, the WLAN network is put at the top
of the list of preferred networks.
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6.2 WLAN

Procedure for parameterizing list of preferred networks

Result

114

1.

In the "WLAN" dialog box, "Wireless" tab, press Advanced... to open the
"Advanced Wireless Settings" dialog box.

Advanced Wireless Settings

Use wWindows to configure my wireless settings

Windows will connect to the folowing netwarks
wihenever they are available, Preference wil be given
to netwaorks at the top of this list,

Preferred Networks

3 assermbly Line 4 Up
1 Assembly Line 9

Delete

HHA

[ Automatically connect to non-preferred netwiorks

Metworks to access: IOnI\,r access paints EI

| ok || Cancel |

If you want to block the connection to the parameterized networks in the list of preferred
networks, clear the "Use Windows to configure my wireless settings" check box.

Note

If preferred networks are configured in the project, the sequence of entries in the list of
preferred networks changes when you start a project. The sequence configured in the
project is set. Any networks not permitted in the project are removed from the list.

The HMI device attempts to connect with a WLAN network in the sequence of the
preferred networks in the list.

Change the sequence as required.
— Select the WLAN network you want to move.
— Use the "Up" and "Down" buttons to select the desired position.

If necessary, use the "Delete" button to delete the selected WLAN entry from the list of
preferred networks.

Select the "Automatically connect to non-preferred networks" check box if you want the
HMI device to connect to other WLAN networks.

Confirm your entries.

The dialog closes.

The WLAN parameters are now set.
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6.3 Control Panel

Display logbook
Press "View Log..." in the "WLAN" dialog box, "Wireless" tab, to open the logbook.

The logbook provides information about connection buildup, connection cleardown and failed
attempts at connection buildup.

See also
Required properties of the WLAN connection |(Page 45)

6.3 Control Panel

6.3.1 Overview

Control Panel of the HMI device

You can configure the following settings in the Control Panel of the HMI device:
e Date/time

® Screen saver

® Regional settings

® Transfer settings

® Network settings

® Delay time

® Password

Mobile Panel 277 IWLAN
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6.3 Control Panel

Opening the Control Panel

6.3.2

The Control Panel can be opened as follows:

® |n the startup phase

Press "Control Panel" to open the HMI device Control Panel in the loader.

® |n a running project

Select the operating element provided for the respective task, if configured.

® |n the Windows CE start menu

— Open the Windows CE start menu. Alternatively, press the key twice on the
alphanumerical screen keyboard.

Open the Control Panel with "Settings > Control Panel".

Reference

Overview of functions

The following table shows the settings in the Control Panel.

Symbol Functions Tab/entry Chapter
@ Saving and restoring with external storage device |- Backing up and restoring with an
external memory medium (Page 158)
S Importing, displaying and deleting certificates "Stores" Importing and deleting certificates
(Page 157)
pﬁqJ Setting the date and time "Date/Time" Setting the date and time|(Page 128)
Configuring the screen keyboard - Configuring the screen keyboard
(Page 121)
Changing the browser startup page and general | "General" Changing internet settings
browser settings (Page 154)
Changing connection and proxy server settings "Connection" Setting the proxy server|(Page 155)
Changing cookie settings "Privacy" Changing data protection settings
(Page 155)
Changing security settings "Advanced" Changing data protection settings
(Page 155)
% Setting the character repeat for the keyboard "Repeat” Setting the character repeat rate of
the screen keyboard|(Page 123)
%) Setting the double-click "Double-Click" Setting the double-click|(Page 124)
e Parameterizing the WLAN connection "WLAN" Changing the network configuration
— (Page 150)
Setting the IP address 'WLAN' Settings' |"IP Address"

Setting the name server 'WLAN' Settings'

"Name Servers"
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Symbol Functions Tab/entry Chapter
e- Parameterizing the LAN connection "LAN" Changing the network configuration
- (Page 150)
Setting the IP address 'LAN' Settings' "IP Address"
Setting the name server 'LAN' Settings' "Name Servers"
i Changing the logon data "Identification" Changing the logon data (Page 152)
- =
ép Backup registry information "Persistent Backup registry information
: Storage" (Page 131)
Changing monitor settings "Display" Changing screen settings|(Page 132)
Displaying information about the HMI device "Device" Displaying information about the HMI
device|(Page 138)
Restarting the HMI device "Device" Restarting the HMI device
(Page 137)
Calibrating the touch screen "Touch" Calibrating the touch screen
(Page 125)
Displaying battery status "Battery" Displaying battery status|(Page 162)
Activate memory management "Memory Activate memory management
Monitoring" (Page 163)

Activating vibration alarm

"Vibration Alarm"

Activating vibration alarm|(Page 140)

Changing password protection

"Password
Settings"

Changing password protection
(Page 127)

Changing the printer properties

Changing the printer properties
(Page 135)

Changing the PROFINET 10O setting

Enabling PROFINET IO |(Page 145)

SO

Changing regional settings

"Regional Settings"

Changing regional settings

(Page 130)
Changing the number format "Number"
Changing the currency format "Currency"
Changing the time format "Time"
Changing the date format "Date"
@ Setting the screen saver Setting the screen saver (Page 133)
Reducing the backlighting
i Tﬁ Displaying the system information "General" Displaying system properties
=7 Displaying memory information "Memory" (Page 139)

Setting the device name of the HMI device

"Device Name"

Setting the device name of the HMI
device (Page 149)

= Programming the data channel "Channel" Programming the data channel
L (Page 141)

Setting the delay time "Directories" Setting the delay time (Page 144)
=-'" Changing e-mail settings” "Email" Changing e-mail settings |(Page 153)

1)

Additional tabs may appear in the "WinCC flexible Internet Settings" dialog. This depends on the options that have
been enabled for network operation in the project.
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6.3 Control Panel

6.3.3 Operating the Control Panel

Introduction

The Control Panel is operated with the HMI device touch screen.

Procedure

Proceed as follows to change settings in the Control Panel:

1.

o > 0N

Close the project.

Use the provided operating element.

The Loader appears

Open the Control Panel by pressing "Control Panel".

To open the required dialog, double-click its icon.

Change as required by touching the tab.

Now make the necessary changes.

Touch the respective input object to make entries.

— Use the screen keyboard of the HMI device to enter the new values in the text boxes.
— Touch a button to operate it.

— Touch the selection box to open a drop down list box. Touch the required entry from
the drop down list box.

— Touch the check box to select or clear a check box.
— Touch a radio button to select it.
Confirm the entries using the button [gK| or terminate the entries using the button [X].

The dialog closes.

7. Close the Control Panel with the | X button.
8. Start the project with the "Start" button in the Loader.

Input with the screen keyboard

A screen keyboard is available for alphanumeric characters. The screen keyboard is
displayed as soon as you touch a text box. You can also call up the screen keyboard directly
from the Control Panel.
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Display methods for the screen keyboard

You can change the display method for the screen keyboard and fix the position on the
screen. Confirm an entry using the key or terminate the entry using the key .

Either action closes the screen keyboard.

® Numerical screen keyboard
7189«

4 56 Cel | Ins
123‘J

U- . |ESC| |

|Num

® Alphanumerical screen keyboard

“T1]213[als]e][7]8]e]o]-[=]« [ =Ix]

_quert}‘UiOp[]’lInsHomel;'
g |a|s|d|(flg|h|i|kK|P]:]"]|}\ pel | End | ¥
tly|z|x|ec|lv | b(n|{m|, | .|/ © |&c]| wm 4
cl | R an acer | R o - 4|
The alphanumerical screen keyboard has the following levels.
— Normal level
— Shift level
The shift level includes uppercase letters.
® Reduced screen keyboard
Changing the display of the screen keyboard
Key Functions
. Switching between the numerical and alphanumerical keyboard

Switching between the normal level and Shift level of the alphanumerical
screen keyboard

Switchover to special characters

Switching from full display to reduced display

Switching from reduced display to full display

Closing of reduced display of the screen keyboard

EEEEEE
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Moving the screen keyboard
In order to move the screen keyboard, proceed as follows:

Adjust screen keyboard size

Note

The [ icon only appears on the screen keyboard if in the "Siemens HMI InputPanel" dialog

box you have selected the "Show Resize button" check box.

To adjust the size of the screen keyboard, proceed as follows:
1. Touch the icon [#].
2. To adjust the size of the screen keyboard, maintain contact.

3. When the size you want is reached, release contact with the [ icon.

See also
Configuring the screen keyboard (Page 121)
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6.4 Changing settings for operation

6.4.1 Configuring the screen keyboard

Introduction

You can change the layout and the position of the screen keyboard as follows.

Requirements

You have opened the "Siemens HMI InputPanel - Options" dialog with the
(0

“ jcon.

Position and Size
[ Show Resize buttan

Currently closed...
| Open Input Panel ! @

Save current size and position...

‘ Save I @

@
®
®
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Check box for displaying the El button in the screen keyboard
Button for displaying the screen keyboard
Button for saving the screen keyboard settings
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Procedure
Proceed as follows:

1. If you want to change the size of the screen keyboard, activate the "Show Resize button
check box.

The [ icon also appears in the screen keyboard.
2. Use the "Open Input Panel" button to open the screen keyboard.

The appearance of the dialog box changes:

Siemens HMI Input Panel - Options m

Currently open...

‘ Close Input Panel : @

Save current size and position...

‘ Save I @

©) Button for closing the screen keyboard
® Button for saving the screen keyboard settings

3. If you want to switch between the numeric and alphanumeric screen keyboard, press
the key.

4. If you want to change the position of the screen keyboard, move it using the |

Release contact from the icon when the required position is reached.

5. If you want to increase the size of the screen keyboard, enlarge it to the size required
using the [ icon. Release contact from the icon when the required size is reached.

6. If you want to save the settings, press the "Save" button.

7. Close the screen keyboard by pressing the "Close Input Panel" button.

8. Confirm your entries.

The dialog closes.

Result
The screen keyboard settings have been modified.
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6.4 Changing settings for operation

Setting the character repeat rate of the screen keyboard

Introduction

You can set the character repeat for the screen keyboard in the Control Panel.

Requirements

Procedure

Result

You have opened the "Keyboard Properties" dialog with the "Keyboard" @ icon.

Keyboard Properties ok}

Repeat l

IV Enable characker repeat

Repeat delay: Long

&

Slow

) Repeat rate: e E
2 ™ ) e

Tap here and hold down a key to

ppp!

® e 0 0

Check box for selecting the character repeat

Slider control and buttons for the delay time before character repeat
Slider control and buttons for the rate of the character repeat

Test box

Proceed as follows:

1.
2.

If you want to enable character repetition, select the "Enable character repeat" check box.

If you want to change the delay, press a button or the slider in the "Repeat delay" group.
Moving the slider to the right will shorten the delay. Moving to the left will extend the
delay.

If you want to change the repeat rate, press a button or the slider in the

"Repeat rate" group.

Moving the slider to the right will shorten the repeat rate. Moving to the left will extend the
repeat rate.

. Verify your settings.

— Touch the test box. The screen keyboard opens.
— Move the screen keyboard as needed.
— Touch any character and keep it pressed.

— Check the implementation of the character repetition and the rate of the character
repetition in the test box.

— Correct your setting if necessary.

Confirm your entries.
The dialog closes.

The character repetition and delay are set.
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6.4.3 Setting the double-click

Introduction
You can start applications in the Control Panel and in Windows CE by double-clicking.
In the "Mouse Properties" dialog box you can change the following settings.
® The time interval between two clicks for a double-click
® The physical distance between two clicks for a double-click

A double-click corresponds to two brief touches in sequence.

Requirements

You have opened the "Mouse Properties" dialog with the "Mouse" iﬁ) icon.

Double-Click |

Double-click this grid to set the double-click.
sensitivity For both the speed and physical |
distance bebween clicks,

Double-click this icon ko test your double-click
settings, If this icon doesn't change, adjust
wour setbings using the grid above,

—®
—®

@ Icon for setting the double-click
® Icon for testing the double-click
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Procedure

Result

6.4 Changing settings for operation

Proceed as follows:
1. Double-click on the grid.
After one double-click the grid is shown in inverse colors.

25

2. Double-click on the icon.
If the double-click is valid, the icon is displayed as follows:

3. If the icon remains unchanged, double-click on the grid again.
4. Confirm your entries.

The dialog closes.

The double-click adjustment is completed.

6.4.4 Calibrating the touch screen

Introduction

Requirements

Depending on the mounting position and viewing angle, it is possible that parallax may occur
when operating the touch screen. In order to prevent any operating errors as a result,
calibrate the touch screen again in the startup phase or during runtime.

You have opened the "OP Properties" dialog box, "Touch" tab, by touching the

"OpP" 6@ icon.

OP Properties

If wour windows CE device is not responding

:Trff propetly ko your kaps, vou may need to

recalibrate yvour screen,

To start, kap Recalibrate,

Recalibrate
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Procedure
Proceed as follows:
1. Use the "Recalibrate" button to open the following dialog box:

Carefully press and briefly hold stylus on the center of
the target. Repeat as the target moves around the screen.

+ @

2. Briefly touch the center of the calibration crosshairs @.
The calibration crosshairs is then displayed at four more positions.
3. Touch the middle of the calibration crosshairs for each position.
If you do not touch the middle of the calibration crosshairs, the procedure is repeated.

Once you have touched the calibration crosshairs for all positions, the following dialog
appears:

New calibration settings have been measured.
Tape the screen to register saved data.
Wait for 30 seconds to cancel saved data and
keep the current setting.

Time limit: 30 sec

4. Touch the screen within 30 seconds.

The new calibration is saved. If you wait longer than 30 seconds, the new calibration is
discarded and the original calibration remains in effect.

The "OP Properties" dialog box, "Touch" tab is displayed again.
5. Close the dialog.

Result
The HMI device touch screen is now recalibrated.
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6.5 Changing password protection

Introduction
You can protect the Control Panel and the Windows CE taskbar with a password.

Requirements
You have opened the "Password Properties" dialog with the "Password" @ icon.

Password Properties m

Pazsword Settings l

i Passwiord
‘?% Password: @
Canfirm passwaord: @

® Password text box
® Text box for entering the password a second time

NOTICE

If the password is no longer available, you cannot do the following until you have updated
the operating system.

e Making changes to the Control Panel

e Operating the Windows CE task bar

All data on the HMI device will be overwritten when you update the operating system!

Procedure for activating password protection
Proceed as follows:
1. Enter a password in the "Password" text box.
2. Repeat the password entry in the "Confirm password" text box.
3. Confirm your entries.

The dialog closes.

NOTICE

The following characters cannot be used in passwords:
e Blank

e Special characters *? . % /\'"

Result
You cannot open the Control Panel or Windows CE taskbar without entering a password.
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Procedure for deactivating password protection

Proceed as follows:

1. Delete the inputs in the "Password" and "Confirm password" text boxes.

2. Confirm your entries.

The dialog closes.

Result

Password protection for the Control Panel and the Windows CE taskbar is disabled.

6.6 Changing HMI device settings

6.6.1 Setting the date and time

Introduction

You can set the date and time on the HMI device. The HMI must be restarted in the
following cases:

® You have changed the time zone setting

® You have changed the "Daylight savings time currently in effect" check box setting

Requirements

122

You have opened the "Date/Time Properties" using the "Date/Time Properties" -GJ icon.

DatefTime Properties m

Datef Time l

Time Zone |(GMT) Greenwich Mean Time : Dublin, EdinblLl—

1]

Januar 2006 “ Current Time

M DF 5 5 | |06:0328 =

2
9
16
23
30

3

1011 12 13 14 15 [
17 18 19 20 21 22
24 Efze 27 28 29

31

1
4 5 6 7 &

Davylight savings kime
currently in effect

b b

|
apphy 1

®©® 000

128

Time zone selection box
Text box for the time

Date selection box

"Daylight savings" check box
Button for applying changes
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Procedure

Result

Internal clock

6.6 Changing HMI device settings

Proceed as follows:

1.
2.

Select the appropriate time zone for the HMI device from the "Time Zone" selection box.
Touch the "Apply" button to confirm your entry.

The time of day shown in the "Current Time" box is adjusted correspondingly to the
selected time zone.

Set the date in the selection box.

4. Set the current time of day in the "Current Time" text box.

5. Touch the "Apply" button to confirm your input.

The values you have set are now in effect.

Note
The system does not automatically switch between winter and summer time.

If you want to switch from winter to summer time, select the
"Daylight savings time currently in effect" check box.

When you press the "Apply" button, the time is brought forward by one hour.

If you want to switch from summer to winter time, clear the
"Daylight savings time currently in effect" check box.

When you press the "Apply" button, the time is moved backwards by one hour.

. Confirm your entries.

The dialog closes.

The settings for the data and time of day have now been changed.

The HMI device has an internal buffered clock.

Synchronizing the date and time with the PLC

The date and time of the HMI device can be synchronized with the PLC if this has been
configured in the project and the PLC program.

See also

Additional information on this subject is available in the "WinCC flexible" system manual.

NOTICE

Time-dependent reactions

You have to synchronize the date and time when time-controlled responses are triggered in
the PLC by the HMI device.

Restarting the HMI device (Page 137)
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6.6.2 Changing regional settings

Introduction

In different countries, for example, the date, time and decimal points are displayed
differently. You can adjust the display format to meet the requirements of different regions.

The country-specific settings apply to the current project. If the project language is changed,
the country-specific settings are also changed.

Requirements
You have opened the "Regional and Language Settings" dialog with the

"Regional Settings" 5 icon.

Regional and Language Settings

Regional Settings | Murnber I Currency I Time I Date |

» W
o hs
- -

Many programs have different
-|international settings, Regional
adjustrnents in date-, time-,
currency- and numbers-
conventions for displaying and

.| sorting data can be achieved in
-k changing those international

0] Region selection box

Procedure
Proceed as follows:
1. Select the region from the selection box.

2. Change to the "Number", "Currency", "Time" and "Date" tabs and set the selection boxes
to the desired settings.

3. Confirm your entries.

The dialog closes.

Result

The HMI device's regional settings have been changed.
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6.6.3 Backup registry information

Registry information and temporary data

You can install and uninstall your own programs on the HMI devices under Windows CE.
You must save the registry settings after installation or uninstallation.

You can save the following data to the flash memory:

® Reqgistry information

® Temporary files

Restoring the file system of a memory card

If memory cards are used, the file system on the memory card may become damaged,
perhaps due to a power failure. The HMI device detects the defective file system on start-up
or when the memory card is inserted. The HMI device can restore the file system
automatically or on request.

Requirements

You have opened the "OP Properties" dialog box, "Persistant Storage" tab, by touching the

"OpP" 4@ icon.

—

Sawe actual reqgistry settings to flash,
Syskem will start with saved registry Save Regiskry
setkings nexk time,

Sawe all files Fram kermparary memary

{e.g. the "Program files' directory) to Save Files
flash, The Files will be restored during

system startup, The "Temp' directory

will nok be saved.

Automatically repair file swskem errors on storage
cards at syskem startup and card insertion tine

i Display ] Device ] Touch l

® e 6
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Meaning of the text in the dialog:

Saves the current registry information to the flash memory. The HMI device loads the saved
registry information the next time it boots.

Button for saving registry information
Button for saving temporary files
Meaning of the text in the dialog:

Saves all the files in temporary storage to the flash memory (for example, from the
"Program Files" directory). These files are written back when the HMI device is started.
The "\Temp" directory is not saved.

Check box for automatically restoring the file system on the memory card when the
HMI device starts up and when a memory card is inserted.
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Procedure
Proceed as follows:
1. If you want to save the current registration entries, click the "Save Registry" button.
2. If you want to save the temporary files, click the "Save Files" button.
3. Specify how the file system on the memory card should be restored.
— Activate automatic restore by selecting the "Automatically Repair ..." check box.
— If you only want the restore to be carried out upon prompting, clear the
"Automatically Repair ..." check box.
4. Confirm your entries.
The dialog closes.
Result

The desired data is saved.

6.6.4 Changing screen settings

Requirements

You have opened the "OP Properties" dialog box, "Display" tab, by touching the
"OP" 4@ icon.

OP Properties m

Persistent Storage |- Display l Device l Touch l

(D
)

Up DOWN

rrightness

0] Button for increasing the brightness
® Button for reducing the brightness
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Procedure

Result

6.6.5

6.6 Changing HMI device settings

Proceed as follows:

1. If you want to increase the brightness of the screen, press "UP".
2. If you want to reduce the brightness of the screen, press "DOWN".
3. Confirm your entries.

The dialog closes.

The screen settings have been changed.

Setting the screen saver

Power management settings in the WinCC flexible project

To save power, the HMI device has a power management function with the following states:
® "Power Save 1"

— Reduces the brightness of the backlighting.
® "Power Save 2"

— The touch screen is switched off.

— The function keys are not active.

The relevant time intervals are set in the project. Power management is automatically
activated if the HMI device is not operated within the specified period of time.

You can clear the "Power Save 1" state by touching the touch screen or pressing the
function key.

You can clear the "Power Save 2" state by briefly pressing the ON/OFF button.

Settings in the Control Panel

You can also set the following time intervals in the HMI device Control Panel:
® For the automatic activation of the screen saver
® For the automatic reduction in the screen's backlighting

The screen saver and the reduced screen backlighting functions are switched back off by
means of the following actions:

® By pressing any key
e By touching the touch screen

The function associated to the key or button will not be executed by this.
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Validity

Requirements

134

The time until the backlighting is reduced is always the shorter time interval.

In other words,. the time interval set in the "Screensaver" dialog box applies if it is shorter
than the setting for "Power Save 1" in the project.

If a value of "0" is entered in the "Screensaver" dialog box for the reduction in backlighting,
the value set in the project will apply.

After you have selected the screen saver and reduction of the backlighting, you must restart
the HMI device. The settings become effective following a restart.

NOTICE
Reducing the brightness of the backlighting

The brightness of the backlighting decreases incrementally during its operational life. In
order to increase the operational life of the backlighting, activate the backlighting reduction.

Burn-in effect

Screen contents may occasionally leave a burn-in effect in the background if they appear
too long.

This burn-in effect will automatically disappear after a certain amount of time if the
screensaver is activated, for example. The longer the same content is displayed on the
screen, the longer it will take for the burn-in effect to disappear.

Generally, you should always activate the screen saver.
When the screen saver is active, the backlighting is reduced at the same time.

You have opened the "Screensaver" dialog with the "ScreenSaver" @ icon.

Screensaver m

Dirn Backlight becomes active after | § ™| mirtes 1
Screensaver becomes active after | d TS @
®

@ Standard () Blank Screen)

Enter a '0' bo disable the function,
The minimum Eime is 5 and the maximum is 71552 minutes,

0] Time interval in minutes until backlighting is reduced
® Period of time in minutes before the screen saver is activated
® Screen saver setting
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Proceed as follows:

Enter the interval in minutes after which the backlighting is to be reduced.
Entering "0" will deactivate the backlighting reduction.

Enter the number of minutes before the screen saver is to be activated.
The minimum time is 5 minutes and the maximum time is 71,582 minutes.
Entering "0" disables the screen saver.

Select either the standard screen saver or an empty screen.

— In order to select the standard screen saver, select the "Standard" option.

— In order to select a blank screen as screen saver, select the "Blank Screen" option.

Confirm your entries.

The dialog closes.

The screen saver and the reduced backlighting for the HMI device is set. After you have
reselected the screen saver and reduction of the backlighting, you must restart the
HMI device. The selection becomes effective following a restart.

Procedure
1.
2.
3.
4.

Result

See also

Power management (Page 82)
Restarting the HMI device |(Page 137)

6.6.6 Changing the printer properties

Introduction

You can print hardcopies and reports on a network printer. Line printing of alarms is not
possible on a network printer.

The list of current printers and required settings for HMI devices can be found on the Internet
under "http://support.automation.siemens.com/WW/view/en/11376409".
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Requirements

Procedure

Result

136

=
You have opened the "Printer Properties" dialog with the "Printer" icon.

Printer Properties m

Printer Language: IEpsnng E_ —®
Part: Metwirk: E @
Metwork: \\=erver 321prinkeral —@
Paper Size: IM E @
Qrientation = | ( : )
@) Portrait () Landscape | @

I:] Craft Mode |:| Color

Q

CNONCONONCNONC)

Selection boxd for the printer

Interface selection box

Network address of the printer

Paper format selection box

"Orientation" group with radio buttons for print orientation
Print quality check box

Color printing check box

Proceed as follows:

1.

o M Db

Select the printer from the "Printer Language:" selection box.
In the "Port:" selection box, select the "Network:" interface.
In the "Network:" text box, enter the network address of the printer.
Select the paper format from the"Paper Size:" selection box.
Select the required radio button in the "Orientation" group:
"Portrait" for portrait
"Landscape" for landscape
Select the print quality.
— Select the "Draft Mode" check box if you wish to print in draft mode.
— Clear the "Draft Mode" check box if you wish to print with higher quality.

If the printer selected can print in color and you wish it to do so, select the
"Color" check box.

Confirm your entries.

The dialog closes.

The settings for the printer have now been changed.
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6.6 Changing HMI device settings

6.6.7 Restarting the HMI device

Introduction

The HMI device must be restarted in the following cases:

Requirements

You have activated or deactivated the PROFINET 1O direct keys.

You have changed the time zone setting

You have switched between summer time and winter time.

You have reselected the screen saver and reduction of the backlighting.

You have changed the data transfer rate to the Access Point.

NOTICE

Data loss when the HMI device is restarted
All volatile data is lost when the HMI device is restarted.

Check the following:
e The project on the HMI device is complete

¢ No data is being written to the flash memory

You have opened the "OP Properties", tab "Device" dialog box with the icon "OP" 4@

OP Properties

Device: Mabile Panel 277 TwLAN
Irnage Yersion: W01.00,00,00_01.42
Bookloader Yersion: 0.1z

Bootloader Rel Date: 20,5,2007

Flashsize: &4 MB

Battery I Mernary [Manitaring rIIIZI

Rebaok : @

@

Mobile Panel 277 IWLAN

Button for restarting the HMI device
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6.6 Changing HMI device settings

Procedure
1. Press "Reboot" to reboot the HMI device.
A warning is displayed.
The HMI device reboots immediately if you confirm this warning.
Result
The HMI device starts.
See also

Setting the date and time |(Page 128)
Enabling PROFINET IO (Page 145)
Overview (Page 109)

6.6.8 Displaying information about the HMI device

Introduction
You will need the device-specific information if you contact A&D Technical Support.

Requirements

You have opened the "OP Properties" dialog box, "Device" tab, by touching the

"OpP" 4@ icon.

i Device || Touch | Battery I Memary Monitaring r 1] ’I

Device: IMobile Panel 277 TWwLAN II4®

Image Version: Mol ,00,00,00_01,42 " @
Bootloader Yersion: 0.1z " @
Bootloader Rel.Date: 20.5,2007 " @

Flashsize: &4 ME @

HMI device name

Version of the HMI device image
Version of the boot loader

Boot loader release date

®©® 000

Size of the internal flash memory in which the HMI device image and project are stored
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Procedure
Proceed as follows:
1. The HMI device-specific information is displayed in the "Device" tab.

2. Close the dialog when the information is no longer required.

Note

The memory available for the project is only a part of the internal flash memory displayed.

6.6.9 Displaying system properties

Introduction

The system-specific information provides you with information about the processor,
operating system and memory of the HMI device.

Requirements

You have opened the "System Properties" dialog with the "System" icon.

General | Memary | Device Mame |

System: Computer:

Microsoft@® WindowsE CE Processar Type: |Inte|, ARMOZOT-PXAZ
Hiesel S Expansion Slots: I EI
@ 2004 Microsoft Corp, &1 rights Mernary: 86204 KB RAM
reserved. This computer program is ) :

protected by LS, and international Registered to:

copyright lawes,

@ ®

0] Copyright for Microsoft Windows CE

® Information about the processor, size of the internal flash memory, and capacity of a
memory card when inserted

Displaying system properties
The system information is displayed. This dialog is read-only.
Close the dialog.
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6.6 Changing HMI device settings

Procedure for displaying memory information

NOTICE
"Memory" tab

Do not change the memory distribution in the "Memory" tab.

Only applies for the usage of options:
An alteration to the memory distribution may be necessary. Please refer to the
accompanying documentation for the option for additional information.

Proceed as follows:
1. Change to the "Memory" tab.

The memory information is displayed.

System Properties m
Memory | Device Mame

Move siider to the left for more memaory to run programs, Move slider to
the right. for more storage room, Only unused RAM can be adjusted,

] 1

Stnrage T R LR R T R R LR R T R R R RN TR TR TR L AR TR TRTIRT) Prugram
Memory Ii:ﬁ Memory

Allocated 16384KE Allocated 69520KE
In Use BS2KB In Use 13480KE

2. Close the dialog.

6.6.10  Activating vibration alarm

Introduction

Requirements

140

You can activate a vibration alarm for the HMI device. The vibration alarm is triggered in the
current project if the charging status of the main battery is critical.

You have opened the "OP Properties" dialog box, "Vibration Alarm" tab, by touching the

"OP" 4@ icon.

| Battery | Memory Monikoring || Yibration Alarm | [ 4] |

Fibration Alarm

|:| Enable Virbration alarm

Mobile Panel 277 IWLAN
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Procedure
1. Select the "Enable Vibration Alarm" check box.
2. Confirm your entries.
The dialog closes.
Result
The vibration alarm is activated.
6.7 Programming the data channel
Introduction

You can only transfer a project if you have enabled at least one data channel.

If you block all data channels, the HMI device is protected against unintentional overwriting
of the project data and HMI device image.

Note

Data channel 1 is not available with the Mobile Panel 277 Wireless.

Requirements

=
The "Transfer Settings" dialog box has been opened using the "Transfer Settings" ¢, icon.

Transfer Settings m

Channel | Directoties

Channel 1:

Serialivia R5232[PPI Multi-Master Cable

[ Enable Channel [ ] Rremote Control

Channel 2:
I = THERMET : | @
[ ] Enable Channel [] Remate Contral PelverEzd @

0] Group for the data channel 2 (Channel 2)
® Button for the "Network and Dial-Up Connections" dialog box

Mobile Panel 277 IWLAN
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6.7 Programming the data channel

Procedure
Proceed as follows:
1. Select the desired interface from the selection box.
Note
"Ethernet" is for communication via LAN and WLAN.
2. If you want to enable the data channel, select the "Enable Channel" check box.
3. If you want to disable the data channel, clear the "Enable Channel" check box.
4. If you want to enable automatic transfer, select the "Remote Control" check box.
A WARNING
Unintentional transfer mode
Ensure that the configuring PC does not inadvertently switch the HMI device to transfer
mode during the open project. This could cause unintentional actions to be triggered in
the plant.
5. Enter further parameters if required.
— Applies to "ETHERNET"
Press "Advanced" to change to "Network and Dial-Up Connections".
Open the "LAN"or "WLAN" entry. You can change the TCP/IP settings there.
Confirm your entries.
Close "Network and Dial-Up Connections".
— Applies to "USB"
No further settings are required for "USB".
6. Confirm your entries.
The dialog closes.
Result

The data channel is programmed.
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General information

Note
Changes during the "Transfer" operating mode

If changes are made to the transfer settings when the HMI device is in "Transfer" mode or
while a project is running, the new settings only take effect the next time a transfer or the
project is started.

This may occur if the Control Panel is opened to change the transfer properties in an active
project.

NOTICE

Transfer mode via channel 2

You can change the settings for the transfer.

The following steps are required:

e Close the project.

e Change the settings on the HMI device.
e Then return to "Transfer" mode.

See also
Changing the network configuration (Page 150)
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6.8 Setting the delay time

6.8 Setting the delay time

Introduction

The project is opened following a delay time when the HMI device is switched on.
The Loader is displayed during the delay time.

Requirements

You have opened the "Transfer Settings" dialog box, "Directories" tab, by touching the

8
"Transfer" i,m icon.

Transfer Settings

Channel | Directories

Project File

I'l,FIash'l,Simatic'l,

Project Backup

I'I,Storage Card MM, Simakich,

Aukostart application:

Path:

WWaik [zec]:

I'l,FIash'l,Simatic'l,HmiRTm JBXE

[ t y
®» ©@ 4@ ©)

P —=

0] Directory where the project file is saved

® Directory where the compressed source file of your project is saved

The external memory card or the network connection can be defined as the storage location.
During the next backup process, the project's source file is stored in the specified location.

® Memory location and start file of the HMI device for the executable project file
® Delay time selection box
NOTICE

Settings under "Project File" and "Path”

Do not change the setting in the "Project File" and "Path:" boxes. The project may not open
at the next start of the HMI device if changes are made here.

144
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Procedure for setting the delay time
1. Select the desired delay time in seconds from the "Wait [sec]:" selection box.

With the value "0", the project starts immediately. It is now no longer possible to call the
Loader after switching on the HMI device. If you still do need to access the Loader an
operating element must be configured to close the project.

2. Confirm your entries.

The dialog closes.

Result

The delay time for the HMI device is now set.

6.9 Enabling PROFINET 10

PROFINET 10

Function keys or buttons can be configured as PROFINET 10 direct keys. If PROFINET IO
direct keys are used in the project, they must be enabled.

Requirements

You have opened the "PROFINET" dialog with the "PROFINET" ) icon.

WL

@ wLan

Device name: {max. 240 charackers)

@
@

[HM1-Panel — - 4@
—®

MAC-Address LAN: 12-34-56-75-94-BC

@

MAC-Address WLAN:  00-0F-A3-DD-DA-CD —

Check box to enable or block PROFINET IO direct keys
Group for communications link

Text box for the device name

MAC address of the LAN interface

MAC address of the WLAN interface

®©® 0 0
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6.9 Enabling PROFINET 10

Procedure

Result

See also

146

1. To enable PROFINET 10O direct keys, select the "PROFINET 10 enabled" check box.

2. Select the communications link.

Note

Select "LAN" for service purposes only. If you select "LAN", the HMI device is connected
directly to the network via the RJ45 interface.

If you connect the configuring PC directly to the HMI device through the RJ45 interface,
you must open the connection compartment. If the connection bay is open, degree of
protection IP65 is not fulfilled.

3. Enter the device name of the HMI device.

The device name can have a maximum of 240 characters.

NOTICE
Addressing error of PROFINET IO device

The device name does not correspond to the computer name in Windows CE.

The device name must match the device name entered in the HW Config of STEP 7.

4. Confirm your entries.
The dialog closes.

5. Reboot the HMI device after saving the settings.

The PROFINET IO direct keys are enabled.

Restarting the HMI device (Page 137)
Direct keys (Page 197)
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6.10 Configuring network operation

6.10.1 Overview of network operation

Introduction
You connect the HMI device to a PROFINET network.
The connection to a network offers, for example, the following options:
® Printing via a network printer
® Saving, exporting and importing of recipe data records on or from a server
e Setting up of message and data archives
® Transferring a project
® Saving data
NOTICE
The HMI device can only be used in PROFINET networks.
The HMI device only has client functionality in the PC network. This means that users
can access files of a node with TCP/IP server functionality from the HMI device via the
network. However, you cannot, for example, access data on the HMI device from a PC
via the network.
Note
Information on communication using SIMATIC S7 via PROFINET is provided in the
"WinCC flexible communication" user manual.
Addressing

Within a PROFINET network, computers are usually addressed using device names.
These device names are translated from a DNS or WINS server to TCP/IP addresses.

The corresponding servers are generally available in PROFINET networks.

Note

The use of TCP/IP addresses to address PCs is not supported by the HMI device's
operating system.

So to address the HMI device using device names in a PROFINET network, you need a
DNS or WINS server.

Consult your network administrator if you have questions in this regard
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6. 10 Configuring network operation

Printing via a network printer

The HMI device's operating system does not support line by line alarm logging via a network
printer. All other printing functions, for example hardcopy or logs are available without
restriction via the network.

Preparation

Before beginning the configuration, request the following network parameters from your
network administrator.

® Does the network use DHCP for dynamic assignment of network addresses?
If not, get a new TCP/IP network address for the HMI device.

® Which TCP/IP address does the default gateway have?

o |f a DNS network is used, what are the addresses of the name server?

e [f a WINS network is used, what are the addresses of the name server?

General procedure for configuring the network

The HMI device must be configured prior to network operation. The configuration is basically
divided into the following steps:

Proceed as follows:

1. Enter the device name of the HMI device.
2. Configure the network address.

3. Set the logon information.
4

. Save the settings.
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6. 10 Configuring network operation

6.10.2 Setting the device name of the HMI device

Introduction

Requirements

Procedure

Result

See also

The HMI device uses the device name to identify itself in the network.

You have opened the "System Properties" dialog with the "System" &7/ icon.

General] Memory | Device Name l

These settings are used to identify your Windows CE device to
other cormputers,
Please type a name (without any spaces) and a short description.

Device name:

Device description: |HMI Device —_@

0] Device name of the HMI device
@ Description for the HMI device (optional)

Note

To activate the network functions, enter a unique device name in the Device name text box.

Proceed as follows:

1. Enter the device name for the HMI device in the "Device name:" text box.

2. If necessary, enter a description for the HMI device in the "Device description:" text box.

3. Confirm your entries.

The dialog closes.

The device name for the HMI device is now set.

Overview of network operation |(Page 147)
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6. 10 Configuring network operation
6.10.3 Changing the network configuration

Introduction

You can change the network settings for the WLAN and LAN connection under
"Network and Dial-Up Connections".

Requirements for changing WLAN or LAN connection settings
You have opened the following display by touching the

"Network and Dial-Up Connections" e;_, icon.

| File Edit View Advanced ||}(|| E

[z1[x]

oA o4
or T
WILAM LAMN

You can enter the connection parameters for the WLAN and LAN connection.
The parameterization is identical.

Procedure for setting the connection parameters

The following procedure shows how to set the connection parameters using the
WLAN connection.

Proceed as follows:
1. Open the "WLAN" entry.
— The ""WLAN' Settings" dialog box opens.

'WLAN' Settings 0K,

IP Address |Name Servers |

&n IP address can be () Obtain an IP address via DHCP
autornatically assigned to this .
computer, If wour network
does not autornatically assign

IP addresses, ask your network IP Address: 1 Bic FEUREe
adrministratar for an address, Subnet Mask: 555 255 255 .0

and then type it in the space

provided, Diefault Gateway: |:|

o

2. Select either automatic address assignment via DHCP or manual address assignment.

3. If you assign the address manually, enter the corresponding addresses in the text boxes
for "IP Address", "Subnet Mask" and, if used, "Default Gateway".
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4. If a name server is used in the network, change to the "Name Servers" tab.

6. 10 Configuring network operation

IP Address | Mame Servers

MName server addresses may be
autornatically assigned if DHCP
is enabled on this adapter,
You can specify additional
WINS or DS resolvars in the
space provided.

Primary DMNS:
Secondary DMS:
Prirnary WIkS:
Secondary WINS:

[ ]
. ]
[ ]

5. Enter the appropriate addresses.

6. Confirm your entries.

The dialog closes.

7. Close the "Network and Dial-Up Connections" display.

The Control Panel is displayed again.

Result

The WLAN/LAN connection parameters for the HMI device have been set.

See also

Overview of network operation|(Page 147)
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6. 10 Configuring network operation

6.10.4 Changing the logon data

Introduction

In order to access certain network resources you need to log on to the network as a user.
Your administrator will issue you with a user name and password and the name of the

domain.

Requirements

) 5
You have opened the "Network ID" dialog with the "Network ID" icon.

Identification |

Windows CE uses this Lser narne: |
inforrmation to gain access to

rnetwork resources. Enter the  Password: |

Liser name, password, and
domain provided by your Daornain: |
network adrinistrator.

Procedure
Proceed as follows:
1. Enter the user name in the "User name" text box.
2. Enter your password in the "Password" text box.
3. Enter the domain name in the "Domain" text box.
4. Confirm your entries.
The dialog closes.
Result
The logon data has now been set.
See also
Overview of network operation|(Page 147)
152
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6. 10 Configuring network operation

6.10.5 Changing e-mail settings

Requirements

You have opened the "WInCC flexible Internet Settings" dialog with the

.

"WinCC Internet Settings" =] icon.

SMTP setrver g
@l Use the default of the project file

wWinCC flexible Internet Settings m

O ——

Mame

Sender: |Sirnatiu: HMI Device —4@
Authentication: | _4@

0] Setting the SMTP server
® Name for the sender

® E-mail account

Note

Options

Additional tabs may appear in the "WinCC flexible Internet Settings" dialog. This depends on
the options that have been enabled for network operation in the project.

Procedure for changing e-mail settings

Result

See also

Proceed as follows:

1.

Specify the SMTP server.

— Select the "Use the default of the project file" option button if you want to use the
SMTP server configured in the project.

— Clear the "Use the default of the project file" option button if you do not want to use the
SMTP server configured in the project. Specify the required SMTP server.

Enter the name for the sender in the "Sender" text box.
Enter the e-mail account for your e-mail in the "Authentication:" text box.

Some e-mail providers only allow you to send mail if you specify the e-mail account.
The "Authentication:" text box can remain empty if your e-mail provider allows you to
send mail without checking the account.

. Confirm your entries.

The dialog closes.

The e-mail settings have been changed.

Overview of network operation|(Page 147)
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6.11 Changing internet settings

6.11 Changing internet settings

6.11.1 Changing general internet settings

Requirements
You have opened the "Internet Options" dialog box, "General" tab, by touching the

"Internet Options" 9 icon.

Internet Options m

G3Eneral |Cc:nneu:tic:n IPrivacv I Ldvanced |

Start Page: Ihttp:waw.siemens.cumfautumation

Search Page: Ihttp:waw.siemens.cumfautumationfser\tice

User Agent (requires browser restart): IDefauIt (windows CE) El
Cache Size (in KB): |512 ‘ Clear Cache | |Clear Histunrl
Note

Do not change the settings in the "User Agent" box.

Procedure

Proceed as follows:
Enter the homepage for the Internet browser in the "Start Page" text box.
Enter the address of the required search engine in the "Search Page" text box.
Enter the required cache memory size in the "Cache" text box.
If you want to delete the cache memory, press the "Clear Cache" button.

If you want to delete the history, press the "Clear History" button.

I S o

Confirm your entries.

The dialog closes.

Result

The general parameters for the Internet browser have been set.
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6.11.2 Setting the proxy server

Requirements
You have opened the "Internet Options" dialog box, "Connection" tab, by touching the

"Internet Options" 9 icon.

Internet Options m
- Connection |F‘rivac\,r | advanced |
[]Use L&N (no autodial)  Autodial name: | El
Network

|:| tccess the Internet using a proxy server:

Address: I Paort: IEID

|:| Bypass proxy server for local addresses

Procedure
Proceed as follows:
1. Select the "Use LAN (no autodial)" check box.

2. If you are using a proxy server, in the "Network" group, select the
"Access the Internet using a proxy server" check box.

Specify the address of the proxy server and the interface.

3. If you want to bypass the proxy server for local addresses, select the
"Bypass proxy server for local addresses" check box.

4. Confirm your entries.

The dialog closes.

6.11.3 Changing data protection settings

Cookies and encryption

Cookies are pieces of information sent by a web server to a browser. In the event of
subsequent access to the web server, the cookies are sent back. This enables information to
be stored between the accesses.

In order to ensure a high level of privacy, data are sent via the Internet in encrypted form.
Common encryption protocols include SSL and TLS. You can activate or deactivate the
usage of encryption protocols.

The required settings can be obtained from your network administrator.
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6.11 Changing internet settings

Requirements

You have opened the "Internet Options" dialog box, "Privacy" tab, by touching the

"Internet Options" 9 icon.

Internet Options

| General | Conmection | Privacy | Advanced |

okf %

Cookies

First-party Cockigs Third-party Cookigs
i@ () Accept

) Block ) Block

() Prompt @) Prompt

Blways allow session caokies

Procedure
Proceed as follows:

1. Select the required cookie behavior by means of the radio buttons.

"Accept”

Cookies are stored without request.
— "Block"

Cookies will not be stored.
- "Prompt"

Cookies will be stored on request.

2. If you want allow cookies which are restricted to a single session, select the

"Always allow session cookies" check box.

3. Change to the "Advanced" tab.

Internet Options

[General I Connection IF‘rivac\,r | Advanced |

CX E3

o
Use S5L 2.0
Use S5L 3.0
Use TLS 1.0

warn if changing between secure and not secure mode

4. Activate the required encryption protocol.
5. Confirm your entries.

The dialog closes.

Result
The safety settings have now been set.
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6.11.4 Importing and deleting certificates

Overview
You can import, view and delete certificates. The certificates differ in the following ways:
® (Certificates that you trust
e Own certificates
® Other certificates

The required settings can be obtained from your network administrator.

Requirements
You have opened the "Certificates" dialog with the "Certificates" icon.

Stares |

Class 2 Public Primnary Certification Authority E
Class 3 Public Prirnary Certification Authority
Entrust.net Certification Authority (2048)
Entrust.net Secure Server Certification Authorit

Lists the certificates Equifax Secure Certificate Autharity
trusted by you GlobalSign Root €& El
Import.. | | View.. | | Remoye |

Procedure
Proceed as follows:
1. Select the type of certificate from the selection box:
"Trusted Authorities"
"My Certificates"
"Other Certificates"
2. If required, start the importing process with the "Import.." button.
A dialog with source details will open.
3. If required, delete the certificate.
— Mark the desired certificate.
— Delete the selected certificate using the "Remove" button.
4. The "View.." button enables you to list the properties of the selected certificate.
5. Close the dialog.
Result

The changes to the certificates have been carried out.
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6.12 Backing up and restoring with an external memory medium

6.12 Backing up and restoring with an external memory medium

Backup

During a backup, the following data is copied from the HMI device's internal flash memory to
an external memory medium.

® QOperating system

® Applications

e Data

The following external storage devices are possible:
® Memory card

® USB memory stick

CAUTION
IP65 degree of protection not fulfilled

To insert or remove the memory card, you must open the HMI device's connection
compartment. If the connection bay is open, degree of protection IP65 is not fulfilled.

It is preferable to back up onto a USB memory stick.

Requirements for backup
® The current project and all other applications are closed, except Control Panel.
e The HMI device features an external storage device with sufficient free space.

The size of the internal flash memory is displayed with information about the HMI device.
If the available space on the external memory medium is insufficient, a warning is
displayed and backup is aborted.

You have opened the "Backup/Restore" dialog with the "Backup/Restore" @ icon.

Backup f Restore

All other application must be ended before
starting <BACKLIP= or <RESTORE:=.

Backup (to storage card)

BACKUP

Restore (from storage card)

RESTORE
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6.12 Backing up and restoring with an external memory medium

Procedure for backup
Proceed as follows:
1. Select "BACKUP" to start Backup.
The HMI device checks the external memory.
The HMI device issues messages in the following situations:
— More than one external memory is available:
Select the desired memory.
— The external memory is not available or is defective:
Acknowledge the displayed messages.
The Control Panel is displayed again.
Replace the external memory. Start the backup process again.
— Data is already stored on the external memory.
2. Follow the instructions of the HMI device.
The following messages are displayed in sequence during backup:
"Checking Registry"
"Backup Progress"
"Saving CE-Image"
A progress bar shows the status of the backup process.
If backup was successful, the following message is displayed:
"Backup successfully completed. Press OK and remove your storage card."
3. Click "OK" button to acknowledge the message.

Remove the external memory medium.

Result

The HMI device data is now saved on the external memory.

Requirements for restoring
The HMI device features an external memory medium that stores the backup.

Mobile Panel 277 IWLAN
Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0 159



Configuring the operating system

6.12 Backing up and restoring with an external memory medium

Procedure for restoring

NOTICE

Deleting the flash memory

A restore operation deletes the old data from flash memory of the HMI device on
confirmation. The data stored on the external memory is then copied to the internal flash
memory. Existing license keys are deleted following your confirmation.

The restore process involves the following steps:
® The Windows CE image is restored.
® The HMI device starts.

e All other data is restored.

NOTICE

Cancel restore

If the external memory is removed during the restore process, the process is canceled.

Ensure that the external memory is not removed at any point during the restore process.

Proceed as follows:
1. Select "RESTORE" to start Restore.
The HMI device checks the external memory.
The HMI device issues messages in the following situations:
— The external memory is not available or is defective:
Acknowledge the displayed messages.
The Control Panel is displayed again.
Replace the external memory.
— More than one external memory with valid backup is available:
Remove all external memories with backups that are not needed.

If necessary, you can check the available external memories using the
"REFRESH" button.
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Result

See also

Mobile Panel 277 IWLAN

6.12 Backing up and restoring with an external memory medium

. If necessary, start the restore process with the "RESTORE" button.

The data to be restored is checked.
When the check is complete, one of the following prompts is displayed:

"You are starting RESTORE now. All files (except files on storage cards) and the
registry will be erased. Are you sure?"

At this point you can cancel the restore using the "No" button to prevent the data on
the HMI device from being deleted.

— You are now starting RESTORE. All files on the panel and the licenses listed below as
well as the registry will be erased. Are you sure?

This query is displayed when license keys are available both on the HMI device and in
the backup data. If necessary, cancel the restore process with the "No" button and first
back up the HMI device's license keys. Then restart the restore process.

. Start to restore the data by selecting "Yes".

A progress bar shows the status of the restoration of the Windows CE image.
When restore is completed, the following message is displayed:

"Restore succesfully finished. Press ok, remove your storage card and reboot
your device."

4. Remove the external memory.

5. Acknowledge this message.

The HMI device starts.

The backed-up data has been restored to the HMI device.

Note
Calibrating the touch screen

After the restore, you may have to re-calibrate the touch screen.

Displaying information about the HMI device |(Page 138)
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6.13 Displaying battery status

6.13 Displaying battery status

Introduction

Requirements

Procedure

162

You can check the charging status and the temperature of the main battery and the bridging
battery.

NOTICE
Battery cannot be charged

To charge the batteries, the ambient temperature/battery temperature must not exceed
40 °C The higher the temperature, the longer it will take for the battery to charge.

Find a place with a cool ambient temperature for the charging station. If necessary, allow
the battery to cool first.

You have opened the "OP Properties" dialog box, "Battery" tab, by touching the

"OP" 4@ icon.

OP Properties

Memory Manitoring

Main Batkery

Capacity 20 %% 0 [ 100+
Temperature 42 =C 0 [—— 70 <

Backup Battery
Capacity 0 % ol

Temperature 0 =C 0] 70 -

| Update 4@=

Charging status of main battery
Temperature of main battery
Charging status of bridging battery
Temperature of bridging battery

®©® 00

Button to update the display

Proceed as follows:
1. Update the display if required by pressing the "Update" button.
2. Close the dialog.
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6. 14 Activate memory management

6.14 Activate memory management

Memory management

Requirements

Procedure

Result

Provided the memory management is activated, the HMI device will automatically close the
project if the memory needs reorganizing during an active project.

The project is shut down and the HMI device will display a message. You have to restart the
project.

NOTICE
Memory management

If you do not activate memory management, undefined states can occur during the runtime
of the project.

Select memory management in the "OP Properties" dialog box.

You have opened the "OP Properties" dialog box, "Memory Monitoring" tab, by touching the

"OpP" 6@ icon.

Displary ] Device Mernory Monitaring l 4
Maximum used memory: IS%W
Current used memary: ltl%J

OXC,

[ ] Shut devar HMT Rurtimne iF mernory is running low.:

0] The maximum used memory since last power on of the HMI device and the current used
memory in percent.

® Check box for selecting memory management

Proceed as follows:
1. In order to start memory management, select the check box.
2. Confirm your entries.

The dialog closes.

Memory management is activated.
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6. 14 Activate memory management
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7.1 Overview

Operating the HMI device

The HMI device is operated in the system as follows:

® As mobile device, with a battery

® As stationary device, in the charging station

For transfer and testing purposes, you can operate the HMI device in an office environment
as follows:

® As mobile device, with a battery

® As stationary device, with a tabletop power supply unit

® As stationary device, in the charging station

Requirements for commissioning

You must take the following steps before commissioning a project on the HMI device:
1.

o g ko

Mobile Panel 277 IWLAN

Install and connect up charging station

Alternatively, connect the HMI device to the tabletop power supply unit.

. Charging the battery and inserting it in the HMI device

To charge the battery, you have the following possibilities:

— In the charging compartment of the charging station

— In the HMI device, in the charging station

— In the HMI device when connected to the tabletop power supply unit
Switch on the HMI device with the ON/OFF button

Commission and test WLAN

Define the settings for the transfer in the Control Panel

Transfer project to the HMI device

Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0
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7.2 Operating modes

Commissioning
After transferring the project to the HMI device you must take the following steps:
e Starting the project

® [f necessary: Testing zones

See also
Mounting the charging station (Page 50)
Inserting batteries for the first time (Page 70)

Programming the data channel (Page 141)

7.2 Operating modes

Operating modes
The HMI device may be in the following operating modes:
e Offline
® Online
® Transfer

"Offline mode" and "Online mode" can be set on both the configuring PC and the
HMI device. To set these modes on the HMI device, use a corresponding operating element
of the project.

Changing the operating mode

The configuration engineer must have configured an appropriate operating element to allow
a change of the operating mode on the HMI device during ongoing operation.

Please refer to your system documentation to check whether additional information on this
subject is available there.

"Offline" operating mode

In this mode, there is no communication between the HMI device and PLC. Although the
HMI device can be operated, it cannot exchange data with the PLC.

"Online" operating mode

In this mode, the HMI device and PLC communicate. You can operate the plant on the
HMI device according to your system configuration.
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"Transfer" mode

7.3 Using existing projects

In this mode, you can transfer a project from the configuring PC to the HMI device or backup
and restore HMI device data, for example.

The following options are available for setting "Transfer" mode on the HMI device:
® \When the HMI device starts up

Start "Transfer" mode manually in the HMI device Loader.
e During ongoing operation

Start the "Transfer" mode manually within the project using an operating element.
The HMI device toggles to "Transfer" mode when automatic mode is set and a transfer is
initiated on the configuring PC.

7.3 Using existing projects

Note

The Mobile Panel 277 IWLAN does not have an enabling button, stop button or emergency
stop button. You must modify existing control programs to take this into account.

You can reuse WinCC flexible projects for the following HMI devices:
e Mobile Panel 177 PN

® Mobile Panel 177 DP

® Mobile Panel 277

Carry out an HMI device switch in WinCC flexible.

You must adapt the following aspects of the WinCC flexible project:
o Communication via WLAN

® Zone recognition and point recognition

— If you have used point detection with box ID in an existing project, you have the
following option:

Instead of using the connection box, use a zone consisting of at least one transponder
and set the previous box ID as the ID in this zone.

— If you are using zone recognition, you will need one or more transponders for one
zone.

In WinCC flexible, you can parameterize zones in "Device settings".
You can use zones to configure an easy way of selecting a zone-specific screen.
In this case you may also need to modify the control program from previous devices.

Further information on the subject can be found in the WinCC flexible Online Help or in the
"WinCC flexible Migration™ manual.
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7.4 Data transmission options

7.4

Overview

7.5

7.5.1

Introduction

Data transmission options

The following table shows the options for data transfer between Mobile Panel 277 Wireless

and a configuring PC.

The Ethernet data channel is used for communication via WLAN and LAN (RJ45).

Type Data channel Mobile Panel 277 Wireless
Backup USB Yes
Ethernet Yes
Restoring USB Yes
Ethernet Yes
Updating the operating system USB Yes
Ethernet Yes
Updating the operating system with | USB No
reset to factory settings Ethernet via the RJ45 interface Yes
Transferring a project USB Yes
Ethernet Yes
Installing or removing an option USB Yes
Ethernet Yes
License key transferring or USB Yes
transferring back Ethernet Yes

Overview

Preparing and backing up a project

In order to operate the system with the HMI device, you must transfer the WinCC flexible

project to the HMI device.

Transferring the project to the HMI device

168

You can transfer a project to an HMI device as follows:

® Transfer from the configuring PC

® Restore from a PC using ProSave

In this case, an archived project is transferred from a PC to the HMI device.
WinCC flexible need not be installed on this PC.

Mobile Panel 277 IWLAN
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7.5 Preparing and backing up a project

Commissioning and recommissioning
® \When the HMI device is commissioned there is no project at first.
The HMI device is also in this state after the operating system has been updated.

e \When recommissioning, any project already on the HMI device is replaced.

See also
Operating modes ((Page 166)

7.5.2 Transfer

7.5.2.1 Overview

Transfer

At the end of the configuration phase, transfer the executable project from the configuring
PC to the HMI device.

You can start the "Transfer" mode manually or automatically on the HMI device.

Transferred data is written directly to the internal flash memory on the HMI device. For the
transfer, you use a data channel which you have to configure before starting a transfer.

Backtransfer

You have the option to transfer the compressed project file together with the runtime project
to the HMI device. If necessary, the compressed project file can be transferred back to the
configuring PC and edited.

The HMI device must be equipped with an external memory to which the compressed project
file can be saved.

NOTICE

No checking of the project files

WinCC flexible does not check whether the compressed project file stored on the
HMI device corresponds to the existing runtime project.

See also
Setting the delay time (Page 144)
Programming the data channel (Page 141)

Data transmission options|(Page 168)
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7.5 Preparing and backing up a project

7.5.2.2 Starting manual transfer

Introduction

Requirements

Procedure

Result

See also

170

You can manually switch the HMI device to "Transfer" mode as follows:

With a configured operating element during ongoing operation
In the Loader of the HMI device

The project "™*.hmi" that you want to transfer is open in WinCC flexible on the
configuring PC

The HMI device is connected to this configuring PC
The data channel is programmed on the HMI device

The HMI device is in "Transfer" mode

Proceed as follows:

1.

2L S o

On the configuring PC, select the "Transfer settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Select devices for transfer" dialog opens.

Select the HMI device in the left area of the dialog.

Select the type of connection between the HMI device and the configuring PC.
Set the connection parameters.

Set the transfer parameters in the right area of the dialog.

If you wish to transfer the compressed project file together with the executable project to
the HMI device:

Select the "Enable backtransfer" check box.
Start transfer in WinCC flexible with "Transfer".

The configuring PC checks the connection to the HMI device. The project is transferred to
the HMI device. If the connection is not available or is defective, an error message is
displayed on the configuring PC.

When the transfer is completed successfully, the project can be found on the HMI device.
The transferred project is then started automatically.

Programming the data channel (Page 141)

Data transmission options |(Page 168)

Operating modes |(Page 166)
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7.5 Preparing and backing up a project

7523 Starting automatic transfer

Introduction

Requirements

If automatic transfer is activated, the HMI device automatically changes into "Transfer" mode
during operations as soon as you start a transfer on the configuring PC connected.

Note

With automatic transfer, the HMI device only changes into "Transfer" mode when the project
is running on the HMI device.

Automatic transfer is particularly suited for the test phase of a new project since transfer is
completed without interfering with the HMI device.

NOTICE

Undesired system responses

If the automatic transfer has been activated on the HMI device and a transfer is initiated on
the configuring PC, the project currently running is automatically stopped. The HMI device
then automatically switches to "Transfer" mode. The transfer mode can trigger undesired

responses in the system.

After the commissioning phase, deactivate the automatic transfer so that the HMI device
cannot be inadvertently switched to transfer mode.

You can issue a password in the Control Panel to restrict access to the transfer settings
and thus avoid unauthorized modifications.

® The project "™*.hmi" that you want to transfer is open in WinCC flexible on the
configuring PC

® The HMI device is connected to this configuring PC
® The data channel is programmed on the HMI device
® The automatic transfer is activated in the data channel for the transfer

® The project is started on the HMI device

Mobile Panel 277 IWLAN
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7.5 Preparing and backing up a project

Procedure

Result

See also

Proceed as follows:

1.

On the configuring PC, select the "Transfer settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Select devices for transfer" dialog opens.

2. Select the HMI device in the left area of the dialog.

3. Select the type of connection between the HMI device and the configuring PC.

Set the connection parameters.

4. Set the transfer parameters in the right area of the dialog.

5. If you wish to transfer the compressed project file together with the executable project to

the HMI device:
Select the "Enable backtransfer" check box.
Start transfer in WinCC flexible with "Transfer".

The configuring PC checks the connection to the HMI device. The HMI device terminates
the current project. The HMI device then automatically switches to transfer mode. The
project is transferred to the HMI device. If the connection is not available or is defective,
an error message is displayed on the configuring PC.

When the transfer is completed successfully, the project can be found on the HMI device.

The transferred project is then started automatically.

Programming the data channel (Page 141)

Data transmission options (Page 168)

Operating modes (Page 166)

7524 Starting backtransfer

Requirements

172

No project is open on the configuring PC in WinCC flexible
The HMI device is connected to this configuring PC

The data channel is programmed on the HMI device

The HMI device is in "Transfer" mode

The memory card containing the compressed project file is inserted into the HMI device

Mobile Panel 277 IWLAN
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Procedure

7.5 Preparing and backing up a project

Proceed as follows:

1.

2B

Result

On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication settings" dialog box opens.

Select the type of HMI device.

Select the type of connection between the HMI device and the configuring PC.
Set the connection parameters.

Close the dialog with "OK".

Select the "Transfer" > "Backtransfer" command in the "Project”" menu.

The "Backtransfer" dialog opens.

Click "OK" to start the backtransfer process.

The configuring PC checks the connection to the HMI device. The compressed project file
is transferred back from the HMI device to the configuring PC. If the connection is not
available or is defective, an error message is displayed on the configuring PC.

After successful backtransfer, the project is opened on the configuring PC in WinCC flexible.

753 Testing a project

Introduction

There are two options to test a project:

Test the project on the configuring PC

You can test a project at a configuring PC, using a simulator. For detailed information,
refer to the "WinCC flexible" user manual and to the WinCC flexible Online Help.

Offline testing of the project on the HMI device

Offline testing means that communication between the HMI device and PLC is down
while the test is being carried out.

Online testing of the project on the HMI device

Online testing means that the HMI device and PLC communicate with each other during
testing.

Perform the tests, starting with the "Offline test", followed by the "Online test".

Note
You should always test the project on the HMI device on which the project will be used.

Mobile Panel 277 IWLAN
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7.5 Preparing and backing up a project

Check the following:

1. Check the correct layout of the screens
2. Check the screen navigation

3. Check the input objects

4. Enter the tag values

The test increases the certainty that the project will run error-free on the HMI device.

Requirements for offline testing
® The project has been transferred to the HMI device

o The HMI device is in "Offline" mode

Procedure

In "Offline" mode, you can test individual project functions on the HMI device without them
being affected by the PLC. PLC tags, therefore, are not updated.

Test the operating elements and visualization of the project as far as possible without
connecting to the PLC.

Requirements for online testing
® The project has been transferred to the HMI device

® The HMI device is in "Online" mode

Procedure
In "Online" mode, you can test individual project functions on the HMI device without them
being affected by the PLC. PLC tags are updated in this case.
You have the option to test all communication-dependent functions, for example alarms, etc.
Test the operating elements and views of the project.

See also

Operating modes|(Page 166)
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754

See also

7.5.5

7.551

7.5 Preparing and backing up a project

Testing zones

If zones are present in the system, you need to test whether the HMI device is
detecting them.

Note

The following requirements must be fulfilled in order to test zones:

e The project has been transferred to the HMI device and started

e The HMI device is in online mode

e The transponders have been fitted and the transponder IDs are set

If the operating elements "Zone label" and "Zone quality" are present in the project, you can
check the zones on the HMI device.

In particular, check the following cases:
® Are the zone limits operating as planned?

Are moving machine parts influencing the reception of the transponders? Check also the
extreme positions of moving machine parts.

® |s WLAN coverage ensured in all parts of the zone?

Displaying zone names (Page 211)
Displaying zone quality (Page 211)
Mounting the transponder (Page 54)

Backup and restore

Overview

Backup and restore

You can back up and restore the following data found in the internal flash memory of the
HMI device with a PC:

® Project and HMI device image

® Password list

® Recipe data

® License keys

Use one of the following tools for backup and restore:
e WinCC flexible

® ProSave

Note
Alternatively, use the Control Panel to back up to an external memory device.
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7.5 Preparing and backing up a project

General information

NOTICE

Resetting to factory defaults required

If a complete restore operation is interrupted due to power failure on the HMI device, the
operating system of the HMI device may be deleted! In this case, you have to reset the
HMI device to its factory settings.

Compatibility conflict

If a message is output on the HMI device warning of a compatibility conflict during the
restore operation, the operating system must be updated.

7.55.2 Backup and restore using WinCC flexible

Requirements
® No project is open on the configuring PC in WinCC flexible
® The HMI device is connected to this configuring PC

® The data channel is programmed on the HMI device

Procedure for backup
Proceed as follows:

1. On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication settings" dialog box opens.

Select the type of HMI device.

Select the type of connection between the HMI device and the configuring PC.
Set the connection parameters.

Close the dialog with "OK".

Select the "Backup" command in the menu "Project > Transfer" in WinCC flexible.

o g ks~ DN

The "Backup settings" dialog opens.

Select the data to be backed up.

Select a destination folder and a file name for the "*.psb" backup file.
Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the HMI device automatically
sets "Transfer" mode when a backup is initiated.

10. Start the backup operation in WinCC flexible with "OK" on the configuring PC.
11. Follow the instructions in WinCC flexible.

A status view opens to indicate the progress of the operation.
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Result

7.5 Preparing and backing up a project

The system outputs a message when the backup is completed.

The relevant data is now backed up on the configuring PC.

Procedure for restoring
Proceed as follows:

1.

o gk~ e DN

Result

On the configuring PC, select the "Communication settings" command in the
"Project > Transfer" menu in WinCC flexible.

The "Communication settings" dialog box opens.

Select the type of HMI device.

Select the type of connection between the HMI device and the configuring PC.
Set the connection parameters.

Close the dialog with "OK".

In WinCC flexible, select the "Restore” command in the menu "Project > Transfer".
The "Restore settings" dialog opens.

Select the "*.psb" backup file to be restored from the "Open" field.

You can see the HMI device for which the backup file was created and the type of backup
data the file contains.

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when a restore operation is initiated.

Start the restore operation in WinCC flexible with "OK" on the configuring PC.

If there are license keys both on the HMI device and in the backup, a dialog box will
appear. Use this dialog to establish whether you want to overwrite the license keys or
abort the restore process.

— If necessary, abort the restore and first back up the HMI device's license keys.
— Then restart the restore process.
Follow the instructions in WinCC flexible.

A status view opens to indicate the progress of the operation.

When the restore is successfully completed, the data backed up on the configuring PC is
now on the HMI device.

See also

Programming the data channel (Page 141)

Data transmission options (Page 168)

Operating modes (Page 166)
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7.5 Preparing and backing up a project

7.55.3 Backup and restore using ProSave

Requirements
® The HMI device is connected to a PC on which ProSave is installed

® The data channel is programmed on the HMI device

Procedure for backup
Proceed as follows:
From the Windows start menu, start ProSave on the PC.
Select the HMI device type in the "General" tab.
Select the type of connection between the HMI device and the PC.
Set the connection parameters.
Select the data to be backed up in the "Backup" tab.

"

Select a destination folder and a file name for the "*.psb" backup file.

N o g ks~ 0w b=

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the HMI device automatically
sets "Transfer" mode when a backup is initiated.

8. Start the backup operation in ProSave on the PC with "Start Backup".
Follow the instructions in ProSave.

A status view opens to indicate the progress of the operation.

Result
The system outputs a message when the backup is completed.

The relevant data is now backed up on the PC.
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7.5 Preparing and backing up a project

Procedure for restoring
Proceed as follows:

1.

o~ e

Result

From the Windows start menu, start ProSave on the PC.

Select the HMI device type in the "General" tab.

Select the type of connection between the HMI device and the PC.
Set the connection parameters.

Select the "*.psb" backup file to be restored from the "Restore" tab.

You can see the HMI device for which the backup file was created and the type of backup
data the file contains.

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when a restore operation is initiated.

. Start the restore operation in ProSave on the PC with "Start Restore".

If there are license keys both on the HMI device and in the backup, a dialog box will
appear. Use this dialog to establish whether you want to overwrite the license keys or
abort the restore process.

— If necessary, abort the restore and first back up the HMI device's license keys.
— Then restart the restore process.
Follow the instructions in ProSave.

A status view opens to indicate the progress of the operation.

When the restore is successfully completed, the data backed up on the PC is now on the
HMI device.

See also

Programming the data channel (Page 141)

Data transmission options (Page 168)

Operating modes (Page 166)
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7.5 Preparing and backing up a project

7.5.6

7.5.6.1

Updating the operating system

Overview

Updating the operating system

A compatibility conflict may occur when transferring a project to the HMI device. This is
caused by different versions of the configuration software used and the HMI device image
available on the HMI device. If there are different versions, the transfer is aborted. A
message indicating a compatibility conflict is displayed on the configuring PC.

There are two ways to match the versions:

e Update the HMI device image if the project was created with the most recent version of
the configuration software

® Transfer a matching version of the HMI device image if you do not want to adapt the
project for the HMI device to the most recent version of the configuration software for the
project

General information

180

NOTICE
Resetting to factory defaults required

If the update of the HMI device image is interrupted due to a power failure on the
HMI device, the operating system of the HMI device may be deleted. In this case,
you have to reset the HMI device to its factory settings.

NOTICE

Data loss

All data on the HMI device, such as the project and passwords, will be deleted when you
update the operating system.

Note
Calibrating the touch screen
After updating the operating system, you may have to recalibrate the touch screen.
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Resetting to factory settings

In ProSave or WinCC flexible, you can update the operating system with or without resetting
to factory settings.

CAUTION
IP65 degree of protection not fulfilled

To update the operating system and reset to factory settings, you need an Ethernet
connection over the RJ45 interface.

If you connect the configuring PC directly to the HMI device through the RJ45 interface, you
must open the connection compartment. If the connection bay is open, degree of protection
IP65 is not fulfilled.

e Updating the operating system without resetting to factory settings

First, switch into "Transfer" mode on the HMI device or use the automatic transfer
function if the project is active. Then start the operating system update in ProSave or
WinCC flexible.

e Updating the operating system with reset to factory setting

NOTICE

Loss of license keys

The license keys on the HMI device will be deleted when resetting to factory settings.
The license keys on the HMI device will be retained when updating the operating system
without resetting to factory settings.

NOTICE

Data channels

When resetting to factory settings, all data channel parameters are reset. The transfer
can only be started following reconfiguration of the data channels.

Note

You have to perform an operating system update with reset to factory settings if the
HMI device does not yet have an operating system or if the operating system of the
HMI device is corrupt.

First, start the operating system update in ProSave or WinCC flexible and switch the
power on the HMI device off and on again when prompted.

7.5.6.2 Updating the operating system using WinCC flexible

Requirements
® No project is open on the configuring PC in WinCC flexible
® The HMI device is connected to this configuring PC

® The data channel is programmed on the HMI device
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Procedure

Result

See also
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Proceed as follows:

1.

S L

10.

On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication settings" dialog box opens.

Select the type of HMI device.

Select the type of connection between the HMI device and the configuring PC.

Set the connection parameters.

Close the dialog with "OK".

In WinCC flexible, select the command "Update OS" in the "Project > Transfer" menu.

mg".
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R

In "Image path”, select the HMI device image file

The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation CD.

In the output area, you are provided information on the version of the HMI device image
file after it is opened.

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when an update is initiated.

In WIinCC flexible, select "Update OS" on the configuring PC to run the operating system
update.

Follow the instructions in WinCC flexible.

During the operating system update a status view opens to indicate progress.

A message is displayed when the operating system update is successfully completed.

This operation has deleted the project data from the HMI device.

Programming the data channel (Page 141)

Data transmission options (Page 168)

Operating modes|(Page 166)
Enabling PROFINET IO |[(Page 145)
Overview (Page 180)
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7.5.6.3 Updating the operating system using ProSave

Requirements
® The HMI device is connected to a PC on which ProSave is installed

® The data channel is programmed on the HMI device

Procedure
Proceed as follows:
From the Windows Start menu, start ProSave on the PC.
Select the HMI device type in the "General" tab.
Select the type of connection between the HMI device and the PC.
Set the connection parameters.
Select the "OS Update" tab.

In "Image path", select the HMI device image file "*.img".

2B S o e

The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation CD.

In the output area, you are provided information on the version of the HMI device image
file after it is opened.

7. Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when an update is initiated.

8. Select "Update OS" on the PC to run the operating system update.
9. Follow the instructions in ProSave.

During the operating system update a status view opens to indicate progress.

Result
A message is displayed when the operating system update is successfully completed.

This operation has deleted the project data from the HMI device.

See also
Programming the data channel (Page 141)
Data transmission options (Page 168)
Operating modes ((Page 166)
Enabling PROFINET IO (Page 145)
Overview (Page 180)
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7564 Resetting to factory settings with WinCC flexible

Requirements

No project is open on the configuring PC in WinCC flexible

The HMI device is connected to this configuring PC over the Ethernet

Have the MAC address of your HMI device's Ethernet interface to hand.

— The MAC address is displayed briefly when the HMI device is turned on.

— The MAC address is displayed in the "PROFINET" dialog in the Control Panel.

Procedure for setting the PC interface

1.
2.
3.

Select "Start > Control Panel > Set PG/PC interface".
Select "S7TONLINE (STEP7) -> TCP/IP" from the "Application access point" area.

Select the interface which is connected to the HMI device from the
"Interface parameterization used" area.

Confirm your entries.

Procedure for resetting to factory settings

Proceed as follows:

1.
2.

184

Turn off the power supply to the HMI device.

On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication settings" dialog box opens.

Select the HMI device type from the "General" tab, and select "Ethernet" from the
"Connection" area.

Enter an IP address.

Note
Possible address conflicts with incorrect IP address
Do not use a dynamic IP configuration for "Reset factory settings".

Define an IP address which the HMI device is going to receive from the configuration
station during the update process.

If the HMI device has already been used with WinCC flexible or ProSave you can use the
existing IP address for "Reset factory settings".

Mobile Panel 277 IWLAN
Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0



Commissioning the HM/I device

7.5 Preparing and backing up a project

Confirm your entries.
In WinCC flexible, select the command "Update OS" in the "Project > Transfer" menu.
Select the "Reset factory settings" check box.

A text box opens where you can enter the MAC address.

Enter the HMI device's MAC address in the text box.

In "Image path", select the HMI device image file ".img".

The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation CD.

In the output area, you are provided information on the version of the HMI device image
file after it is opened.

10. In WIinCC flexible, select "Update OS" on the configuring PC to run the operating system
update.

11. Follow the instructions in WinCC flexible.

During the operating system update a status view opens to indicate progress.

Result
A message is displayed when the operating system update is successfully completed.

This operation has deleted the project data from the HMI device. The factory settings
are reset.

Note
Calibrating the touch screen

After the restore, you may have to re-calibrate the touch screen.
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7.5.6.5 Resetting to factory settings with ProSave

Requirements

The HMI device is connected over the Ethernet to a PC on which ProSave is installed
When updating the operating system with reset to factory setting only:

Have the MAC address of your HMI device's Ethernet interface to hand.

— The MAC address is displayed briefly when the HMI device is turned on.

— The MAC address is displayed in the "PROFINET" dialog in the Control Panel.

Procedure for setting the PC interface

1.
2.
3.

Select "Start > Control Panel > Set PG/PC interface".
Select "S7TONLINE (STEP7) -> TCP/IP" from the "Application access point" area.

Select the interface which is connected to the HMI device from the "Interface
parameterization used" area.

Confirm your entries.

Procedure for resetting factory settings

Proceed as follows:

1.
2.
3.

4.
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Turn off the power supply to the HMI device.
From the Windows Start menu, start ProSave on the PC.

Select the HMI device type from the "General" tab, and select "Ethernet" from the
"Connection" area.

Enter an IP address.

Note
Possible address conflicts with incorrect IP address

Do not use a dynamic IP configuration for "Reset factory settings".

Define an IP address which the HMI device is going to receive from the configuration
station during the update process.

If the HMI device has already been used with WinCC flexible or ProSave you can use the
existing IP address for "Reset factory settings".
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Change to the "OS Update" tab.

Select the "Reset factory settings" check box.

A text box opens where you can enter the MAC address.
Enter the MAC address of the HMI device

In "Image path”, select the HMI device image file

LLE
A

mg".

The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation CD.

In the output area, you are provided information on the version of the HMI device image
file after it is opened.

9. Select "Update OS" on the PC to run the operating system update.
10. Follow the instructions in ProSave.

During the operating system update a status view opens to indicate progress.

Result
A message is displayed when the operating system update is successfully completed.

This operation has deleted the project data from the HMI device. The factory settings
are reset.

Note
Calibrating the touch screen

After the restore, you may have to re-calibrate the touch screen.
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7.5.7

7.5.7.1

Installing and removing options

Overview

Installing and removing options

7.5.7.2

You can install options on the HMI device, for example, additional programs developed
especially for the HMI device.

You can also remove the option from the HMI device again.

Note
License key

A license key may be needed to run an option. The license key unlocks the option for use.

Installing and removing options using WinCC flexible

Requirements

® No project is open on the configuring PC in WinCC flexible

® The HMI device is connected to this configuring PC

® The data channel is programmed on the HMI device

Procedure for installing an option

188

Proceed as follows:

1.

© N o o~ Db

On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication settings" dialog box opens.

Select the type of HMI device.

Select the type of connection between the HMI device and the configuring PC.
Set the connection parameters.

Close the dialog with "OK".

Select the "Options" command in the menu "Project > Transfer" in WinCC flexible.
Select the desired option under "Available options".

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the installation of an option is initiated.

Start the installation of the option in WinCC flexible on the configuring PC with the
">>" putton.

10. Follow the instructions in WinCC flexible.

A status display appears indicating the progress of the installation.
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The option has now been installed on the HMI device.

Procedure for removing an option

Proceed as follows:

1.

© ® N o gk w0 D

10.

11.

Result

On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication settings" dialog box opens.

Select the type of HMI device.

Select the type of connection between the HMI device and the configuring PC.
Set the connection parameters.

Close the dialog with "OK".

Select the "Options" command in the menu "Project > Transfer" in WinCC flexible.
Press the "Device status" button to update the display.

Select the desired option under "Installed options".

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the removal of an option is initiated.

Start the removal of the option in WinCC flexible on the configuring PC with the
"<<" button.

Follow the instructions in WinCC flexible.

A status display appears indicating the progress of the removal.

The option has now been removed on the HMI device.

See also

Programming the data channel (Page 141)

Data transmission options| (Page 168)

Operating modes ((Page 166)

Overview (Page 188)
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7.5.7.3

Requirements

Installing and removing options using ProSave

The HMI device is connected to a PC on which ProSave is installed

The data channel is configured on the HMI device

Procedure for installing an option
Proceed as follows:

Result

N o g ks~ owbdb =

From the Windows Start menu, start ProSave on the PC.

Select the HMI device type in the "General" tab.

Select the type of connection between the HMI device and the PC.
Set the connection parameters.

Select the "Options" tab.

Select the desired option under "Available options".

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the installation of an option is initiated.

8. Start the installation of the option in ProSave with the ">>" button.

9. Follow the instructions in ProSave.

A status display appears indicating the progress of the installation.

The option has now been installed on the HMI device.

Procedure for removing an option

190

Proceed as follows:
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From the Windows Start menu, start ProSave on the PC.

Select the HMI device type in the "General" tab.

Select the type of connection between the HMI device and the PC.
Set the connection parameters.

Select the "Options" tab.

Press the "Device status" button to update the display.

Select the desired option under "Installed options".

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the removal of an option is initiated.

Start the removal of the option in ProSave with the "<<" button.
Follow the instructions in ProSave.

A status display appears indicating the progress of the removal.
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Result

The option has now been removed on the HMI device.
See also

Programming the data channel (Page 141)

Data transmission options (Page 168)

Operating modes (Page 166)

Overview (Page 188)
7.5.8 Transferring and transferring back license keys

7.5.8.1 Overview

Transferring and transferring back license keys

With the purchase of an optional package, you obtain a specific user license with an
associated license key. Once you have installed an option, transfer a license key to the
HMI device. The license key unlocks an option for use.

You can also transfer back the license key from the HMI device to the storage location.

Note

You only transfer license keys with the Automation License Manager or WinCC flexible.
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7.5.8.2 Transferring and transferring back license keys

Requirements
e \When transferring or transferring back using WinCC flexible:
No project is open on the configuring PC in WinCC flexible
® The HMI device is connected to this configuring PC
® The data channel is programmed on the HMI device

® The storage location and the license key awaiting transfer are ready

Procedure for transferring a license key
Proceed as follows:
1. Switch to "Transfer" mode on the HMI device.
2. When transferring using WinCC flexible:

Select the "License Keys" command in the menu "Project > Transfer".
The Automation License Manager opens.

When transferring using the Automation License Manager:
Start the Automation License Manager via the Windows Start menu.

3. In the Automation License Manager, select the command "Connect HMI device" in the
menu "Edit > Connect target system".

The "Connect target system" dialog opens.

Under "Device type", select the appropriate HMI device type.
Select the type of connection from the "Connection" box.
Set the connection parameters.

Select "OK".

The connection to the HMI device is established. The connected HMI device is displayed
in the left window of the Automation License Manager.

N o a &

8. In the left window, select the source drive.
The right window displays the available license keys.

9. Drag one or more license keys from the right window and drop them on the HMI device in
the left window.

The license keys are then transferred to the HMI device.

Result

The license key is transferred from the storage location to the HMI device.
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Procedure for transferring back a license key

Proceed as follows:

1.
2.

N o o &

Result

Switch to "Transfer" mode on the HMI device.
When transferring back using WinCC flexible:

Select the "License Keys" command in the menu "Project > Transfer".
The Automation License Manager opens.

When transferring back using the Automation License Manager:
Start the Automation License Manager via the Windows Start menu.

In the Automation License Manager, select the command "Connect HMI device" in the
menu "Edit > Connect target system".

The "Connect target system” dialog opens.

Under "Device type", select the appropriate HMI device type.
Select the type of connection from the "Connection" box.
Set the connection parameters.

Select "OK".

The connection to the HMI device is established. The connected HMI device is displayed
in the left window of the Automation License Manager.

In the left window, select the HMI device.
The right window displays the available license keys.

Drag one or more license keys from the right-hand window and drop them on the target
drive in the left-hand window.

The license keys are transferred back to the storage location.

The license key is transferred back from the HMI device to the storage location.

See also

Overview (Page 191)

Operating modes (Page 166)

Programming the data channel (Page 141)

Data transmission options (Page 168)
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Operating a project 8

8.1 Handling the HMI device during operation

The following must be noted when working with the Mobile Panel 277 IWLAN:
e Pay attention to the "BAT" LED.
— Recharge the HMI device in good time.

To charge the batteries, the ambient temperature/battery temperature must not
exceed 40 °C The higher the temperature, the longer it will take for the battery to
charge. Find a place with a cool ambient temperature for the charging station.

If necessary, allow the battery to cool first.

You can check the battery temperature in the "OP" dialog box, "Battery" tab in the
Control Panel.

— Alternatively, change the main battery.
® Pay attention to the "COM" LED.

If you leave the area with sufficient WLAN coverage, the "COM" LED will flash.
The HMI device is in "Offline" mode. You can no longer operate the system with the
HMI device.

See also
Displaying WLAN quality (Page 210)

8.2 Starting the project

Requirements

In order to switch on the Mobile Panel 277 IWLAN and start the project, the following
requirements must be met:

® The batteries have been charged and inserted in the HMI device
If the batteries are not available, place the HMI device in the charging station
® The project is loaded on the HMI device
® The WLAN quality is sufficient
® Transponders, if zones are configured:

— The transponders are installed
— The batteries are fitted in the transponders

— Aunique ID has been set in the transponders that matches the project
parameterization
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8.2 Starting the project

Switching on the HMI device
Press the ON/OFF button.

The HMI device performs the following steps:

1

2
3
4

The HMI device starts.
The "PWR" LED lights up.
The "BAT" LED shows the charging status of the inserted main battery.

The HMI device either starts the project immediately or after a configured delay time.

Establishing the WLAN connection
SSIDs for up to 3 WLAN networks can be stored in the project.

The WLAN networks stored in the project must be parameterized on the HMI device and
must be included in the list of preferred networks on the HMI device.

The WLAN connection is established as follows:

1.

If one of the 3 WLAN networks is available when the HMI device is started, the
HMI device connects automatically.

The configured sequence of SSIDs determines the order in which the HMI device will
attempt to connect to the WLAN networks.

If the HMI device cannot establish a connection with any of the 3 configured
WLAN networks, the HMI device will attempt to connect to other WLAN networks.

For this to happen, connection to other WLAN networks must be authorized in the project.

3. Once the HMI device has established the WLAN connection, the "COM" LED lights up.

4. If the HMI device was unable to establish a connection with any of the WLAN networks,

Result

"Not Connected" is displayed in the status line of the dialog box.

The HMI device will show the project start screen or the zone-specific screen.

The project is started.

If the HMI device was unable to establish a WLAN connection, it will continue to attempt to
establish the connection.
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8.3 Direct keys

Introduction
Direct keys on the HMI device are used to set bits in the 1/0 area of a SIMATIC S7.
Direct keys enable operations with short reaction times, that are, for example, a jog mode
requirement.
NOTICE
PLC stop
Please note that leaving the WLAN area will cause the PROFINET IO device to fail and will
therefore result in a PLC stop.
Determine suitable programming measures in the PLC, in order to prevent a PLC stop.
Please refer to your system documentation to check whether additional information on this
subject is available there.
NOTICE
Effectiveness of direct keys in offline mode
Direct keys are active when both of the following conditions are satisfied:
e The HMI device is in an area with sufficient WLAN coverage.
e The HMI device is in "Offline" mode.
NOTICE
If you operate a function key with direct key functionality in a running project, the direct key
function is always executed, independent of the current screen contents.
Direct keys
The following objects can be configured as a direct key:
e Buttons
® Function keys
® Screen numbers
¢ Handwheel
® |lluminated pushbutton
e Key-operated switch
Note
Direct keys result in additional basic load on the HMI device.
Additional information about direct keys is available in the system manual
"WinCC flexible communication".
See also

Enabling PROFINET IO (Page 145)

Evaluating operator controls as direct keys (Page 87)
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8.4 Operator input options
Once the project is transferred to the HMI device, current processes can be operated and

monitored in the process control phase. You have the following options for operating the
HMI device:

® Touch screen

The HMI device is operated by means of the touch screen. The operating elements
shown in the dialogs are touch-sensitive. Touch objects are basically operated in the
same way as mechanical keys. You activate operating elements by touching them with
your finger. To double-click them, touch an operating element twice in succession.

A\ caution

Do not use any pointed or sharp objects when operating the touch screen. Otherwise
this may damage the plastic membrane of the touch screen.

e External input devices
The following operator controls can be connected externally:
— Keyboard, connected via USB
— Mouse, connected via USB
The use of external input devices is recommended for commissioning.

Operating a project with an external keyboard

An external keyboard can be used to operate a project in exactly the same way as with the
HMI keyboard or screen keyboard.

Note
The function keys of the external keyboard are disabled.

Use other keys on the external keyboard, which correspond to the HMI device keys.

Operating a project with an external mouse

An external mouse can be used to operate a project in exactly the same way as with the
HMI touch screen. Click the described operating elements with the mouse.

Unintentional actions

A\caution

Do not carry out several operations simultaneously. You may otherwise trigger
unintentional actions.

e With touch control:

Always touch only one operating element on the screen
e With key operation via an external keyboard:

Do not press more than two keys simultaneously
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Observing the plant documentation

Some operations with the project may require in-depth knowledge about the specific plant on
the part of the operator. Proceed with caution, for example, when you use jog mode. Please
refer to your system documentation to check whether additional information on this subject is
available there.

Operation feedback from operating elements

The HMI device provides optical feedback as soon as it detects that an operating elements
has been selected. The operating element receives the focus and is selected. This selection
is independent of any communication with the PLC. Therefore this selection does not
indicate whether the relevant action is actually executed or not.

The configuration engineer can also configure the selection of an operating element so that it
deviates from the standard. Please refer to your system documentation to check whether
additional information on this subject is available there.

Optical feedback from operating elements
The type of optical feedback depends on the operating element:
e Buttons

The HMI device outputs different views of the "Pressed" and "Unpressed" states,
provided the configuration engineer has configured a 3D effect:

"Pressed" state:

"Unpressed" state:

The configuration engineer determines the appearance of a marked field, for example,
line width and color for the focus.

® |nvisible buttons

By default, invisible buttons are not displayed as pressed when they are touched.
No optical operation feedback is provided in this case.

The configuration engineer may, however, configure invisible buttons so that their outline
appears as lines when touched. This outline remains visible until you select another
operating element.

e |/O fields

When you select an 1/O field, the content of the 1/O field is displayed against a colored
background. With touch operation, a screen keyboard is displayed for the entering of
values.
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8.5 Function keys

Function keys

Function key assignment is defined during configuration. The configuration engineer can
assign function keys globally and locally.

Function keys with global function assignment

A globally assigned function key always triggers the same action on the HMI device or in the
PLC irrespective of the screen displayed. Such an action could be, for example, the
activation of a screen or the closure of an alarm window.

Function keys with local function assignment

A function key with local function assignment is screen-specific and is therefore only
effective within the active screen.

The function assigned locally to a function key can vary from screen to screen.

The function key of a screen can be assigned one function only, either a global or local one.
The local assignment function takes priority over the global setting.

The configuration engineer can assign function keys in such a way that you can operate
operating elements with function keys, for example, the alarm view, trend view, recipe view
or status/PLC.

Multi-key operation

Unwanted actions may be triggered, if the operator unintentionally actuates a key
combination.

A\cauTion

Unintentional actions

In "Online" mode, simultaneous operation of more than two keys may cause unintentional
actions in the plant.

Do not press more than two keys simultaneously.
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8.6 Setting the project language

Introduction

The HMI device supports multilingual projects. You must have configured a corresponding
operating element which lets you change the language setting on the HMI device during
runtime.

The project always starts with the language set in the previous session.

Requirements
® The required language for the project must be available on the HMI device

® The language switching function must be logically linked to a configured operating
element such as a button

Selecting a language

You can change project languages at any time. Language-specific objects are immediately
output to the screen in the new language when you switch languages.

The following options are available for switching the language:
® A configured operating element switches from one language to the next in a list
® A configured operating element directly sets the desired language

Please refer to your system documentation to check whether additional information on this
subject is available there.

8.7 Input

8.7.1 Overview

Screen keyboard

When you touch an operating element requiring entry on the HMI device touch screen,
a screen keyboard appears. The screen keyboard is displayed in the following cases:

® An |/O field is selected for input
® A password must be entered for accessing a password-protected function
The screen keyboard is automatically hidden again when input is complete.

Based on the configuration of the operating element, the system displays different screen
keyboards for entering numerical or alphanumerical values.

Note

The screen keyboard display is independent of the configured project language.
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8.7 Input

General procedure
The operating elements of a screen are operated by touching the touch screen.
Proceed as follows:
1. Touch the desired operating element within the screen.

2. Depending on the operating element, perform further actions. Detailed descriptions can
be found under the respective operating element.

Examples:
— /O field: Enter numerical, alphanumerical or symbolic values in the 1/O field
— Symbolic I/O field: Select an entry from the drop down list box

— Slider control: Move the slider control

Procedure for text boxes

Values are entered in the project text boxes. Based on your configuration, the values are
saved to tags and transferred, for example, to the PLC.

Proceed as follows:
1. Touch the desired text box within the screen.
The screen keyboard opens.

Depending on your configuration, you can enter values in the text box in the following
manner:

— Numerical values, for example decimal numbers, hexadecimal numbers, binary values
— Alphanumerical values, for example digits and letters
— Date/time

2. Enter the value.

3. Confirm your entry with ﬁl or discard your entry with the button ﬂl
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8.7 Input
8.7.2 Entering and editing numerical values

Numerical screen keyboard

When you touch an operating element for numerical input on the HMI-device touch screen,
the numerical screen keyboard appears. This is the case, for example, for a text box.
The screen keyboard is automatically hidden again when input is complete.

7| 8| 9|« [FE=Ix]

456 Del | Ins
123‘J

U- . |Esc| |

|Num Help

Figure 8-1 Numerical screen keyboard

Note
Opened screen keyboard
When the screen keyboard is open, PLC job 51, "Select screen" has no function.

Formats for numerical values
You can enter values in numerical text boxes based on the following formats:
® Decimal
® Binary

® Hexadecimal

Note
Entry of hexadecimal values

When you enter values in hexadecimal format, the alphanumerical screen keyboard
opens.

Limit value test of numerical values

Tags can be assigned limit values. If you enter a value that lies outside of this limit, it will not
be accepted, for example, 80 with a limit value of 78. In this case the HMI device will deliver
a system alarm, if an alarm window is configured. The original value is displayed again.

Decimal places for numerical values

The configuration engineer can define the number of decimal places for a numerical text box.
The number of decimal places is checked when you enter a value in this type of I/O field.

® Decimal places in excess of the limit are ignored

o Empty decimal places are filled with "0"
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Procedure

Numerical values can be entered character-by-character via the buttons on the numerical
screen keyboard.

Proceed as follows:
1. Touch the desired operating element within the screen.

The numerical screen keyboard opens. The existing value is displayed in the screen
keyboard and is selected.

2. Enter the value.

When entering hexadecimal values, the keys with letters "G" to "Z" are operable, but the
characters will not be entered.

You have the following options to enter a value:

— The selected value is deleted when you enter the first character. Completely reenter

the value.

- Usethe €— | and — | keys to move the cursor within the current value. You can

now edit the characters of the current value or add characters.

Use the = | key to delete the character to the left of the cursor. If the value is

selected, use this key to delete the selected part of the value.

The Del | key deletes the character positioned to the right of the cursor. If the value is

selected, use this key to delete the selected part of the value.
- Use the HE'Plkey to display the infotext of the 1/O field.

This key is only enabled if infotext has been configured for the input object or the

current screen.

3. Use the = | key to confirm your entry or cancel it with |[ESC | Either action closes the

screen keyboard.

Result
You have changed the numerical value or entered a new one.
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8.7 Input

8.7.3 Entering and editing alphanumerical values

Alphanumerical screen keyboard

When you touch an operating element for alphanumerical input on the HMI-device touch
screen, the alphanumerical screen keyboard appears. This is the case, for example, for a
text box. The screen keyboard is automatically hidden again when input is complete.

“T1lz2[3]als]e[7]elo]o]-[=]«— & _Ix]

—H (g (w|e|[r|t|y|lu|li|lo|p|[]| ] J Ins |Home| G
¢ |a|s|d|f|lg|h|ji|k|I|:]" |\ pel | End |
tl\|z|x|c|v|b|ln|m|, |[.|f]| © |&c/| mm|$|Hebp
cel | R Ak acer | B ow | ¥ |

Figure 8-2  Alphanumerical screen keyboard, normal level

Note

Opened screen keyboard

When the screen keyboard is open, PLC job 51, "Select screen" has no function.
Language change

Language change in the project has no influence on the alphanumerical screen keyboard.
The entry of Cyrillic or Asian chracters is therefore not possible.

Keyboard levels
The alphanumerical screen keyboard has various levels.
o Normal level
e Shift level
If you change the levels with key il the key assignments change.
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8.7 Input

Procedure

Alphanumerical values can be entered character-by-character via the buttons on the
alphanumerical screen keyboard.

Proceed as follows:
1. Touch the desired operating element within the screen.

The alphanumerical screen keyboard opens. The existing value is displayed in the screen
keyboard and is selected.

2. Enter the value.

You have the following options to enter a value:

— The selected value is deleted when you enter the first character. Completely reenter

the value.

- Usethe €— | and — | keys to move the cursor within the current value. You can
now edit the characters of the current value or add characters.

Use the == | key to delete the character to the left of the cursor. If the value is
selected, use this key to delete the selected part of the value.

The el | key deletes the character positioned to the right of the cursor. If the value is

selected, use this key to delete the selected part of the value.

- Usingkey T | it is possible to switch between the keyboard levels of the screen

keyboard. On switchover, the key assignments of the screen keyboard change.
- Use the HE'Plkey to display the infotext of the 1/O field.

This key is only enabled if infotext has been configured for the input object or the

current screen.

3. Use the = | key to confirm your entry or cancel it with |[ESC | Either action closes the

screen keyboard.

Result

You have changed the alphanumeric value or entered a new one.
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8.7.4

8.7 Input

Entering the date and time

Entering the date and time

See also

8.7.5

Enter the date and time in the same way you enter alphanumerical values.

Note

When entering the date and time, please note that the format is determined by the
configured project language.

Entering and editing alphanumerical values/(Page 205)

Setting the project language [(Page 201)

Entering symbolic values

Drop down list box

Procedure

Result

Operating elements for entering symbolic values offer you a list from which you can select
the input values. When you touch a symbolic I/O field on the HMI device touch screen, the
following drop down list box opens.

Figure 8-3  Symbolic I/O field after touch, example

Proceed as follows:
1. Touch the required operating element.

The drop down list box of the operating element opens. Select ~| and «|to scroll in the
drop down list box.

2. Touch the required entry in the drop down list box.

The selected entry is accepted as an entry.

You have changed the symbolic value or entered a new one.
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8.8 Displaying infofext

8.8 Displaying infotext

Purpose

The configuration engineer uses infotext to provide additional information and operating
instructions. The configuration engineer can configure infotext on screens and operating
elements.

The infotext of an I/O field may contain, for example, information on the value to be entered.

Enter ternperature setpoint for Tank_1
{Range 40...80 °C)

Figure 8-4  Infotext for an I/O field, example

Opening infotext for operating elements
1. Touch the required operating element.

The screen keyboard opens. You can see from the appearance of the Hﬂ'Pl key whether
infotext has been configured for the operating element or the current screen.
2. Touch the HE'Pl key on the screen keyboard.

The infotext for the operating element is displayed. If there is no infotext for the selected
screen object, the infotext for the current screen is displayed, if it has been configured.

You can scroll through the contents of long infotext with ~|and «|.

Note
Switching between displayed infotext

The configuration engineer can configure infotext for an 1/O field and the associated
screen. You can switch between two infotexts by touching the infotext window.

3. Close the displayed infotext by pressing .

Alternative procedure

Depending on your configuration, infotext can also be called via a configured operating
element.

Please refer to your system documentation to check whether additional information on this
subject is available there.
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8.9 Device-specific displays

8.9.1 Displaying battery status

Application
The "Battery" object indicates the charging status of the main battery. Charge the battery in
good time. Alternatively, change the main battery.
Layout
Symbol Color Meaning Charging status
D _ Green The battery is sufficiently charged. |>20 %
Yellow The battery is weak. The battery 10 % to 20 %
D l:. must be charged. Alternatively,
insert a charged spare battery.
Red Battery is very weak. The battery <10 %
must be charged. Alternatively,
insert a charged spare battery.
Operation
The object is for display only and cannot be operated.
See also

Inserting, charging and changing the battery (Page 68)
Charging batteries in the charging compartment (Page 100)
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8.9 Device-specific displays

8.9.2 Displaying WLAN quality

Application
The "WLAN quality" object displays the signal strength of the WLAN wireless connection.
The HMI device measures the signal strength and indicates the quality using 5 bars.
Layout
Symbol Meaning Signal strength
rr[—_ No wireless connection No signal
l_‘—l:_ Very poor wireless connection <20 %
1 Poor wireless connection <40 %
l_‘-[ >20 %
1 Wireless connection OK <60 %
d—[ >40 %
o | Good wireless connection <80 %
l_‘—[ >60 %
r‘_[—_ Very good wireless connection >80 %
Operation
The "WLAN quality" object is purely for display purposes. You cannot operate the
"WLAN quality" object.
See also

Handling the HMI device during operation|(Page 195)
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8.9 Device-specific displays

8.9.3 Displaying zone names
Application
The "Zone name" object shows the names of the zone in which the HMI device is currently
located.
Layout
Symbol Meaning
The HMI device is within the indicated zone.
Zonename
The HMI device is not inside any zone.
Operation
The "Zone name" object is purely for display purposes. You cannot operate the
"Zone name" object.
See also

Division of the system into zones (Page 45)

8.94 Displaying zone quality

Application
The "Zone quality" object shows how close the HMI device is to the limits of a zone. Unlike
with "WLAN quality", the HMI device does not measure signal strength. The HMI device
calculates the zone quality from the distance between it and the assigned transponders.
Layout
Symbol Meaning Quality
I:‘:l:l The HMI device is within a zone. >15 %
|:[‘] The HMI device is at the limits of a zone. 1%t015 %
I:l:‘ The HMI device is not within any zone. 0%

The "Zone quality" object indicates which zone this concerns.
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8.10 Bar and gauge

Calculating the quality
The quality within a zone depends on the measured distance to the transponder:
e |n the center of the zone the quality is 100 %
® The quality decreases as you approach the limits of the zone

® On the transponder and on the border of the zone, the quality is 0 %

Operation

The "Zone quality" object is purely for display purposes. You cannot operate the
"Zone quality" object.

8.10 Bar and gauge

Bar
The bar is a dynamic display object. The bar displays a value from the PLC as a rectangular
area. The bar allows you to recognize the following at a glance:
® The distance of the current value from the configured limit values
® \Whether a set point value has been reached
The bar can display values such as fill levels or batch counts.
100
&0
30
o
Layout

The layout of the bar depends on the configuration:
® The bar may feature a scale of values
® The configured limit values can be indicated by lines

® (Color changes can signal when a limit value has been exceeded or has not been reached
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8.10 Bar and gauge

Gauge

The gauge is a dynamic display object. The gauge displays numerical values in analog form
by means of a pointer. This enables an operator at the HMI device to see at a glance if the
boiler pressure is in the normal range, for example.

Layout
The layout of the gauge depends on the configuration:

® A trailing pointer can display the maximum value reached so far on the scale. The trailing
pointer is reset when the screen is reloaded

® The label on the scale can show the measured variable, for example boiler pressure and
the physical unit, for example bar

Operation

The bar and the gauge are for display only. Both objects cannot be controlled by the
operator.
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8.11 Operating the slider control

8.11 Operating the slider control

Introduction

The slider control can be used to monitor and change process values within a defined range.

The slider control can also be configured without a slider. In this case, you cannot enter a

value. The slider control is then only used for displaying values.

SIMATIC
100 =
0
D—1—Q@

Figure 8-5  Slider control — example

0] Slider control for entering values

® Value display with current value
Layout

The layout of the slider control depends on the configuration:

® The slider control can contain a label and a setting range

® The current value can be displayed below the area of the slider control
Procedure

Proceed as follows:

1. Touch the slider of the desired slider control.

2. Move the slider to the required value.

If a value display has been configured, you can check the exact value that has been set.

3. Release the slider.

Result

The set value is applied.
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8.12

Introduction

Layout

Procedure

Result

Mobile Panel 27

8.12 Operating the switch

Operating the switch

The switch is an operating element and display object with two predefined switching states,
for example "On" and "Off". Switches can signalize the state of a plant section, for example if
a motor is running or not. At the same time, you can use the switch to change the state of
the corresponding plant section via the HMI device, for example from "On" to "Off".

The layout of the switch depends on the configuration:

Switch with slider

The two states are displayed by the position of the slider

Switch

@ Slider
Switch with text or graphic
The two states are displayed by the label on the slider

Depending on the switching state, the switch is labeled with one of two texts or one of
two graphics.

Examples:

"Backward" or "Forward"

Switch with slider

Proceed as follows:

Move the slider to the other position or double-click the slider area
Switch with text or graphic

Proceed as follows:

Touch the switch

The switch changes its appearance. The associated value is switched.

7 IWLAN
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8.13 Operating the trend view

8.13

Trends

Trend view

Operating the trend view

Trends continuously display the current process data or process data from a log.

Trends are displayed in the trend view. A trend view can display several trends
simultaneously.

10077

| @

m | w|w|w|a|lallsg] & x—-0

1
Trend Tag assignment Value Date/time -
Pressure Pressure pattern 25| 31.01.2006 13:06:34 v
|

®

Figure 8-6 Trend view, example

o
®
®

Ruler
Buttons for trend operation
Trend value in the value table

Layout and operation

Value table

216

The layout and operation of the trend view depends on the configuration. The configuration
engineer determines, for example, the following:

Appearance of the trend view, the axes, value ranges and labels
Operating options of the trend view
Limit values for the trend values

The change of color of the trend in the event of limit violation

Please refer to your system documentation to check whether additional information on this
subject is available there.

The trend values can be read from the value table if this is configured:

When the ruler is displayed, the trend values are shown at a position of the ruler in the
value table

When the ruler is hidden, the latest trend values are displayed in the value table
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8.13 Operating the trend view

Ruler
When configured, a ruler is available to provide an exact reading of the trend values in the
value table.
You can move the ruler to the desired position of the trend view.
Operation
The trend view can be operated as follows:
® Enlarge or reduce the display of time intervals
e Scroll forward or back by one display width
e Stop and resume trend recording
® Move the ruler
® Hide and display the ruler
The following table shows the trend view buttons:
Buttons Functions
] Stops or continues trend recording
= Zooms the displayed time section
=1 Zooms out of the displayed time section
- Scrolls one display width backwards (to the left)
VS Scrolls one display width forwards (to the right)
4 Scrolls back to the beginning of the trend recording. The start values of the
trend recording are displayed there.
- Moves the ruler backwards (to the left)
i Moves the ruler forwards (to the right)
i Inserts or removes the ruler
In addition, the configuration engineer can configure function keys or operating elements
with which you can control trend views.
Please refer to your system documentation to check whether additional information on this
subject is available there.
Operation

Touch the required button in the trend view.

The position of the ruler can also be changed by means of touching and dragging the ruler
on the touch screen.

Mobile Panel 277 IWLAN
Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0 217



Operating a project

8. 14 Operating the Status Force

8.14 Operating the Status Force

8.14 .1 Overview

Application
You read or write access values of the connected PLC directly with Status Force. Status
force allows you to monitor or change addresses of the PLC program, etc. You don't need to
connect an additional programming device or additional PC to the PLC.
Note
Status force can only be used in combination with SIMATIC S7.
Layout
The layout of Status Force depends on the configuration.
The figure shows the general layout of Status Force. A value can be monitored or controlled
on every line.
CDnnectiDnl Typel Oﬂ‘aetl FDrmatl Control Yalue | [l
PLC_1 M |120 |DEC 33
PLC_1 T |40 |7 24,00
PLC_1 o |50 |CDEC of .
PLC_1 o |50 |HEX oa00 | .
*I [ ;IJ
o | o |
Figure 8-7  Status Force, example
The configuration engineer specifies which columns appear in Status Force.
The table shows the significance of all configurable columns.
Column Functions
"Connection" The PLC whose address ranges must be displayed.
"Type", "DB Number", "Offset", The address range of the value
"Bit"
"Data type", "Format" The data type of the value
"Status value" The value read from the specified address.
"Control value" The value to be written to the specified address.
Please refer to your system documentation to check whether additional information on this
subject is available there.
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8. 14 Operating the Status Force

Operator controls
Depending on your configuration, you can operate the trend view using the following buttons:

Buttons Functions

o "Read" button

Updates the display in the "Status value" column.

This button engages when it is pressed. You cannot operate any text boxes until
the button is actuated again and the refresh is stopped.

WA "Write" button

Applies the new value in the "Control value" column. The control value is written
to the PLC.

8.14.2 Operation

Operator input options
Status Force can be operated as follows:
® Change the column sequence
® Read the status values of the connected PLC

e Enter values and transfer them to the PLC

Change column sequence
Depending on the configuration, you can change the column sequence of Status Force.
Proceed as follows:
1. Touch the column header which you wish to exchange with a different column header

2. Keeping the touch screen pressed, move the column heading to the column heading you
wish to exchange it with

Result
The columns are displayed in the modified sequence.

Procedure for reading the status value
Proceed as follows:

1. Enter the address and the desired format of a value for each line. Touch the respective
columns to display the screen keyboard.

2. Once you have entered all of the desired values, touch the & button.
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8.15 Operating the Sm@rtClient view

Result
All values are read cyclically by the PLC and entered in the "Status value" column until the

&' button is touched again.

Requirements for forcing
The following requirements must be fulfilled in order to force values:
® The "Control value" column must be available

® The "Write" button must be available

Procedure for forcing a value
Proceed as follows:

1. Enter the address of a value for each line. Enter the desired value in the "Control value"
column. Touch the respective columns to display the screen keyboard.
2. Once you have entered all of the desired values, touch the K2 button.

Result
The values from the "Control value" column are transferred once to the PLC.

8.15 Operating the Sm@rtClient view

8.15.1 Overview

Application
The Sm@rtClient view enables you to monitor and remotely operate the current project of a
remote HMI device. With the correct configuration, several equal priority HMI devices can
access a remote HMI device.
Note
If another HMI device accesses your HMI device via the Sm@rtClient view, this leads to an
additional load on your HMI device.

Layout

In the Sm@rtClient view, the remote HMI is displayed with the complete layout.
Depending on the configuration, you can monitor and also operate this screen.

You can also operate the function keys like buttons on an HMI device with a touch screen.

Monitoring mode

On a Sm@rtClient view which is configured for monitoring mode, you can only monitor the
remote HMI device. You cannot control its operation.
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Operation

8.15 Operating the Sm@rtClient view

Note

It is not possible to operate the direct keys of the remote HMI device from the local
HMI device.

The available operator controls depend on the HMI devices used:

® Same type of HMI devices

You can operate the project of the remote HMI device with the operator controls of your
HMI device

Operate keys from a local touch screen

All the keys of the remote HMI device are displayed as buttons on the touch screen.
You can touch them to operate them.

Touch operation from a local HMI device using keys

You operate the buttons in the usual manner.

8.15.2 Operation

Operator input options
The Sm@rtClient view can be operated as follows:

e Starting remote control

® Forcing permission

® Ending remote control

Procedure for starting remote control

Proceed as follows:

1.

Mobile Panel 277 IWLAN

On the HMI device change to the screen with the Sm@rtClient view.

The following options are available for establishing the connection to the remote
HMI device:

— The connection is established automatically.
— The connection must be established by touching the appropriate button.

Depending on the configuration, you may be required to enter the address of the
remote HMI device and a password.

. The current screen of the project running on the remote device is displayed on the screen

of your HMI device.
You can now monitor or control this screen depending on your configuration.

Scroll bars are displayed if the screen of the remote HMI device is larger than that of the
current HMI device.
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Procedure for forcing permission

If several HMI devices have access to a HMI device, only one HMI device has operating
permission at any one time.

Two cases must be distinguished for this case:

e |f another HMI device is already controlling the remote HMI device, if configured
accordingly, you can force operating permission for the remote HMI device

— You are trying to operate the remote HMI device

— A dialog appears in which you are prompted to enter the appropriate password for
forcing remote control

— You are now authorized to operate the remote HMI device

e [f another HMI device is accessing your HMI device via the Sm@rtClient view, you can
force local operating permission for your HMI device

— Touch the screen of your HMI device five times consecutively

— You are given permission to operate your local HMI device

Procedure for ending remote control

You can end monitoring and control of a remote HMI device with one of the following
methods depending on the configuration:

® Touch a button configured for this action
e Exit the screen containing the Sm@rtClient view

e |f configured, a menu is displayed after you have touched an empty space over a longer
period. Select the "Close" menu item.

Please refer to your system documentation to check whether additional information on this
subject is available there.

Mobile Panel 277 IWLAN
222 Operating Instructions, 04/2008, AV6 691-1DM01-2AB0



Operating a project
8.16 Project security

8.16 Project security

8.16.1 Overview

Design of the security system

The configuration engineer can protect the operation of a project by implementing a
security system.

The security system is based on authorizations, user groups and users.

If operating elements protected by a password are pressed, the HMI device first requests
that you log on. A logon screen is displayed in which you enter your user name and
password. After logging on, you can press the operating elements for which you have the
necessary authorizations.

The logon dialog can be set up by the configuration engineer via an individual operating
element.

In the same way, the configuration engineer can set up an operating element to log off.
After logging off, objects assigned password protection can no longer be operated; to do so,
log on again.

Please refer to your system documentation to check whether additional information on this
subject is available there.

Central user administration using SIMATIC Logon
Users, user groups and authorizations can be stored on a central server.

If user administration cannot contact the server, an error message is displayed. If this is the
case, you can only log on locally. Check whether additional information is available in your
plant documentation.

The operation of SIMATIC Logon differs as follows:

® The simple user display is not supported

® Users cannot be deleted

® You cannot change your logout time

® \When changing the password, you must enter it twice for security reasons

® The domain name is also indicated in the "User" field

User groups and authorizations

Project-specific user groups are created by the configuration engineer. The "Administrators"
and "PLC User" groups are included in all projects by default. User groups are assigned
authorizations. Authorization required for an operation is specifically defined for each
individual object and function in the project.
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8. 16 Project security

Users and passwords

Logoff times

Each user is assigned to exactly one user group.

The following persons are allowed to create users and assign them passwords:
® The configuration engineer during configuration

® The administrator on the HMI device

® A user with user management authorization on the HMI device

Irrespective of the user group, each user is allowed to change his own password.

A logoff time is specified in the system for each user. If the time between any two user
actions, such as entering a value or changing screens, exceeds this logoff time, the user is
automatically logged off. The user must then log on again to continue to operate objects
assigned password protection.

Backup and restore

Note
Backup and restore is not available to central user administration with SIMATIC Logon.

The user data is encrypted and saved on the HMI device to protect it from loss due to
power failure.

The users, passwords, group assignments and logoff times set up on the HMI device can be
backed up and restored. This prevents you having to enter all of the data again on another
HMI device.

NOTICE

The currently valid user data is overwritten in the following cases:
e Depending on the transfer settings, when the project is transferred again
e Upon restore of a backed-up project

¢ Upon import of the user administration via an operating element. Please refer to your
system documentation to check whether additional information on this subject is
available there.

The retransferred or restored user data and passwords are valid with immediate effect.

Limits for user, password and user view
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Number of characters
Length of user name, maximum 40
Length of password, minimum 3
Length of password, maximum 24
Entries in user view, maximum 50
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8.16.2 User view

Application
The user view is used to display the users on the HMI device:
e All users on the HMI device are displayed in the user view to the administrator or to a
user with administrator authorizations
e If you are a user without user management authorization, you can only see your personal
user entry
The authorizations of a user after logging on depends on the user group to which the user is
assigned.
Please refer to your system documentation to check whether additional information on this
subject is available there.
Layout

The configuration engineer can implement a simple or extended user view.

The two user views offer the same functions. They differ only in the display of information.

Simple user view

If you are not logged on to the HMI device, the only entry contained in the simple user view
is "<ENTER>".

If you are logged on to the HMI device, the simple user view only displays the user name
and user group.

Group =)
PLC User Group (1)
User 1 Group (1)
<Mew Lser =
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8. 16 Project security

Extended user view
The extended user view displays information about the users.

Logoff time

Adrmin i Group (9 5

PLC User

Aok ok ok ok ok GrDup (1:] 5

Uger 1 | **##**r | Group (1) 5

1| [ E

The extended user view contains the following columns:
® Users

® Password

e Group

® | ogoff time

The passwords are encrypted by appearing as asterisks.

8.16.3 User logon

Logon dialog

Use the logon dialog to log on to the security system of the HMI device. Enter your user
name and password in the logon dialog.

logon x|
User: I
Password: I
Ok | Cancel |

The logon dialog opens in the following cases:

® You press an operating element with password protection

® You press an operating element that was configured for displaying the logon dialog
e Select the "<ENTER>" entry in the simple user view

® Select a blank entry in the extended user view

® The logon dialog will be automatically displayed when the project is started, depending on
the configuration

Please refer to your system documentation to check whether additional information on this
subject is available there.
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8.16 Project security

Requirements
The logon dialog is open.

Procedure using the touch screen
Proceed as follows:
1. Enter the user name and password.
Touch the corresponding text box. The alphanumerical screen keyboard is displayed.

2. Select "OK" to confirm logon.

Procedure using the keys
Proceed as follows:

1. Using the key select the "User" text box within the logon dialog.
2. Enter the user name using the system keys.

To enter letters, switch the numerical keypad to letter assignment using the key .

3. Using the key select the "Password" text box.
4. Enter the password using the system keys.

5. Touch the "OK" button to confirm your entries.

Note
The user name is not case-sensitive.

The password is case-sensitive.

Result

After successful logon to the security system, you can execute password-protected functions
on the HMI device for which you have authorizations.

If you enter a wrong password, an error message is displayed when an alarm window has
been configured.
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8. 16 Project security

8.16.4 User logoff

Requirements
You have logged into the security system of the HMI device.

Procedure
You have the following options for logging off:
® You press an operating element that was configured for logoff
e You will be logged off automatically if you are not operating the project and if the logoff
time has been exceeded
You will also be automatically logged off if you enter an incorrect password.
Result

You are no longer logged into the project. In order to activate an operating element with
password protection, you must first log on again.

8.16.5 Creating users

Requirements
You have opened a screen containing the user view.

You have user management authorization or you are the administrator.

NOTICE

The following characters cannot be used in passwords:
e Blank
e Special characters *? . % /\""
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8.16 Project security

Procedure for creating a user in the simple user view

Proceed as follows:

1.

Touch the "<New User>" entry in the user view.

The following dialog opens:

B x|
Lser: I
Password: I
(04 | Cancel |

Enter the desired user name and password.

Touch the corresponding text box. The alphanumerical screen keyboard is displayed.
. Touch the "OK" button.

The following dialog opens:

DN x|
Group: [Giroup (1) =]

Logoff time: |5

[ ox |

Cancel |

Assign the user to a group.
In order to do so, open the "Group" drop down list box by means of the ~| button.

Select «| and x| to scroll in the drop down list box.

Touch the required entry in the drop down list box.

The selected entry is then accepted as input.

6. Touch the text box "Logoff time". The screen keyboard is displayed.

7. Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for

Mobile Panel 277 IWLAN

"no automatic logoff."

Touch the "OK" button to confirm your entries.
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8. 16 Project security

Procedure for creating a user in the extended user view
Proceed as follows:
1. Double-click the desired field in the blank line of the user view.
The appropriate screen keyboard is displayed.
2. Enter the respective user data in the field:
— Assign the user to one of the groups from the drop down list box.

— Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for
"no automatic logoff."

Result
The new user is created.

8.16.6 Changing user data

Requirements
You have opened a screen containing the user view.
Which data you are allowed to change depends on your authorization:

® You are an administrator or a user with user management authorization. In these cases
you are allowed to change the data for all the users on the HMI device in the user view:

User name

Group assignment

Password

Logoff time

® You are a user without user management authorization. In this case you are only allowed
to change your personal user data:

— Password

— Logoff time, if configured

Note
You can only change the logoff time and password for the "Admin" user.

You can only change the logoff time for the "PLC_User". This user is used for logging
on via the PLC

Procedure for changing user data in the simple user view
Proceed as follows:
1. In the user view, touch the user whose user data you want to change

2. When entering the data, use exactly the same procedure as for creating a user
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8.17 Closing the project

Procedure for changing user data in the extended user view
Proceed as follows:
1. In the user view, touch the user whose user data you want to change

2. When entering the data, use exactly the same procedure as for creating a user

Result
The user data for the user is changed.

8.16.7 Deleting users

Requirements
You have opened a screen containing the user view.

To delete a user, you must be an administrator or have user management authorization.

Note

The "Admin" and "PLC_User" users exist by default. These users cannot be deleted.

Procedure

To delete a user, delete the user name entered.

Result

The user has been deleted and may no longer log onto the project.

8.17 Closing the project

Procedure
Proceed as follows:
1. Use the corresponding operating element object to close the project.
Wait for the Loader to open after you closed the project.
2. Press the ON/OFF button for at least 4 seconds.
Result

The project is terminated.
The HMI device is switched off.
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8.17 Closing the project
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Operating alarms

9.1 Overview

Alarms

Alarms indicate events and states on the HMI device which have occurred in the system,
in the process or on the HMI device itself. A status is reported when it is received.

An alarm could trigger one of the following alarm events:
® |ncoming

e Qutgoing

® Acknowledge

The configuration engineer defines which alarms must be acknowledged by the user.
An alarm may contain the following information:

® Date

® Time

® Alarm text

® |ocation of fault

e State

® Alarm class

® Alarm number

e Alarm group

e Diagnostics capability
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9.1 Overview

Alarm classes

Alarm groups

Alarm buffer

Alarm report

Alarm log

234

Alarms are assigned to various alarm classes:
® Error

Alarms in this class must always be acknowledged. Error alarms normally indicate critical
errors within the plant such as "Motor temperature too high"

® QOperation

Warning alarms usually indicate states of a plant such as "Motor switched on"
e System

System alarms indicate states or events which occur on the HMI device
e SIMATIC diagnostic alarms

SIMATIC diagnostic alarms show states and events of the SIMATIC S7 or
SIMOTION PLCs

® User-specific alarm classes
The properties of this alarm class must be defined in the configuration

Please refer to your system documentation to check whether additional information on this
subject is available there.

The configuration engineer can group alarms into alarm groups. When you acknowledge an
individual alarm of an alarm group, you acknowledge all alarms which belong to the same
alarm group.

The alarm events are stored in an internal buffer remanently. The size of this alarm buffer
depends on the HMI device type.

The configuration engineer can activate alarm reporting on the project. In this case, alarm
events are output directly on the connected printer.

The configuration engineer can define whether each individual alarm is logged. An alarm of
this type is printed when the alarm events "Incoming" and "Outgoing" occur.

If you want to print alarms of the "System" alarm class, you have to print the contents of the
associated alarm buffer. For this case the configuration engineer has to configure an
operating element for printing the alarm buffer.

Alarm events are stored in an alarm log, provided this log file is configured. The capacity of
the log file is limited by the storage medium and system limits.
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9.2

9.3

9.2 Recognizing pending alarms

Recognizing pending alarms

You can recognize pending alarms that must be acknowledged by means of the alarm
indicator.

The alarm indicator is a graphic symbol indicating pending alarms or alarms requiring
acknowledgment, depending on the configuration. The configuration determines whether an
alarm has to be acknowledged or not. This is also defined by the alarm class which an alarm
belongs to.

[\

Figure 9-1 Alarm indicator with three pending alarms

The alarm indicator flashes as long as alarms are pending for acknowledgment. The number
displayed indicates the number of pending alarms. The configuration engineer can assign
functions to be executed when the alarm indicator is operated.

Usually, the alarm indicator is only used for error alarms. Please refer to your system
documentation to check whether additional information on this subject is available there.

Displaying alarms

Displaying alarms

Alarm view

Alarms are displayed in the alarm view or in the alarm window on the HMI device.

Depending on the configuration, the alarm view is displayed as follows:

® As a single line. Alarm numbers and alarm texts are displayed as single lines
® As simple alarm view

® As extended alarm view

In the simple or extended alarm views the configuration engineer specifies the alarm
information to be displayed.

Depending on the configuration, alarms from alarm logs are also displayed in the alarm view.
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9.3 Displaying alarms

Simple alarm view

Motor 23 too hot

19.04.2005 11:41:37 ! 1 {

7]

L RE . |

The buttons have the following functions:

Functions

Displaying infotext for an alarm.

Process alarm.

Acknowledge alarm.

Select the next or previous alarm in the list.

EYENE SR

Scroll one page up or down.

Extended alarm view

[ 12:04:59

Motor 23 too hot

Date Status
19.04.2005 K

I

The buttons have the following functions:

Buttons

Functions

&

Displaying infotext for an alarm.

Process alarm.

1.

Acknowledge alarm.
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Changing the column sequence and sorting in the extended alarm view

Depending on the configuration, you can change the column sequence and sorting order on
HMI devices with touch operation.

e Change column sequence
— Touch the column header which you wish to exchange with a different column header

— Keeping the touch screen pressed, move the column heading to the column heading
you wish to exchange it with

® (Change sorting order

To change the sorting order of the alarms, touch the respective column header on the
touch screen

Alarm class layout

The various alarm classes are identified in order to distinguish between them in the

alarm view.

Symbol Alarm class

! Error

Without a symbol Operation

Symbol depending on the configuration | User-defined alarm classes

S7 SIMATIC or SIMOTION diagnostic alarms
$ System

The configuration engineer can change the symbols for the alarm classes. Please refer to
your system documentation to check whether additional information on this subject is
available there.

Alarm window

The alarm window is independent of the process screen. Depending on the configuration,
the alarm window opens automatically as soon as a new alarm is pending for
acknowledgment. The alarm window can be configured so that it only closes after all the
alarms have been acknowledged.

The layout and the operation of the alarm window are the same as for the alarm view.

Please refer to your system documentation to check whether additional information on this
subject is available there.
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9.4 Display infotexts for an alarm

94 Display infotexts for an alarm

Displaying infotext

The configuration engineer can also provide infotext for alarms.

Procedure
Proceed as follows:
1. Touch the desired alarm in the alarm view or the alarm window.
The alarm is selected.
2. Touch the j button in the simple alarm view or in the extended alarm view.
If configured, the infotext assigned to this alarm is displayed.
3. Close the screen for displaying the infotext by means of the button.
See also
Displaying alarms|(Page 235)
9.5 Acknowledge alarm

Requirements
The alarm to be acknowledged is displayed in the alarm window or the alarm view.

Procedure
Proceed as follows:
1. Touch the desired alarm in the alarm view or the alarm window.
The alarm is selected.
2. Touch the j button in the simple alarm view or 3 | in the extended alarm view.

Alternative operation
Depending on the configuration, you can also acknowledge an alarm with a function key.

Result

The alarm is acknowledged. If the alarm belongs to an alarm group, all the alarms of the
associated group are acknowledged.

Please refer to your system documentation to check whether additional information on
acknowledgment and available alarm groups is available there.
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9.6 Edit alarm

9.6 Edit alarm

Introduction

The configuration engineer can assign additional functions to each alarm. These functions
are executed when the alarm is processed.

Note
When you edit an unacknowledged alarm, it is acknowledged automatically.

Requirements
The alarm to be edited is displayed in the alarm window or the alarm view.

Procedure
Proceed as follows:
1. Touch the desired alarm in the alarm view or the alarm window. The alarm is selected.
2. Touch the ﬂ button in the simple alarm view or & | in the extended alarm view.
Result

The system executes the additional functions of the alarm. Please refer to your system
documentation to check whether additional information on this subject is available there.
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9.6 Edit alarm
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10.1 Overview

Introduction

Recipes are used when different variants of a product are manufactured with the same
process. In this case, the product variants differ in terms of their type and quantity of the
components, but not in terms of the manufacturing process sequence. The configuration
engineer can store the combination of each individual product variant in a recipe.

Field of application

Recipes can be used everywhere the same product components are used in variable
combinations to create different product variants.

Examples:

® Beverage industry

® Food processing industry
® Pharmaceutical industry

® Paint industry

e Building materials industry

e Steel industry
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10.2 Structure of a recijpe

10.2 Structure of a recipe

Recipes

The recipe collection for the production of a product family can be compared to a file cabinet.
A recipe which is used to manufacture a product corresponds to a drawer in a file cabinet.

Example:

In a plant for producing fruit juice, recipes are required for different flavors. There is a recipe,
for example, for the flavors orange, grape, apple and cherry.

(
®

(
®

//
— | @

@ File cabinet Recipe collection Recipes for a fruit juice plant
®@ Drawer Recipe Orange flavored drinks

® Drawer Recipe Grape flavored drinks

@ Drawer Recipe Apple flavored drinks

® Drawer Recipe Cherry flavored drinks
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10.2 Structure of a recipe

Recipe data records

The drawers of the file cabinet are filled with suspension folders. The suspension folders in
the drawers represent records required for manufacturing various product variants.

Example:
Product variants of the flavor apple might be a soft drink, a juice or nectar, for example.

ONONONO

>

Drawer Recipe Product variants of apple flavored drinks
Suspension folder  Recipe datarecord  Apple drink

Suspension folder Recipe data record  Apple nectar

Suspension folder  Recipe data record  Apple juice

® 00

Elements

In the figure showing the file cabinet, each suspension folder contains the same number of
sheets. Each sheet in the suspension folder corresponds to an element of the recipe data
record. All the records of a recipe contain the same elements. The records differ, however,
in the value of the individual elements.

Example:

All drinks contain the same components: water, concentrate, sugar and flavoring. The
records for soft drink, fruit juice or nectar differ, however, in the quantity of sugar used in
production.
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10.3 Recipes in the project

10.3 Recipes in the project

Overview

244

If recipes are used in a project, the following components interact:

® Recipe view/recipe screen

On the HMI device, recipes are displayed and edited in the recipe view or in a recipe
screen.

— The recipe data records from the internal memory of the HMI device are displayed and
edited in the recipe view.

— The values of the recipe tags are displayed and edited in the recipe screen.

Depending on the configuration, the values displayed in the recipe view are synchronized
with the values of recipe tags.

HMI device recipe memory

Recipes are saved in the form of data records in the HMI device recipe memory.
The recipe data can also be saved in recipe tags.

Recipe tags

The recipe tags contain recipe data. When you edit recipes in a recipe screen, the recipe
values are stored in recipe tags. Depending on the configuration, the values of the recipe
tags are exchanged with the PLC.

The recipe tags can be synchronized with the recipe data records so that the same
values are saved in both.

Memory card

The memory card is an external storage medium for recipe data records. The recipe data
records are exported from the HMI device recipe memory and are saved on the memory
card in a *.csv file. The records can be reimported from the memory card to the recipe
memory.

Mobile Panel 277 IWLAN
Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0



Operating recipes

Data flow

10.3 Recipes in the project

The following figure shows the data flow in a project with recipes.

. <
Ol <

HMI device m
Recipe view @ u

Recipe 1
Recipe 2

Recipe 3

o=
1 @
Recipe tag A

Recipe < >

® f ~_ |

[

Qe 0600
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®

v

<

Memory card

Editing, saving or deleting a recipe data record
Display recipe data record

Synchronize or do not synchronize recipe tags
Display and edit recipe tags in the recipe screen

Write records from the recipe view to the PLC or read records from the PLC and
display them in the recipe view

Recipe tags are sent to the PLC online or offline
Export or import recipe data record to memory card
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10.4 Recipe displays

Displaying recipes
You can display and edit recipes on the HMI device with a recipe view or recipe screen.

Recipe view

A recipe view is a screen object used to manage recipe data records. The recipe view shows
recipe data records in tabular form.

Depending on the configuration, the recipe view is displayed as follows:
® As extended recipe view
® As simple recipe view

The configuration engineer also defines which operator controls are displayed in the
recipe view.

Extended recipe view

The following figure shows an example of the extended recipe view.

Recipe Mame:

Mo
@7|Orange j | 1 ( : )
Mo,

Data Record Marne:

@7|Nectar j|2 4@

Entry Mame Yalue 5
(3)——|water sw0o———5)
Concentrate (N

ECDO

Selection box for the recipe
Selection box for the recipe data record

Element name
The element name designates a specific element in the recipe data record

Display field
This show the number of the selected recipe or the selected recipe data record

Value of the element
Buttons for editing a recipe data record

Qe ©® 00

Status bar for display of the status messages
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10.4 Recipe displays

Simple recipe view

Display of values

The simple recipe view consists of three areas:
® Recipe list

e Data record list

® FElement list

In the simple recipe view, each area is shown separately on the HMI device. Depending on
the configuration, the simple recipe view starts with the recipe list or data record list.

The following figure shows an example of the record list.

Juice

Beverage -—
Nectar
—

Number of the recipe data record
Recipe data records
Buttons for changing the displayed list and calling the menu

@00 (——eoer-=

NOTICE
Changing the recipe data record in the background

Applies to the processing of a recipe data record:
If values of the corresponding recipe data record are changed by a PLC job, the recipe view
is not updated automatically.

To update the recipe view, reselect the respective recipe data record.
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10.4 Recipe displays

Recipe screen

248

A recipe screen allows the correlation between the plant and the recipe data to be displayed
in graphic form. The configuration engineer combines /O fields and screen objects to form a
custom input screen. The configuration engineer can distribute the 1/O fields of a recipe over
several recipe screens, thus allowing recipe elements to be arranged by subject. The recipe
screen can be operated using buttons configured accordingly.

The following figure shows an example of the recipe screen.

) D\
Water I 40 I | recipe name No.:
\Concentiaiet i 70 BN || [orange e
_ 30 - Data record name No.:
T iz
( T
Save | Data from the PLC |
Load | Data to PLC |
2
®

® é@
Element name and associated values

The element name designates a specific element in the recipe data record
Buttons for editing a recipe data record
Modified recipe view

®e e O

Buttons for transferring recipe data

The values displayed or entered in the recipe screen are saved in recipe tags. The recipe
values are exchanged with the PLC immediately or later via these tags.

A configured recipe view can itself be a component of a recipe screen You must synchronize
the tags in order to synchronize data between the tags of the recipe screen and the recipe
data records displayed in the recipe view. Synchronization of tags is only possible in the
extended recipe view.

Please refer to your system documentation to check whether additional information on this
subject is available there.
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10.5 Recipe values in the HMI device and the PLC

Introduction

You can change the values of a recipe on the HMI device and therefore influence the
manufacturing process or a machine.

Depending on the configuration, the recipe values are displayed, edited and saved in
different ways:

e |f you are editing recipes with a recipe view in your project, the values are saved in
recipe data records

® |f you are editing recipes in a recipe screen in your project, the values are saved in
recipe tags

Differences may occur between the display values in the recipe view and the values saved in
the associated tags in an ongoing project when you edit recipes with a recipe view and in a
recipe screen. To prevent this, the recipe data record values must be synchronized with the
values of the recipe tags.

You have however the option to perform synchronization operations at any time.
Synchronization only takes place if the configuration engineer has activated the respective
settings for a recipe.

Note
Recipe tags can only be synchronized in the extended recipe view.

Synchronizing recipe tags
Synchronization of the recipe tags depends on the configuration:

® Automatic synchronization:

The values of the recipe view are synchronized with the associated recipe tags. In this
case, changes to values in the recipe view have an immediate effect on the values of the
associated recipe tags. The values are only synchronized, when an operating element

that is outside the recipe view is operated.

e Synchronization by the user:

The values of the recipe view and the associated recipe tags are not synchronized

automatically. The configuration engineer has assigned the same function to the
& | button or a different operating element in the recipe view. The recipe tags and the

recipe view are only synchronized when you operate the buttons or the appropriate
operating element.
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Recipe tags online/offline

250

The configuration engineer can configure a recipe so that changes to the values of the recipe
tags do not have an immediate effect on the current process.

Synchronization of the recipe values between the HMI device and the PLC depends on
whether the configuration engineer has selected the settings "Tags online" or the setting
"Tags offline" for a recipe.
® "Tags online™

This setting has the following effect:

— When you change recipe values in the recipe screen, these changes are applied
immediately by the PLC and immediately influence the process

— If recipe values are changed in the PLC, the changed values are displayed
immediately in the recipe screen

e "Tags offline™:
With this setting, changed recipe values are not synchronized immediately between the
HMI device and the PLC

In this case, the configuration engineer must configure operating elements for transferring
the values to the PLC or reading them from the PLC in a recipe screen. The recipe values
are only synchronized between HMI device and PLC when you operate the appropriate
operating element
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10.6 Operating the recipe view

10.6.1 Overview

Operation

The recipe view can be operated as follows:

® Enter values for the recipe elements

® (Create recipe data records

® Save recipe data records or save them under a new name

® Delete recipe data records

Synchronize values of the recipe view with the associated recipe tags

Transfer recipe data records from the PLC and to the PLC

Operator controls of the recipe view

The following table shows the operator controls of the recipe view.

Buttons

Functions

Creates a new recipe data record.
If a start value is configured, it is shown in the text box.

Saves the displayed values of the recipe data record.
The storage location is predefined by the project.

The recipe data record is saved under a different name irrespective of the recipe
view. A dialog box opens in which the name is entered.

The displayed recipe data record is deleted.

o x 2]z

The values of the recipe view are synchronized with the associated recipe tags.
The values changed during editing are written to the associated recipe tags.
Subsequently all the values of the tags are read out and updated in the table.

The recipe values from the PLC are displayed in the recipe view.

&&=

The values of the set recipe data record displayed in the recipe view are
transferred to the PLC.

Operating the recipe screen

You operate the recipes in a recipe screen with the operator controls provided by the
configuration engineer.

Please refer to your system documentation to check whether additional information on this
subject is available there.
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10.6 Operating the recipe view

10.6.2 Creating a recipe data record

Introduction

Requirements

Procedure

Result

See also

252

You create a new recipe data record by modifying an existing record. You then save the
modified data record under a new name.

A screen with a recipe view is displayed.

Proceed as follows:

1.

If the recipe view contains several recipes: Select the recipe for which you want to create
a new recipe data record.

. Touch ﬂ

A new recipe data record with the next available number is created.

If you change the new data record number to an existing data record number, the existing
data record is overwritten.

Enter values for the elements of the data record.

The elements of the recipe data record can be assigned default values depending on the
configuration.

4. Touch il

5. Enter a name for the data record.

The data record is saved under the new name.

If the recipe data record already exists, a dialog is opened. In this dialog, specify whether
the existing data record is to be overwritten.

The new recipe data record is saved to the selected recipe.

Recipes in the project (Page 244)
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70.6 Operating the recipe view
10.6.3 Editing a recipe data record

Introduction
Edit the values of the recipe data records and save them in a recipe view.

Synchronization with the PLC

If you want to display the current recipe values from the PLC in the recipe view, you first

have to read the current values from the PLC with ﬂ

The values changed in the recipe view only become effective when the amended data record

is transferred to the PLC by means of theﬂl button.

Requirements
A screen with a recipe view is displayed.

Procedure
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to change.
3. Change the data record as required.

4. Save your changes by means of the El button.

If you want to save the recipe data record under a different name, touch the = | button.

5. The recipe data record is saved.

Result
The edited recipe data record has now been saved in the selected recipe.

See also
Recipes in the project (Page 244)
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10.6 Operating the recipe view

10.6.4 Deleting a recipe data record

Introduction

Requirements

Procedure

Result

See also

You can delete all the data records of a recipe which are not required.
A screen with a recipe view is displayed.

Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to delete.

3. Touch il

The recipe data record is deleted.

Recipes in the project (Page 244)

10.6.5 Synchronizing tags

Introduction

254

The values of the recipe elements can be saved to recipe tags, depending on the
configuration.

Differences may occur between the display values in the recipe view and the actual values of
tags in an ongoing project. Synchronize the tags to equalize such differences.

Synchronization always includes all the variables which belong to a recipe data record.

NOTICE

Changed tag name

Tags and the value of the recipe data record cannot be assigned to each other if the tag
name of the tag to be synchronized has been changed. The tags in question are not
synchronized.

Note
Recipe tags can only be synchronized in the enhanced recipe view.
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Requirement

Procedure

Result

See also

70.6 Operating the recipe view

A screen with a recipe view is displayed.

Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to synchronize.

3. Touch @

The elements of the recipe data record are synchronized with the recipe tags.

If the values of the recipe view and the tag do not match, the more current value is accepted.

Recipes in the project (Page 244)

10.6.6 Reading a recipe data record from the PLC

Introduction

Requirements

Procedure

In the current project, the values which are also stored in the recipes in the HMI device can

be changed directly in the plant. This is the case, for example, if a valve was opened further
directly at the plant than is stored in the recipe. The values of the recipe data records saved
in the HMI device possibly no longer match the values in the PLC.

To synchronize the recipe values, read the values from the PLC and display them in the
recipe view.

A screen with a recipe view is displayed.

Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record to which you want to apply the values from the PLC.

3. Touch El

The values are read from the PLC.

4. If you want to store the displayed values in the HMI device, touch the El button.
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10.6 Operating the recipe view

Result

The values were read from the PLC, displayed on the HMI device and saved to the selected
recipe data record.

See also
Recipes in the project (Page 244)

10.6.7 Transferring a recipe data record to the PLC

Introduction

In order for an edited recipe data record to take effect in the process, you must transfer the
values to the PLC.

The display values in the recipe view are always transferred to the PLC.

Requirements
A screen with a recipe view is displayed.

Procedure
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record whose values you want to transfer to the PLC.

3. Touch El

Result

The display values in the recipe view were transferred to the PLC and take effect in the
process.

See also
Recipes in the project (Page 244)
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10.7

10.7 Operating the simple recipe view

Operating the simple recipe view

10.7 1 Overview

Introduction

Operation

The simple recipe view consists of three areas:
® Recipe list
e Data record list

® FElement list

You can use the context menu to operate each of these display areas.

The simple recipe view can be operated as follows:

® Enter values for the recipe elements

® (Create recipe data records

® Save recipe data records or save them under a new name
® Delete recipe data records

® Transfer recipe data records from the PLC and to the PLC

Operator controls of the simple recipe view
Toggle between the display areas and the context menus to operate the simple recipe views.

The following table shows the operation of the display area.

Operation Functions

Touching an entry The next lower display area opens.

:I The next higher display area opens.

:l The context menu of the display area opens.

The following table shows the operation of the context menu.

Operation Functions

:l The menu is closed.
The display area opens.

Touch the menu command | The menu command is executed.
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10.7 Operating the simple recipe view

Context menus of the simple recipe view

® Recipe list

Menu item

Functions

New

A new recipe data record is created for the selected recipe.
If a start value is configured, it is shown in the text box.

Displaying infotext

The infotext configured for the simple recipe view is displayed.

Open

The record list of the selected recipe opens.

® Data record list

Menu item Functions
New A new recipe data record is created for the selected recipe.
If a start value is configured, it is shown in the text box.
Delete The selected record is deleted.
Save as The selected record is saved under a different name irrespective of the
simple recipe view. A dialog box opens in which the name is entered.
Rename The selected data record is renamed. A dialog box opens in which the

name is entered.

® FElement list

Menu item Functions

Save The selected record is saved.

To PLC The displayed values of the selected data record are transferred from
the HMI device to the PLC.

From PLC The recipe values from the PLC are displayed on the HMI device in the
recipe view.

Save as The selected data record is saved under a new name. A dialog box
opens in which the name is entered.

Operating the menu

Touch the desired menu command. The command is executed.

Operating the recipe screen

You operate the recipes in a recipe screen with the operator controls provided by the

configuration engineer.

Please refer to your system documentation to check whether additional information on this

subject is available there.
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10.7 Operating the simple recipe view

10.7.2 Creating a recipe data record

Introduction

Requirements

Procedure

Result

See also

Mobile Panel 277 IWLAN

Create a new recipe data record in the recipe list or in the record list. Then enter the values
for the new record in the element list and save the record.

A screen with a simple recipe view is displayed.

Proceed as follows:

1.

If the recipe list contains several recipes: Select the recipe for which you want to create a
new recipe data record.

2. Open the recipe list menu.

3. Select the menu command "New".

Creates a new record
The element list of the new record opens.
Enter values for the elements of the data record.

The tags of the record can be assigned default values depending on the configuration.

5. Open the menu of the element list and select the command "Save".

6. Enter a name for the new record.

7. Confirm your entries.

If you change the new data record number to an existing data record number, the existing
data record is overwritten.

The new recipe data record is saved to the selected recipe.

Recipes in the project (Page 244)
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10.7 Operating the simple recipe view

10.7.3 Editing a recipe data record

Introduction

Edit the values of the recipe data records in a simple recipe view.

Synchronization with the PLC

If you want to display the current recipe values from the PLC in the simple recipe view, you
first have to read the current values from the PLC with the menu command "From PLC" in
the element list.

The values changed in the recipe view only take effect in the PLC when you transfer the
edited data record to the PLC with the menu command "To PLC".

Requirements

A screen with a simple recipe view is displayed.

Procedure

Proceed as follows:

1.

o 0k N

Result

If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

Open the data record list.

Select the recipe data record you want to change.
Open the element list.

Change the values of the records as required.

Save your changes with the menu command "Save".

The recipe data record is saved.

The edited recipe data record has now been saved in the selected recipe.

See also

Recipes in the project (Page 244)
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10.7 Operating the simple recipe view

10.7.4 Deleting a recipe data record

Introduction
You can delete all the data records which are not required.

Requirements
A screen with a simple recipe view is displayed.

Procedure
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

Open the data record list.
Select the data record you want to delete.

Open the menu.

o > 0N

Select the menu command "Delete".

Result
The data record is deleted.

See also
Recipes in the project (Page 244)

10.7.5 Reading a recipe data record from the PLC

Introduction
The values of recipe elements are exchanged with the PLC via tags.

In the current project, the values which are also stored in the recipes in the HMI device can
be changed directly in the plant. This is the case, for example, if a valve was opened further
directly at the plant than is stored in the recipe. The values of the tags on the HMI device
possibly no longer match the values in the PLC.

To synchronize the recipe values, read the values from the PLC and display them in the
recipe view.

Requirements
A screen with a simple recipe view is displayed.
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10.7 Operating the simple recipe view

Procedure

Result

See also

Proceed as follows:

1.

If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

Select the element list of the recipe data record to which you want to apply the values
from the PLC.

3. Open the menu.

4. Select the menu item "From PLC".

The values are read from the PLC.
If you want to save the displayed values in the HMI device, select the menu item "Save".

The values were read from the PLC, displayed on the HMI device and saved to the selected
recipe data record.

Recipes in the project (Page 244)

10.7.6 Transferring a recipe data record to the PLC

Introduction

Requirements

Procedure

262

In order for an edited recipe data record to take effect in the process, you must transfer the
values to the PLC.

The display values in the recipe view are always transferred to the PLC.

A screen with a simple recipe view is displayed.

Proceed as follows:

1.

If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

Select the element list of the recipe data record whose values you want to transfer to
the PLC.

3. Open the menu.

Select the menu item "To PLC".
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Result

See also

10.8 Exporting a recipe data record

The values of the recipe data record were transferred to the PLC and take effect in the
process.

Recipes in the project (Page 244)

10.8 Exporting a recipe data record

Introduction

Requirements

Procedure

Result

You can export one or more recipe data records to a CSV file, depending on the
configuration. After export, the values in the recipe data record can be further processed in a
spreadsheet program such as MS Excel. The degree to which you can influence the export
depends on the configuration:

NOTICE
Export of recipe data to USB memory stick not possible

The USB interface is deactivated while the main battery is changed. Make sure that no
recipe data is exported to a USB memory stick while the main battery is being changed.

® A screen with a recipe view is displayed
® An operating element with the function "Export record" has been configured.

® The following tags are configured equally in the recipe view and for the "Export record"
operating element.

— Recipe number

— Data record number

Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to export.

3. Operate the operator control which was configured for export, for example the
"Export data record" button.

The data record is exported as a CSV file to an external data medium.

Please refer to your system documentation to check whether additional information on this
subject is available there.

The recipe data record is exported.
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10.9 Importing a recipe data record

10.9 Importing a recipe data record

Introduction

You can import values from a CSV file to a recipe data record, depending on the
configuration.

Requirements

® An operating element with the function "Import data record" has been configured,
for example a button

® A screen with a recipe view is displayed

Procedure
Proceed as follows:
1. If the recipe view contains several recipes: Select the recipe which contains the recipe
data record to be imported.
2. Operate the operating element with the function "Import data record".
The record is imported from an external data medium as a CSV file and then displayed in
the recipe view after import.
Result

The imported recipe data record is saved on the HMI device.

Deviating structure

If the structure of the CSYV file differs from the structure of the recipe, deviations are handled
as follows:

® Any additional values in the CSV file will be rejected

® The system applies the configured default value to the recipe data record if the CSV file
contains an insufficient number of values

e |f the CSV file contains values of the wrong data type, the configured default value is set
in the recipe data record

Example:
The imported CSV file contains values that were entered as floating point numbers

However, the corresponding tag expects an integer value. In this case, the system
discards the imported value and uses the configured default
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10.10 Examples

10.10 Examples

10.10.1  Entering a recipe data record

Introduction
You would like to enter production data on the HMI device without interrupting the process
in the machine or plant. For this reason, the production data should not be transferred to
the PLC.

Procedure

Proceed as follows:
1. Call the recipe view or a recipe screen.
Select the desired recipe data record.

Enter the values of the elements.

P wDd

Save the recipe data record.
The recipe data record is saved in the internal memory of the HMI device.

The following figure shows the data flow schematically.

HMI device m
Recipe view @ w

Recipe 1
Recipe 2
0—o @ Recipe 3
1 ©
Recipe tag
Recipe
screen @ v

>
©

PLC

D[ e
|

Display recipe data record

Save recipe data record

Tags are synchronized

Display and edit recipe tags in the recipe screen
Tags are offline

®©@®e 6 06
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10.10 Examples

10.10.2 Manual production sequence

Introduction
You request the production data of different workpieces from the PLC and display this data
on the screen of the HMI device for inspection. You want to correct the transferred
production data in the recipe view or the recipe screen if necessary.

Procedure

A scanner connected to the PLC reads the barcode of a workpiece. The barcode names
correspond to the names in the recipe data record. Based on the barcode name, the PLC
can read the required recipe data record. The recipe data record is displayed for inspection
on the HMI device. You can now edit and save the recipe data record. Then transfer the
edited recipe data record to the PLC again.

The following figure shows the data flow schematically.

HMI device m
Recipe view @ w

Recipe 1
Recipe 2

o—o Recipe 3
1 ©
Recipe tag

Recipe

screen @ v

@ PLC

The recipe data record is read from the PLC and written to the PLC again following
changes

Display and edit recipe tags in the recipe screen
Tags are synchronized

®e 6 o6

Recipe data records are saved in the recipe memory of the HMI device
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11.1 Maintenance and care

Scope of maintenance
o HMI device

The HMI device is designed for maintenance-free operation. The touch screen and
keyboard overlay should nevertheless be cleaned regularly.

® Maintenance cycle of battery

We recommend that you replace the battery once it can only be charged to 50 %.
This is the case after approximately 500 complete charging cycles.

A charging cycle is complete when the battery is fully charged.
Example:

The battery has a charging condition of 80 %. It needs another 20 % before it is fully
charged. The battery is charged. This charging process counts as one fifth of a complete
charging cycle.

® Transponder batteries

Replace the transponder batteries at least every 5 years.

Cleaning the HMI device

A\caution
Inadvertent operation

Always switch off the HMI device before cleaning it. This will ensure that you do not trigger
unintended functions when you touch the keys.

CAUTION

Do not clean the HMI device with compressed air or steam jet blowers. Never use
aggressive solvents or scouring powder.

Use a cleaning cloth dampened with a cleaning agent to clean the equipment.
Only use water with a little liquid soap or a screen cleaning foam.
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11.2 Spare parts and repairs

Procedure

Proceed as follows:
1. Switch off the HMI device.
2. Spray the cleaning solution onto a cleaning cloth.
Do not spray directly onto the HMI device.
3. Clean the HMI device.
When cleaning the display wipe from the screen edge inwards.

11.2 Spare parts and repairs

Repairs

Service pack

268

In case of repair, the HMI device must be shipped to the Return Center in Firth.
Repairs may only be carried out at the Return Center in Firth.

Depending on the work necessary to repair the device, the Center may decide to give you a
credit note. In this case, it is your responsibility to order a new device.

The address is:

A&D Return Center
Siemensstr. 2

90766 Firth, Germany

A service pack can be ordered for servicing purposes.
The service pack includes:
e For the HMI device
— Cover caps
— Battery compartment cover
— Bridging battery
® For the charging station
Covers for the battery compartment in the charging station.
Lock
Key set for lock

Counterpart for power supply connector

The service pack can be ordered from your Siemens representative.
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11.2 Spare parts and repairs

Replacement key set
You can order a replacement key set for the HMI device from your Siemens sales office.

Replacement batteries
Main batteries and bridge batteries can be ordered from your Siemens sales office.

Service & Support on the Internet

Service & Support provides additional comprehensive information on SIMATIC products
through online services at "http://www.siemens.com/automation/support".

Information about on-site services, repairs, spare parts, and much more is available on our
"Services" pages.
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11.2 Spare parts and repairs
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12.1.1

Front view

Dimension drawings
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12.1 Dimension drawings

Side view

8° All dimensions in mm
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12.1 Dimension drawings

12.1.2 Charging station
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12.1 Dimension drawings

12.1.3 Transponder
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12.2 Specifications
12.2 Specifications
12.2.1 Mobile Panel 277 IWLAN
HMI device
Weight with battery and without packaging Max. 2.2 kg
Display
Type Color TFT LC display
Display area, active 151.66 mm x 113.74 mm (7.5")
Resolution 640 x 480 pixels
Colors, displayable 64k colors
Brightness control Yes
Backlighting CCFL
Half Brightness Life Time, typical 50,000 h
Pixel error class according to DIN EN ISO 13406-2 Il
Input unit
Type Touch screen, analog, resistive
Membrane keyboard
Function keys 18, with LEDs
ON/OFF button 1
Handwheel (optional) 1
50 pulses per rotation
Key-operated switch (optional) 1
3 switch settings
llluminated pushbutton (optional) 2
LED separately controllable
Memory

Application memory

6 MB
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12.2 Specifications
Ports
1 x USB e USB host; conforms to USB standard 1.1
(supporting low-speed and full-speed USB devices)
e Maximum load 100 mA
1 x WLAN For PROFINET WLAN
1 x RJ45 For PROFINET LAN
Supply voltage
Supply voltage
About e Battery

e Charging station
e Tabletop power supply unit

Additional specifications

Drop height with battery

Max. 1.2 m

Buffer time of internal clock with bridging
battery inserted

Approx. 4 days

Radio link to transponder
e Frequency band
e Transmission angle

e 2,400 -2,483 MHz
e Approx. 83°

12.2.2 Batteries

Main battery

Type

Lithium ion accumulator

Operation time in normal mode

Approx. 4 h

Operation time in stand-by mode

Approx. 15 days

Charging cycles 500

Charging time Approx. 4 h

Bridging battery

Type Lithium ion accumulator
Bridging time 5 min

Charging cycles 500

N The effective charging time depends on the ambient temperature.

The higher the ambient temperature, the longer the charging time.
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12.2 Specifications
12.2.3 Charging station
Weight
‘Weight without packing Approx. 1.1 kg

Supply voltage

Nominal voltage +24 VDC

Range, permissible 19.2V 10 28.8 V (-20 %, +20 %)

Transients, maximum permissible 35V (500 ms)

Time between two transients, minimum 50 sec

Current consumption with Mobile Panel

e Typical e Approx. 1.5A

e Constant current, maximum e Approx. 1.8 A

e Power on current surge 12t e Approx. 1.7 A%s

Current consumption with Mobile Panel and batteries in

charging compartment

e Typical e Approx. 2.8 A

e Constant current, maximum e Approx. 3.4 A

e Power on current surge 12t e Approx. 1.7 A%s

Fuse, internal Electronic
12.2.4 Transponder

Weight without batteries 0.3 kg

Power supply 3 AA mignon batteries, 1.5V

Operating life of batteries in normal operation 5 years

Radio link to HMI device

e Frequency band e 2400-2,483 MHz

e Transmission angle e Approx. 93°

Type Passive
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12.2 Specifications

12.2.5 Description of interfaces on the HMI device

USB
The figure below shows the pin assignment of the USB interface.
1 4
==
Pin Assignment
1 +5 VDC, out (max. 100 mA)
2 USB-DN
3 USB-DP
4 GND
RJ45
The figure below shows the pin assignment of the RJ45 interface.
[ 1
nnIgInng
1 8
Pin Assignment
1 TD+
2 TD-
3 RD+
4 n. c.
5 n. c.
6 RD-
7 ICD+
8 ICD-
WLAN

WLAN according to IEEE 802.11 a,b,g,h

If the system includes zones and therefore transponders, WLAN according to IEEE 802.11a
must be used. As a general rule the use of WLAN according to IEEE 802.11a is
recommended.
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12.3 Radliation characteristic

12.3 Radiation characteristic

12.3.1 Radiation characteristic of the transponder

Antenna type Dual port patch antenna
Polarization Vertical and horizontal
Frequency band 2,400 - 2,483 MHz

Antenna gain Max. in main count direction

e Port1:2.6 dBic
e Port2: 2.7 dBic

Impedance 50 Q
Full widths at half maximum, horizontal at 2.45 GHz 93°
Full widths at half maximum, vertical at 2.45 GHz 90°

Ranges depending on angular displacement to main count direction
The following figure shows the coordinate system applied to the transponder.

T =
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12.3 Radliation characteristic

The figure below shows the transponder range depending on the angular displacement to
the main count direction in the y direction:
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12.3 Radliation characteristic

The following figure shows the transponder range depending on the angular displacement to
the main count direction in the z direction:
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perating Instructions, 04/2008, 6AV6 691-1DM01-2AB0 281



Technical specifications

12.3 Radliation characteristic

12.3.2 Radiation characteristic of HMI device

Antenna type Dual port patch antenna
Polarization Vertical and horizontal
Frequency band 2,400 - 2,483 MHz

Antenna gain Max. in main count direction

e Port 1: 2.6 dBic
e Port2: 2.7 dBic

Impedance 50 Q
Full widths at half maximum, horizontal at 2.45 GHz | 83°
Full widths at half maximum, vertical at 2.45 GHz 80°

Ranges depending on angular displacement to main count direction
The figure below shows the coordinate system applied to the HMI device.

z Az

x TN )
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Technical specifications

12.3 Radliation characteristic

The figure below shows the HMI device range depending on the angular displacement to the
main count direction in the y direction:
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Technical specifications

12.3 Radliation characteristic

The figure below shows the HMI device range depending on the angular displacement to the
main count direction in the z direction:
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Appendix l \

A.1 ESD guideline

Definition of ESD

All electronic modules are equipped with large-scale integrated ICs or components. Due to
their design, these electronic elements are highly sensitive to overvoltage, and thus to any
electrostatic discharge. These electronic components are therefore specially identified as

ESDs.
Abbreviations
The following abbreviation is commonly used for electrostatic sensitive devices:
o EGB - Elektrostatisch Gefahrdete Bauteile/Baugruppen (Germany)
e ESD - Electrostatic Sensitive Device (internationally recognized term)
Labeling

ESDs are labeled with the following symbol:
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Electrostatic charging

286

CAUTION

Electrostatic charging

ESDs may be destroyed by voltages far below the level perceived by human beings.
Voltages of this kind develop when a component or an assembly is touched by a person
who is not grounded against static electricity. Usually, it is unlikely that damage to an ESD
as a result of overvoltage is detected immediately but may become apparent only after a
longer period of operation.

Prevent electrostatic charging of your body before you touch the ESD!

Anyone who is not connected to the electrical potential of their surroundings is subjected to
electrostatic charging.

The following figure indicates the maximum electrostatic charge anyone is subjected to when
coming into contact with the materials shown. These values correspond with specifications to
IEC 801-2.

9 [kV]
S 161 | '
> e 1 | I
14 + |
13 1 | |
12 + | I
1+ | |
10 4+ |
oI | ®
T | |
6 1 | |
5 1 I @
4 -+
3+ |
2 -+
21| @+
] | ] ] ] | ] ] ] ] ] ] ] >
T T T T T T T T T T T
510 20 30 40 50 60 70 80 90 100 [%]
Relative humidity
0] Synthetic materials
® Wool
® Antistatic materials such as wood or concrete
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Protective measures against electrostatic discharge

CAUTION

Observe grounding measures

When working with electrostatic sensitive devices, make sure that the person, the
workplace and the packaging are properly grounded. This helps to avoid electrostatic
charging.

As a rule, only touch the ESD if this is unavoidable, for example for maintenance. When you
touch modules, make sure that you do not touch the pins on the modules or the PCB tracks.
In this way, the discharged energy cannot reach and damage the sensitive devices.

Discharge electrostatic electricity from your body if you are performing measurements on an
ESD. Do so by touching grounded metallic parts.

Always use grounded measuring instruments.

A.2 System alarms

Introduction

System alarms on the HMI device provide information about internal states of the HMI device
and PLC.

The following overview shows the causes of system alarms and how to eliminate the cause
of error.

Some of the system alarms described in this section are relevant to individual HMI devices
based on their range of features.

Note

System alarms are only indicated if an alarm window was configured. System alarms are
output in the language currently set on your HMI device.

System alarm parameters

System alarms may contain encrypted parameters which are relevant to troubleshooting
because they provide a reference to the source code of the runtime software. These
parameters are output after the text "Error code:"

Meaning of the system alarms

All the system alarms that can be displayed are listed below. The system alarms are divided
into different ranges:
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A.2 System alarms

Table A-1 10000 - Printer alarms

Number Effect/cause Remedy

10000 The print job could not be started or was canceled | Check the printer settings, cable connections and the
due to an unknown error. Faulty printer setup. Or: power supply.

No authorization is available for accessing the Set up the printer once again. Obtain a network printer
network printer. authorization.
Power supply failure during data transfer. If the error persists, contact the Hotline!

10001 No printer is installed or a default printer has not Install a printer and/or select it as the default printer.
been set up.

10002 Overflow of the graphics buffer for printing. Up to Allow sufficient intervals between successive print jobs.
two images are buffered.

10003 Images can now be buffered again. -

10004 Overflow of the buffer for printing lines in text mode | Allow sufficient intervals between successive print jobs.
(e.g. alarms). Up to 1000 lines are buffered.

10005 Text lines can now be buffered again. --

10006 The Windows printing system reports an error. Repeat the action if necessary.

Refer to the output text and the error ID to
determine the possible causes. Nothing is printed
or the print is faulty.

Table A-2 20000 - Global script alarms

Number Effect/causes Remedy

20010 An error has occurred in the specified script line. Select the specified script line in the configuration.
Execution of the script was therefore aborted. Note | Ensure that the tags used are of the allowed types.
the system alarm that may have occurred prior to Check system functions for the correct number and
this. types of parameters.

20011 An error has occurred in a script that was called by | In the configuration, select the script that has been
the specified script. called directly or indirectly by the specified script.
Execution of the script was therefore aborted in the | Ensure that the tags used are of the allowed types.
called script. Check system functions for the correct number and
Note the system alarm that may have occurred types of parameters.
prior to this.

20012 The configuration data is inconsistent. The script Recompile the configuration.
could therefore not be generated.

20013 The scripting component of WinCC flexible Reinstall WinCC flexible Runtime on your PC.
Runtime is not correctly installed. Therefore, no Rebuild your project with "Project > Generator >
scripts can be executed. Generate" and transfer the project to the HMI device.

20014 The system function returns a value that is not Select the specified script in the configuration.
written in any return tag. Check whether the script name has been assigned a

value.

20015 Too many successive scripts have been triggered Find what is triggering the scripts. Extend the times,
in short intervals. When more than 20 scripts are e.g. the polling time of the tags which trigger the
queued for processing, any subsequent scripts are | scripts.
rejected. In this case, the script indicated in the
alarm is not executed.
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Table A-3 30000 - Alarms for IFwSetValue: SetValue()

Number Effect/causes Remedy

30010 The tag could not accept the function result, e.g. Check the tag type of the system function parameter.
when it has exceeded the value range.

30011 A system function could not be executed because | Check the parameter value and tag type of the invalid
the function was assigned an invalid value or type | parameter. If a tag is used as a parameter, check its
in the parameter. value.

30012 A system function could not be executed because | Check the parameter value and tag type of the invalid
the function was assigned an invalid value or type | parameter. If a tag is used as a parameter, check its
in the parameter. value.

Table A-4 40000 - Linear scaling alarms

Number Effect/causes Remedy

40010 The system function could not be executed since Check the parameter types in the configuration.
the parameters could not be converted to a
common tag type.

40011 The system function could not be executed since Check the parameter types in the configuration.
the parameters could not be converted to a
common tag type.

Table A-5 50000 - Data server alarms

Number Effect/causes Remedy

50000 The HMI device is receiving data faster than it is
capable of processing. Therefore, no further data is
accepted until all current data have been
processed. Data exchange then resumes.

50001 Data exchange has been resumed. -

Table A-6 60000 - Win32 function alarms

Number Effect/causes Remedy

60000 This alarm is generated by the --
"DisplaySystemAlarms" function. The text to be
displayed is transferred to the function as a

parameter.

60010 The file could not be copied in the direction defined | Restart the system function or check the paths of the
because one of the two files is currently open or the | source/target files. Using Windows NT/2000/XP:
source/target path is not available. The user executing WinCC flexible Runtime must be

It is possible that the Windows user has no access | granted access rights for the files.
rights to one of the two files.

60011 An attempt was made to copy a file to itself. Check the path of the source/target file.
It is possible that the Windows user has no access | Using Windows NT/2000/XP with NTFS:
rights to one of the two files. The user executing WinCC flexible Runtime must be

granted access rights for the files.
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Table A-7

70000 - Win32 function alarms

Number

Effect/causes

Remedy

70010

The application could not be started because it
could not be found in the path specified or there is
insufficient memory space.

Check whether the application exists in the specified
path or close other applications.

70011

The system time could not be modified.

The error alarm only appears in connection with

area pointer "Date/time PLC". Possible causes:

e Aninvalid time was transferred in the job
mailbox.

e The Windows user has no right to modify the
system time.

If the first parameter in the system alarm is

displayed with the value 13, the second parameter

indicates the byte containing the incorrect value.

Check the time which is to be set.

Using Windows NT/2000/XP: The user executing
WinCC flexible Runtime must be granted the right to
change the system time of the operating system.

70012

An error occurred when executing the function
"StopRuntime" with the option "Runtime and
operating system".

Windows and WinCC flexible Runtime are not
closed.

One possible cause is that other programs cannot
be closed.

Close all programs currently running.
Then close Windows.

70013

The system time could not be modified because an
invalid value was entered. Incorrect separators may
have been used.

Check the time which is to be set.

70014

The system time could not be modified. Possible
causes:

e An invalid time was transferred.

e The Windows user has no right to modify the
system time.

Windows rejects the setting request.

Check the time which is to be set.

Using Windows NT/2000/XP: The user executing
WinCC flexible Runtime must be granted the right to
change the system time of the operating system.

70015

The system time could not be read because
Windows rejects the reading function.

70016

An attempt was made to select a screen by means
of a system function or job. This is not possible
because the screen number specified does not
exist.

Or: A screen could not be generated due to
insufficient system memory.

Or: The screen is blocked.
Or: Screen call has not been executed correctly.

Check the screen number in the function or job with the
screen numbers configured.
Assign the number to a screen if necessary.

Check the details for the screen call and whether the
screen is blocked for specific users.

70017

Date/time is not read from the area pointer because
the address set in the PLC is either not available or
has not been set up.

Change the address or set up the address in the PLC.

70018

Acknowledgment that the password list has been
successfully imported.

70019

Acknowledgment that the password list has been
successfully exported.

70020

Acknowledgment for activation of alarm reporting.

70021

Acknowledgment for deactivation of alarm
reporting.

290
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Number

Effect/causes

70022

Acknowledgment to starting the Import Password
List action.

70023

Acknowledgment to starting the Export Password
List action.

70024

The value range of the tag has been exceeded in
the system function.

The calculation of the system function is not
performed.

Check the desired calculation and correct it if
necessary.

70025

The value range of the tag has been exceeded in
the system function.

The calculation of the system function is not
performed.

Check the desired calculation and correct it if
necessary.

70026

No other screens are stored in the internal screen
memory.
No other screens can be selected.

70027

The backup of the RAM file system has been
started.

70028

The files from the RAM have been copied in the
Flash memory.

The files from the RAM have been copied in the
Flash memory. Following a restart, these saved
files are copied back to the RAM file system.

70029

Backup of the RAM file system has failed.
No backup copy of the RAM file system has been
made.

Check the settings in the "Control Panel > OP" dialog
and save the RAM file system using the "Save Files"
button in the "Persistent Storage" tab.

70030

The parameters configured for the system function
are faulty.

The connection to the new PLC was not
established.

Compare the parameters configured for the system
function with the parameters configured for the PLCs
and correct them as necessary.

70031

The PLC configured in the system function is not
an S7 PLC.

The connection to the new PLC was not
established.

Compare the S7 PLC name parameter configured for
the system function with the parameters configured for
the PLC and correct them as necessary.

70032

The object configured with this number in the tab
order is not available in the selected screen.

The screen changes but the focus is set to the first
object.

Check the number of the tab order and correct it if
necessary.

70033

An e-mail cannot be sent because a TCP/IP
connection to the SMTP server no longer exists.
This system alarm is generated only at the first
attempt. All subsequent unsuccessful attempts to
send an e-mail will no longer generate a system
alarm. The event is regenerated when an e-mail
has been successfully sent in the meantime.

The central e-mail component in WinCC flexible
Runtime attempts, in regular intervals (1 minute),
to establish the connection to the SMTP server and
to send the remaining e-mails.

Check the network connection to the SMTP server and
re-establish it if necessary.

70034

Following a disruption, the TCP/IP connection to
the SMTP server could be re-established.
The queued e-mails are then sent.
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Number Effect/causes Remedy
70036 No SMTP server for sending e-mails is configured. | Configure an SMTP server:
An attempt to connect to an SMTP server has In WinCC flexible Engineering System
failed and it is not possible to send e-mails. using "Device settings > Device settings"
WinCC flexible Runtime generates the system . .
) . In the Windows CE operating system
alarm after the first attempt to send an e-mail. - . .
using "Control Panel > Internet Settings > E-mail >
SMTP Server"

70037 An e-mail cannot be sent for unknown reasons. Check the e-mail parameters (recipient etc.).
The contents of the e-mail are lost.

70038 The SMTP server has rejected sending or Check the domain of the recipient address or
forwarding an e-mail because the domain of the deactivate the authentication on the SMTP server if
recipient is unknown to the server or because the possible. SMTP authentication is currently not used in
SMTP server requires authentication. WinCC flexible Runtime.

The contents of the e-mail are lost.

70039 The syntax of the e-mail address is incorrect or Check the e-mail address of the recipient.
contains illegal characters.

The contents of the e-mail are discarded.

70040 The syntax of the e-mail address is incorrect or --
contains illegal characters.

70041 The import of the user management was aborted Check your user management or transfer it again to
due to an error. the panel.

Nothing was imported.

70042 The value range for the tags has been exceeded Check the desired calculation and correct it if
while executing the system function. necessary.
The system function calculation has not been
carried out.

70043 The value range for the tags has been exceeded Check the desired calculation and correct it if
while executing the system function. necessary.
The system function calculation has not been
carried out.

Table A-8 80000 - Archive alarms

Number Effect/causes Remedy

80001 The log specified is filled to the size defined (in Store the file or table by executing a ‘move’ or ‘copy’
percent) and must be stored elsewhere. function.

80002 A line is missing in the specified log. -

80003 The copying process for logging was not --
successful.

In this case, it is advisable to check any
subsequent system alarms, too.

80006 Since logging is not possible, this causes a In the case of databases, check whether the
permanent loss of the functionality. corresponding data source exists and start up the

system again.

80009 A copying action has been completed successfully. | --

80010 Since the storage location was incorrectly entered | Configure the storage location for the respective log
in WIinCC flexible, this causes a permanent loss of | again and restart the system when the full functionality
the functionality. is required.
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Number Effect/causes Remedy

80012 Log entries are stored in a buffer. If the values are | Archive fewer values.
read to the buffer faster than they can be physically | Or:
written (using a hard disk, for example), Increase the logging cycle.
overloading may occur and recording is then
stopped.

80013 The overload status no longer applies. Archiving --
resumes the recording of all values.

80014 The same action was triggered twice in quick --
succession. Since the process is already in
operation, the action is only carried out once.

80015 This system alarm is used to report DOS or --
database errors to the user.

80016 The logs are separated by the system function Reconnect the logs.

"CloseAllLogs" and the incoming entries exceed
the defined buffer size.
All entries in the buffer are deleted.

80017 The number of incoming events cause a buffer Stop the copy action.
overflow. his can be caused, for example, by
several copying actions being activated at the
same time.

All copy jobs are deleted.

80019 The connection between WinCC flexible and all --
logs were closed, for example, after executing the
system function "CloseAllLogs".

Entries are written to the buffer and are then written
to the logs when a connection is re-established.
There is no connection to the storage location and
the storage medium may be replaced, for example.

80020 The maximum number of simultaneously copy Wait until the current copying actions have been
operations has been exceeded. Copying is not completed, then restart the last copy action.
executed.

80021 An attempt was made to delete a log which is still Wait until the current copying actions have been
busy with a copy action. Deletion has not been completed, then restart the last action
executed.

80022 An attempt was made to use the system function In the project, check
"StartSequencelog" to start a sequence log fora | o If the "StartSequencelLog" system function was
log which is not configured as a sequence log. No properly configured
sequence log file is created. o if the tag parameters are properly provided with

data on the HMI device

80023 An attempt was made to copy a log to itself. In the project, check
The log is not copied. e ifthe "CopyLog" system function was properly

configured
o if the tag parameters are properly provided with
data on the HMI device

80024 The "CopyLog" system function does not allow Edit the "CopyLog" system function in the project if
copying when the target log already contains data | necessary. Before you initiate the system function,
("Mode" parameter). The log is not copied. delete the destination log file.

80025 You have canceled the copy operation. -

Data written up to this point are retained. The
destination log file (if configured) is not deleted.
The cancellation is reported by an error entry
$RT_ERRS at the end of the destination log.
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Number Effect/causes Remedy

80026 This alarm is output after all logs are initialized. --
Values are written to the logs from then on. Prior to
this, no entries are written to the logs, irrespective
whether WinCC flexible Runtime is active or not.

80027 The internal Flash memory has been specified as Configure "Storage Card" or a network path as the
the storage location for a log. This is not storage location.
permissible.

No values are written to this log and the log file is
not created.

80028 The alarm returns a status report indicating that the | --
logs are currently being initialized. No values are
logged until the alarm 80026 is output.

80029 The number of logs specified in the alarm could not | Evaluate the additional system alarms related to this
be initialized. The logs are initialized. alarm. Check the configuration, the ODBC
The faulty log files are not available for logging (Open Database Connectivity) and the specified drive.
jobs.

80030 The structure of the existing log file does not match | Delete the existing log data manually, in advance.
the expected structure.

Logging is stopped for this log.

80031 The log in CSV format is corrupted. Delete the faulty file.
The log cannot be used.

80032 Logs can be assigned events. These are triggered | Close WinCC flexible Runtime, delete the log, then
as soon as the log is full. If WinCC flexible Runtime | restart WinCC flexible Runtime.
is started and the log is already full, the event is not | Or:
triggered. Configure a button which contains the same actions as
The log specified no longer logs data because itis | the event and press it.
full.

80033 "System Defined" is set in the data log file as the Install MSDE again.
data source name. This causes an error. No data is
written to the database logs, whereas the logging to
the CSV logs works.

80034 An error has occurred in the initialization of the No action is necessary. However, it is recommended to
logs. An attempt has been made to create the save the backup files or delete them in order to make
tables as a backup. This action was successful. A | the space available again.
backup has been made of the tables of the
corrupted log file and the cleared log was restarted.

80035 An error has occurred in the initialization of the It is recommended to save the backups or to delete
logs. An attempt has been made to create backups | them in order to release memory.
of the tables and this has failed. No logging or
backup has been performed.

80044 The export of a log was interrupted because The export resumes automatically.

Runtime was closed or due to a power failure. It
was detected that the export needed to be resume
when Runtime restarted.

80045 The export of a log was interrupted due to an error | The export is repeated automatically. Check:
in the connection to the server or at the server e The connection to the server
itself. e |f the server is running

o |f there is enough free space on the server

80046 The destination file could not be written while Check whether there is enough space on the server
exporting the log. and it you have permission to create the log file.
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80047 The log could not be read while exporting it. Check whether the storage medium is correctly
inserted.
80049 The log could not be renamed while preparing to Check whether the storage medium is correctly
export it. inserted and if there is sufficient space on the medium.
The job can not be completed."
80050 The log which shall be exported is not closed. Make sure the "CloseAll Logs" system function is
The job can not be completed. called before using the "ExportLog" system function.
Change the configuration as required.

Table A-9 90000 - FDA alarms

Number Effect/causes Remedy

90024 No operator actions can be logged due to lack of Make more space available by inserting an empty
space on the storage medium for log. The operator | storage medium or swapping out the log files on the
action will therefore not be executed. server using "ExportLog".

90025 No user actions can be logged because of error Check whether the storage medium is correctly
state of the archive. Therefore the user action will | inserted.
not be executed.

90026 No operator actions can be logged because the log | Before further operator actions are carried out, the log
is closed. The operator action will therefore not be | must be opened again using the system function
executed. "OpenAllLogs". Change the configuration as required.

90028 The password you entered is incorrect. Enter the correct password.

90029 Runtime was closed during ongoing operation Ensure that you are using the correct storage medium.

(perhaps due to a power failure) or a storage
medium in use is incompatible with Audit Trail.

An Audit Trail is not suitable if it belongs to another
project or has already be archived.

90030 Runtime was closed during ongoing operation --
(perhaps due to a power failure).
90031 Runtime was closed during ongoing operation --
(perhaps due to a power failure).
90032 Running out of space on the storage medium for Make more space available by inserting an empty
log. storage medium or swapping out the log files on the
server using "ExportLog".
90033 No more space on the storage medium for log. As | Make more space available by inserting an empty
of now, no more operator actions requiring logging | storage medium or swapping out the log files on the
will be executed. server using "ExportLog".
90039 You do not have the necessary authorization to Adapt or upgrade your authorizations.
perform this action.
90040 Audit Trail is switched off because of a forced user | Activate the "Audit Trail" again using the system
action. function "StartLog".
90041 A user action which has to be logged has been A user action requiring logging should only be possible
executed without a logged on user. with permission. Change the configuration by setting a
required permission for the input object.
90044 A user action which has to be confirmed was Repeat the user action if necessary.
blocked, because there is another user action
pending.
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Table A-10 110000 - Offline function alarms

Number Effect/causes Remedy

110000 The operating mode was changed. "Offline" mode | --
is now set.

110001 The operating mode was changed. "Online" mode | --
is now set.

110002 The operating mode was not changed. Check the connection to the PLCs.

Check whether the address area for the area pointer 88
»Coordination" in the PLC is available.

110003 The operating mode of the specified PLC was --
changed by the system function
"SetConnectionMode".

The operating mode is now "offline".

110004 The operating mode of the specified PLC has been | --
changed by the system function
"SetConnectionMode".

The operating mode is now "online".

110005 An attempt was made to use the system function Switch the complete system to "online" mode, then
SetConnectionMode to switch the specified PLC to | execute the system function again.

"online" mode, although the entire system is in
"offline" mode. This changeover is not allowed.
The PLC remains in "offline" mode.

110006 The content of the "project version" area pointer Check:
does not match the user version configured in e The project ID entered on the PLC.

WinCC flexible. WinCC flexible Runtime is « The project ID entered in WinCC flexible.
therefore closed.
Table A-11 120000 - Trend alarms

Number Effect/causes Remedy

120000 The trend is not displayed because you configured | Change the configuration.
an incorrect axis to the trend or an incorrect trend.

120001 The trend is not displayed because you configured | Change the configuration.
an incorrect axis to the trend or an incorrect trend.

120002 The trend is not displayed because the tag Check whether the data area for the tag exists in the
assigned attempts to access an invalid PLC PLC, the configured address is correct and the value
address. range for the tag is correct.
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Table A-12 130000 - System information alarms
Number Effect/causes Remedy
130000 The action was not executed. Close all other programs.
Delete files no longer required from the hard disk.
130001 The action was not executed. Delete files no longer required from the hard disk.
130002 The action was not executed. Close all other programs.
Delete files no longer required from the hard disk.
130003 No data medium found. The operation is canceled. | Check, for example, if
e The correct data medium is being accessed
e The data medium is inserted
130004 The data medium is write-protected. The operation | Check whether access has been made to the correct
is canceled. data carrier. Remove the write protection.
130005 The file is read only. The operation is canceled. Check whether access has been made to the correct
file. Edit the file attributes if necessary.
130006 Access to file failed. The operation is canceled. Check, for example, if
e The correct file is being accessed
e The file exists
¢ Another action is preventing simultaneous access to
the file
130007 The network connection is interrupted. Check the network connection and eliminate the cause
Records cannot be saved or read over the network | of error.
connection.
130008 The storage card is not available. Insert the storage card.
Records cannot be saved to/read from the
storage card.
130009 The specified folder does not exist on the storage | Insert the storage card.
card.
Any files saved to this directory are not backed up
when you switch off the HMI device.
130010 The maximum nesting depth can be exhausted Check the configuration.
when, for example, a value change in a script
results in the call of another script and the second
script in turn has a value change that results in the
call of yet a further script etc.
The configured functionality is not supported.
Table A-13 140000 - Connection alarms chns7: Connection + device
Number Effect/causes Remedy
140000 An online connection to the PLC is established. --
140001 The online connection to the PLC was shut down. | --
140003 No tag updating or writing is executed. Check the connection and if the PLC is switched on.

Check the parameter definitions in the Control Panel
using "Set PG/PC interface".
Restart the system.
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Number Effect/causes

Remedy

140004 No tag update or write operations are executed
because the access point or the module
configuration is faulty.

Verify the connection and check whether the PLC is
switched on.

Check the access point or the module configuration
(MPI, PPI, PROFIBUS) in the Control Panel with "Set
PG/PC interface".

Restart the system.

140005 No tag updating or writing is executed because the

HMI device address is incorrect (possibly too high).

Use a different HMI device address.

Verify the connection and check whether the PLC is
switched on.

Check the parameter definitions in the Control Panel
using "Set PG/PC interface".

Restart the system.

140006 No tag updating or writing is executed because the
baud rate is incorrect.

Select a different baud rate in WinCC flexible
(according to module, profile,
communication peer, etc.).

140007 Tags are not updated or written because the bus
profile is incorrect (see %1).

The following parameters could not be written to
the registry:

: Tslot

Tqui

Tset

MinTsdr

MaxTsdr

Trdy

Tid1

Tid2

: Gap Factor

10: Retry Limit

OoNIARL®N 2

Check the user-defined bus profile.

Check the connection and if the PLC is switched on.
Check the parameter definitions in the Control Panel
using "Set PG/PC interface".

Restart the system.

140008 No tag updating or writing is executed because
baud rate is incorrect. The following parameters
could not be written to the registry:

0: General error

1: Wrong version

2: Profile cannot be written to the registry.

3: The subnet type cannot be written to the

Check the connection and if the PLC is switched on.
Check the parameter definitions in the Control Panel
using "Set PG/PC interface".

Restart the system.

The option "PG/PC is the only master" is not set in
the Control Panel under "Set PG/PC interface".

registry.
4: The Target Rotation Time cannot be written to
the registry.
5: Faulty Highest Address (HSA).
140009 Tags are not updated or written because the Reinstall the module in the Control Panel using
module for S7 communication was not found. "Set PG/PC interface".
140010 No S7 communication partner found because the | Switch the PLC on.
PLC is shut down. DP/T:
DP/T: If only one master is connected to the network, disable

"PG/PC is the only master" in "Set PG/PC interface".

If several masters are connected to the network, enable
these. Do not change any settings, for this will cause
bus errors.

140011 No tag updating or writing is executed because
communication is down.

Check the connection and that the communication
partner is switched on.
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Number Effect/causes Remedy
140012 There is an initialization problem (e.g. when Restart the HMI device.
WinCC flexible Runtime was closed in Task Or:
Manager). Run WinCC flexible Runtime, then start your other
Or: applications.
Another application (e.g.STEP7) with different bus
parameters is active and the driver cannot be
started with the new bus parameters (transmission
rate, for example).

140013 The MPI cable is disconnected and, thus, there is | Check the connections.
no power supply.

140014 The configured bus address is in already in use by | Edit the HMI device address in the PLC configuration.
another application.

140015 Wrong transmission rate Correct the relevant parameters.

Or:

Faulty bus parameters (e.g. HSA)

Or:

OP address > HSA or: Wrong interrupt vector
(interrupt does not arrive at the driver)

140016 The hardware does not support the configured Change the interrupt number.
interrupt.

140017 The set interrupt is in use by another driver. Change the interrupt number.

140018 The consistency check was disabled by Enable the consistency check with SIMOTION Scout
SIMOTION Scout. Only a corresponding note and once again download the project to the PLC.
appears.

140019 SIMOTION Scout is downloading a new project to | Wait until the end of the reconfiguration.
the PLC. Connection to the PLC is canceled.

140020 The version in the PLC and that of the project The following remedies are available:

(FWXfile) do not match. Download the current version to the PLC using
Connection to the PLC is canceled SIMOTION Scout.
Regenerate the project using WinCC flexible ES, close
WinCC flexible Runtime and restart with a new
configuration.
Table A-14 150000 - Connection alarms chnAS511: Connection

Number Effect/causes Remedy

150000 No more data is read or written. Possible causes: | Ensure that the cable is plugged in, the PLC is
e The cable is defective operational, the correct port is being used.
« The PLC does not respond, is defective, etc. Restart the system if the system alarm persists.
e The wrong port is used for the connection
e System overload

150001 Connection is up because the cause of the --

interruption has been eliminated.
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Table A-15 160000 - Connection alarms IVar (WinLC)/OPC: Connection

Number Effect/causes Remedy

160000 No more data is read or written. Possible causes: Ensure that the cable is plugged in, the PLC
e The cable is defective is operational, the correct port is being used.
e The PLC does not respond, is defective, etc. R:rsstie;tsthe system if the system alarm
e The wrong port is used for the connection P '

e System overload

160001 Connection is up because the cause of the interruption has | --
been eliminated.

160010 No connection to the server because the server identification | Check access rights.

(CLS-ID) cannot be determined.
Values cannot be read or written.

160011 No connection to the server because the server identification | Check, for example, if
(CLS-ID) cannot be determined. e The server name is correct
Values cannot be read or written. « The computer name is correct

e The server is registered

160012 No connection to the server because the server identification | Check, for example, if
(CLS-ID) cannot be determined. o The server name is correct
Values cannot be read or written. « The computer name is correct

e The server is registered
Note for advanced users:
Interpret the value from HRESULT.

160013 The specified server was started as InProc server. This has | Configure the server as OutProc Server or
not been released and may possibly lead to incorrect Local Server.
behavior because the server is running in the same process
area as the WinCC flexible Runtime software.

160014 Only one OPC server project can be started on a PC/MP. An | Do not start a second project with OPC
alarm is output when an attempt is made to start a second server functionality on the computer.
project.

The second project has no OPC server functionality and
cannot be located as an OPC server by external sources.
Table A-16 170000 - S7 dialog alarms

Number Effect/causes Remedy

170000 S7 diagnostics events are not indicated because it is not --
possible to log on to the S7 diagnostics functions at this
device. The service is not supported.

170001 The S7 diagnostics buffer cannot be viewed because Set the PLC to online mode.
communication with the PLC is shut down.

170002 The S7 diagnostics buffer cannot be viewed because reading | --
of the diagnostics buffer (SSL) was canceled with error.

170003 An S7 diagnostics event cannot be visualized. The system --
returns internal error %2.

170004 An S7 diagnostics event cannot be visualized. The system --
returns an internal error of error class %2, error number %3.

170007 It is not possible to read the S7 diagnostics buffer (SSL) --
because this operation was canceled with an internal error of
class %2 and error code %3.
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Table A-17 180000 - Misc/common alarms
Number Effect/causes Remedy
180000 A component/OCX received configuration data with a | Install a newer component.
version ID which is not supported.
180001 System overload because too many actions running | Several remedies are available:
in parallel. Not all the actions can be executed, some |4 Generate the alarms at a slower rate (polling)
are rejected. o Initiate scripts and functions at greater intervals
If the alarm appears more frequently:
Restart the HMI device.
180002 The screen keyboard could not be activated. Reinstall WinCC flexible Runtime.
Possible causes:
"TouchlnputPC.exe" was not registered due to a
faulty Setup.
Table A-18 190000 - Tag alarms
Number Effect/causes Remedy
190000 It is possible that the tag is not updated. -
190001 The tag is updated after the cause of the last error -
state has been eliminated (return to normal
operation).
190002 The tag is not updated because communication with | Select the system function "SetOnline" to go online.
the PLC is down.
190004 The tag is not updated because the configured tag Check the configuration.
address does not exist.
190005 The tag is not updated because the configured PLC | Check the configuration.
type does not exist for this tag.
190006 The tag is not updated because it is not possible to Check the configuration.
map the PLC type in the data type of the tag.
190007 The tag value is not modified because the connection | Set online mode or reconnect to the PLC.
to the PLC is interrupted or the tag is offline.
190008 The threshold values configured for the tag have Observe the configured or current threshold values of
been violated, for example, by the tag.
e Avalue entered
e A system function
e Ascript
190009 An attempt has been made to assign the tag a value | Observe the range of values for the data type of the
which is outside the permitted range of values for this | tags.
data type.
For example, a value of 260 was entered for a byte
tag or a value of -3 for an unsigned word tag.
190010 Too many values are written to the tag The following remedies are available:

(for example, in a loop triggered by a script).
Values are lost because only up to 100 actions are
saved to the buffer.

¢ Increase the time interval between multiple write
actions.

¢ Do not use an array tag longer than 6 words
when you configure an acknowledgment on the
HMI device using "Acknowledgment HMI".
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Number Effect/causes Remedy
190011 Possible cause 1:
The value entered could not be written to the Make sure that the value entered lies within the
configured PLC tag because the high or low limit was | range of values of the control tags.
exceeded.
The system discards the entry and restores the
original value.
Possible cause 2:
The connection to the PLC was interrupted. Check the connection to the PLC.
190012 It is not possible to convert a value from a source Check the range of values or the data type of the
format to a target format, for example: tags.
An attempt is being made to assign a value to a
counter that is outside the valid, PLC-specific value
range.
A tag of the type Integer should be assigned a value
of the type String.
190013 The user has entered a string that is longer than the | Only enter strings that do not exceed the permitted
tag. The string is automatically shortened to the tag length.
permitted length.
Table A-19 190100 - Area pointer alarms
Number Effect/causes Remedy
190100 The area pointer is not updated because the address | Check the configuration.
configured for this pointer does not exist.
Type
1 Warnings
2 Errors
3 PLC acknowledgment
4 HMI device acknowledgment
5 LED mapping
6 Trend request
7 Trend transfer 1
8 Trend transfer 2
No.:
Consecutive number displayed in WinCC flexible ES.
190101 The area pointer is not updated because it is not --
possible to map the PLC type to the area pointer
type.
Parameter type and no.: See alarm 190100.
190102 The area pointer is updated after the cause of the last | --
error state has been eliminated
(return to normal operation).
Parameter type and no.: See alarm 190100.
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Table A-20 200000 - PLC coordination alarms

Number Effect/causes Remedy

200000 Coordination is not executed because the address | Change the address or set up the address in the PLC.
configured in the PLC does not exist/is not set.

200001 Coordination is canceled because the write access | Change the address or set the address in the PLC at an
to the address configured in the PLC is not area which allows write access.
possible.

200002 Coordination is not carried out at the moment Internal error
because the address format of the area pointer
does not match the internal storage format.

200003 Coordination can be executed again because the --
last error state is eliminated (return to normal
operation).

200004 The coordination may not be executed. -

200005 No more data is read or written. Possible causes: Ensure that the cable is plugged in and the PLC is
 The cable is defective operational. . .
« The PLC does not respond, is defective, etc. Restart the system if the system alarm persists.
e System overload

Table A-21 200100 - PLC user version alarms

Number Effect/causes Remedy

200100 Coordination is not executed because the address Change the address or set up the address in the
configured in the PLC does not exist/is not set. PLC.

200101 Coordination is canceled because the write access to | Change the address or set the address in the PLC at
the address configured in the PLC is not possible. an area which allows write access.

200102 Coordination is not carried out at the moment Internal error
because the address format of the area pointer does
not match the internal storage format.

200103 Coordination can be executed again because the last | --
error state is eliminated (return to normal operation).

200104 The coordination may not be executed. --

200105 No more data is read or written. Possible causes: Ensure that the cable is plugged in and the PLC is

e The cable is defective
e The PLC does not respond, is defective, etc.
e System overload

operational.
Restart the system if the system alarm persists.
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Table A-22 210000 - PLC job alarms
Number Effect/causes Remedy
210000 Jobs are not processed because the address Change the address or set up the address in the
configured in the PLC does not exist/has not been PLC.
set up.
210001 Jobs are not processed because read/write access to | Change the address or set up the address in the
the address configured in the PLC is not possible. PLC in an area which allows read/write access.
210002 Jobs are not executed because the address format of | Internal error
the area pointer does not match the internal storage
format.
210003 The job buffer is processed again because the last -
error status has been eliminated
(return to normal operation).
210004 It is possible that the job buffer will not be processed. |--
210005 A control request with an illegal number was initiated. | Check the PLC program.
210006 An error occurred while attempting to execute the Check the parameters of the control request.
control request. As a result, the control request is not | Recompile the configuration.
executed. Observe the next/previous system alarms.
Table A-23 220000 - WinCC channel adapter alarms
Number Effect/causes Remedy
220001 The tag is not downloaded because the associated Change the configuration.
communication driver/HMI device does not support
the download of Boolean/discrete data types.
220002 The tag is not downloaded because the associated Change the configuration.
communication driver/HMI device does not support
write access to the data type BYTE.
220003 The communication driver cannot be loaded. The Install the driver by reinstalling WinCC flexible
driver may not be installed. Runtime.
220004 Communication is down and no update data is Check the connection.
transferred because the cable is not connected or
defective etc.
220005 Communication is up. -
220006 The connection between the specified PLC and the -
specified port is active.
220007 The connection to the specified PLC is interrupted at | Check whether
the specified port. e The cable is plugged in
e The PLCis OK
e The correct port is used
e Your configuration is OK (port parameters,
protocol settings, PLC address)
Restart the system if the system alarm persists.
220008 The communication driver cannot access or open the | Close all the applications which access this port and
specified port. The port may be in use by another restart the computer.
application or the port used is not available on the Use another port of the system.
destination device.
There is no communication with the PLC.
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Table A-24 230000 - View alarms
Number | Effect/causes Remedy
230000 The value entered could not be accepted. The system | Enter a practical value or delete any unneeded

discards the entry and restores the previous value.
Either

e The value range has been exceeded
¢ lllegal characters have been entered

e The maximum permitted number of users has been
exceeded

users.

230002

The currently logged in user has not the required
authorization. The system therefore discards the input
and restored the previous value.

Log on as a user with appropriate authorization.

230003

Changeover to the specified screen failed because the
screen is not available/configured. The current screen
remains selected.

Configure the screen and check the screen selection
function.

230005

The value range of the tag has been exceeded in the
1/O field.
The original value of the tag is retained.

Observe the range of values for the tag when
entering a value.

230100

During navigation in the web browser, the system
returned a message which may be of interest to the
user.

The web browser continues to run but may not (fully)
show the new page.

Navigate to another page.

230200

The connection to the HTTP channel was interrupted
due to an error. This error is explained in detail by
another system alarm.

Data is no longer exchanged.

Check the network connection.
Check the server configuration.

230201

The connection to HTTP channel was established.
Data is exchanged.

230202

WININET.DLL has detected an error. This error usually
occurs when an attempt to connect to the server fails or
the server refuses to connect because the client lacks
the proper authorization.

An unknown server certificate may also be the cause if
the connection is encrypted by means of SSL.

The alarm text provides details.

This text is always in the language of the Windows
installation because it is returned by the Windows OS.
Process values are no longer exchanged.

Depending on the cause:

When an attempt to connect fails or a timeout error

occurs:
Check the network connection and the network
Check the server address

e Check whether the WebServer is actually running
on the destination station.

Faulty authorization:

e The configured user name and/or password do
not match those on the server. Establish
consistency

When the server certificate is rejected:

Certificate signed by an unknown CA ( ):

o Either ignore this item in your project, or

o Install a certificate that has been signed with a
root certificate known to the client computer

The date of the certificate is invalid:

o Either ignore this item in your project, or
o |Install a certificate with a valid date on the server

Invalid CN (Common Name or Computer Name):

e Either ignore this item in your project, or
o |Install a certificate with a name that corresponds
to that of the server address
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Number | Effect/causes Remedy
230203 Although a connection can be made to the server, the Error 503 Service unavailable:
HTTP server refuses to connect because Check that WinCC flexible Runtime is running on the
e WinCC flexible Runtime is not running on the server and the HTTP channel is supported.
server, or
e The HTTP channel is not supported
(503 Service unavailable)
Other errors can only occur if the Webserver does not
support the HTTP channel. The language of the alarm
text depends on the Webserver.
Data is not exchanged.
230301 An internal error has occurred. An English text explains | --
the error in more detail. This may be caused by
insufficient memory.
OCX does not work.
230302 The name of the remote server cannot be resolved. Check the configured server address.
The attempt to connect failed. Check whether the DNS service is available on the
network.
230303 The remote server is not running on the addressed Check the configured server address.
computer. Check whether the remote server is running on the
Wrong server address. target computer.
The attempt to connect failed
230304 The remote server on the addressed computer is Use a compatible remote server.
incompatible with VNCOCX.
The attempt to connect failed.
230305 The authentication has failed because the password is | Configure the correct password.
incorrect.
The attempt to connect failed.
230306 Error in the connection to the remote server. This may | Check whether
occur as a result of network problems. e The bus cable is plugged in
The attempt to connect failed. o There are network problems
230307 The connection to the remote server was shut down --
because
e The remote server was shut down, or
e The user instructed the server to close all
connections
The connection is closed.
230308 This alarm provides information on the connection --
status.
An attempt is made to connect.
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Table A-25 240000 - Authorization alarms
Number | Effect/causes Remedy
240000 WinCC flexible Runtime is operating in demo mode. Install the authorization.
You have no authorization or your authorization is corrupted.
240001 WinCC flexible Runtime is operating in demo mode. Load an adequate authorization/powerpack.
Too many tags are configured for the installed version.
240002 WinCC flexible Runtime is operating with a time-limited Restore the full authorization.
emergency authorization.
240004 Error while reading the emergency authorization. Restart WinCC flexible Runtime, install the
WinCC flexible Runtime is operating in demo mode. authorization or repair the authorization
(see Commissioning Instructions Software
Protection).
240005 The Automation License Manager has detected an internal Reboot the HMI device or PC. If this does not
system fault. solve the problem, remove the Automation
Possible causes: License Manager and install it again.
e A corrupt file
e A defective installation
* No free space for the Automation License Manager etc.
Table A-26 250000 - S7 Force alarms
Number | Effect/causes Remedy
250000 The tag in the specified line in "Status Force" is not updated | Check the set address and then verify that the
because the address configured for this tag is not available. | address is set up in the PLC.
250001 The tag in the specified line in "Status Force" is not updated | Check the set address.
because the PLC type configured for this tag does not exist.
250002 The tag in the specified line in "Status Force" is not updated | Check the set address.
because it is not possible to map the PLC type in the tag
type.
250003 An attempt to connect to the PLC failed. The tags are not Check the connection to the PLC. Check that the
updated. PLC is switched on and is online.
Table A-27 260000 - Password system alarms
Number | Effect/causes Remedy
260000 An unknown user or an unknown password has been entered | Log on to the system as a user with a valid
in the system. password.
The current user is logged off from the system.
260001 The logged in user does not have sufficient authorization to Log on to the system as a user with sufficient
execute the protected functions on the system. authorization.
260002 This alarm is triggered by the system function -
"TrackUserChange".
260003 The user has logged off from the system. -
260004 The user name entered into the user view already exists in Select another user name because user
the user management. names have to be unique in the user
management.
260005 The entry is discarded. Enter a shorter user name.
260006 The entry is discarded. Use a shorter or longer password.
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Number | Effect/causes Remedy

260007 The logon timeout value entered is outside the valid range of | Enter a logon timeout value between 0 and 60
0 to 60 minutes. minutes.

The new value is discarded and the original value is retained.

260008 An attempt was made to read a PTProRun.pwil file created --
with ProTool V 6.0 in WinCC flexible.

Reading the file was canceled due to incompatibility of the
format.

260009 You have attempted to delete the user "Admin" or "PLC If you need to delete a user, because perhaps
User". These users are fixed components of the user you have exceeded the maximum number
management and cannot be deleted. permitted, delete another user.

260012 The passwords entered in the "Change Password" dialog You have to log on to the system again. Then
and the confirmation field are not identical. enter the identical password twice to be able to
The password has not been changed. User will be logged off. | change the password.

260013 The password entered in the "Change Password" dialog is You have to log on to the system again. Then
invalid because it is already in use. enter a new password that has not been used
The password has not been changed. User will be logged off. | before.

260014 You have tried unsuccessfully to log on 3 times in You can log on to the system with your correct
succession. password. Only an administrator can change
You will be locked out and assigned to group no. 0. the assignment to a group.

260023 The password you entered does not meet the necessary Enter a password that contains at least one
security guidelines. number.

260024 The password you entered does not meet the necessary Enter a password that contains at least one
security guidelines. character.

260025 The password you entered does not meet the necessary Enter a password that contains at least one
security guidelines. special character.

260028 Upon system start-up, an attempt to log on, or when trying to | Check the connection to the SIMATIC Logon
change the password of a SIMATIC log-on user, the system | Server and its configuration; for example:
attempts to access the SIMATIC Logon Server. 1. Port number
If attempting to log on, the new user is not logged in. If a 2. IP address
different user was logged on before, then this user is logged | 3. Server name
off. 4. Functional transfer cable

Or use a local user.

260029 The SIMATIC Logon user is not associated to any or several | Check the user data on the SIMATIC Logon
groups. Server and the configuration in your
The new user is not logged in. If a different user was logged | WinCC flexible project. A user may only be
on before, then this user is logged off. assigned to one group.

260030 The SIMATIC Logon user could not change his password on | Log in again and choose a different password.
the SIMATIC Logon Server. The new password may not Check the password rules on the SIMATIC
comply with the password regulations on the server or the Logon Server.
user does not have the right to change his password.

The old password remains and the user is logged off.

260031 It was not possible to log the user on to the SIMATIC Logon | Try again. If necessary, check the password
Server. The user name or the password could be incorrect or | data on the SIMATIC Logon Server.
the user does not have sufficient rights to log on.

The new user is not logged in. If a different user was logged
on before, then this user is logged off.

260032 It was not possible to log the user on to the SIMATIC Logon | Check the user data on the SIMATIC Logon
Server as his account is blocked. Server.

The new user is not logged in. If a different user was logged
on before, then this user is logged off.
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Number | Effect/causes Remedy
260033 The action change password or log on user could not be Check the connection to the SIMATIC Logon
carried out. Server and its configuration; for example:
1. Port number
2. IP address
3. Server name
4. Functional transfer cable
Or use a local user.
260034 The last logon operation has not yet ended. A user action or | Wait until the logon operation is complete.
a logon dialog can therefore not be called.
The logon dialog is not opened. The user action is not
executed.
260035 The last attempt to change the password was not completed. | Wait until the procedure is complete.
A user action or a logon dialog can therefore not be called.
The logon dialog is not opened. The user action is not
executed.
260036 There are insufficient licenses on the SIMATIC Logon Sever. | Check the licensing on the SIMATIC Logon
The logon is not authorized. Server.
260037 There is no license on the SIMATIC Logon Sever. A logon is | Check the licensing on the SIMATIC Logon
not possible. Server.
It is not possible to log on via the SIMATIC Logon Server,
only via a local user.
Table A-28 270000 - System alarms
Number | Effect/causes Remedy
270000 A tag is not indicated in the alarm because it attempts to Check whether the data area for the tag exists
access an invalid address in the PLC. in the PLC, the configured address is correct
and the value range for the tag is correct.
270001 There is a device-specific limit as to how many alarms may -~
be queued for output (see the operating instructions). This
limit has been exceeded.
The view no longer contains all the alarms.
However, all alarms are written to the alarm buffer.
270002 The view shows alarms of a log for which there is no data in | Delete older log data if necessary.
the current project.
Wildcards are output for the alarms.
270003 The service cannot be set up because too many devices Reduce the number of HMI devices which want
want to use this service. to use the service.
A maximum of four devices may execute this action.
270004 Access to persistent buffer is not possible. Alarms cannot be | If the problems persist at the next startup,
restored or saved. contact Customer Support (delete Flash).
270005 Persistent buffer damaged: Alarms cannot be restored. If the problems persist at the next startup,
contact Customer Support (delete Flash).
270006 Project modified: Alarms cannot be restored from the The project was generated and transferred
persistent buffer. new to the HMI device; The error should no
longer occur when the device starts again.
270007 A configuration problem is preventing the restore Update the operating system and then transfer

(a DLL is missing, a directory is unknown, etc.).

your project again to the HMI device.
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Table A-29 280000 - DPHMI alarms Connection
Number | Effect/causes Remedy
280000 Connection is up because the cause of the interruption --
has been eliminated.
280001 No more data is read or written. Possible causes: Check whether
e The cable is defective e The cable is plugged in
e The PLC does not respond, is defective, etc. e The PLCis OK
e The wrong port is used for the connection e The correct port is used
e System overload Restart the system if the system alarm persists.
280002 The connection used requires a function block in the -~
PLC.
The function block has responded. Communication is
now enabled.
280003 The connection used requires a function block in the Check whether
PLC. _ e The cable is plugged in
The function block has not responded. e The PLCis OK
e The correct port is used
Restart the system if the system alarm persists.
Remedy depends on the error code:
1: The function block must set the COM bit in the
response container.
2: The function block must not set the ERROR bit
in the response container.
3: The function block must respond within the
specified time (timeout).
4: Go online to the PLC.
280004 The connection to the PLC is interrupted. There is no Check the connection parameters in
data exchange at present. WinCC flexible.
Ensure that the cable is plugged in, the PLC is
operational, the correct port is being used.
Restart the system if the system alarm persists.
Table A-30 290000 - Recipe system alarms
Number | Effect/causes Remedy
290000 The recipe tag could not be read or written. It is assigned | Check in the configuration that the address has
the start value. been set up in the PLC.
The alarm can be entered in the alarm buffer for up to four
more failed tags if necessary. After that, alarm 290003 is
output.
290001 An attempt has been made to assign a value to a recipe Observe the value range for the tag type.
tag which is outside the value range permitted for this
type.
The alarm can be entered in the alarm buffer for up to four
more failed tags if necessary. After that, alarm 290004 is
output.
290002 It is not possible to convert a value from a source format | Check the value range or type of the tag.
to a target format.
The alarm can be entered in the alarm buffer for up to four
more failed recipe tags if necessary. After that, alarm
290005 is output.
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A.2 System alarms

Number | Effect/causes Remedy
290003 This alarm is output when alarm number 290000 is Check in the configuration that the tag addresses
triggered more than five times. have been set up in the PLC.
In this case, no further separate alarms are generated.
290004 This alarm is output when alarm number 290001 is Observe the value range for the tag type.
triggered more than five times.
In this case, no further separate alarms are generated.
290005 This alarm is output when alarm number 290002 is Check the value range or type of the tag.
triggered more than five times.
In this case, no further separate alarms are generated.
290006 The threshold values configured for the tag have been Observe the configured or current threshold
violated by values entered. values of the tag.
290007 There is a difference between the source and target Insert the specified data recipe tag in the source
structure of the recipe currently being processed. The structure.
target structure contains an additional data recipe tag
which is not available in the source structure.
The data recipe tag specified is assigned its start value.
290008 There is a difference between the source and target Remove the specified data recipe tag in the
structure of the recipe currently being processed. The specified recipe from the project.
source structure contains an additional data recipe tag
which is not available in the target structure and therefore
cannot be assigned.
The value is rejected.
290010 The storage location configured for the recipe is not Check the configured storage location.
permitted.
Possible causes:
lllegal characters, write protection, data carrier out of
space or does not exist.
290011 The record with the specified number does not exist. Check the source for the number
(constant or tag value)
290012 The recipe with the specified number does not exist. Check the source for the number
(constant or tag value)
290013 An attempt was made to save a record under a record The following remedies are available:
number which already exists. e Check the source for the number (constant or
The action is not executed. tag value)
e First, delete the record
e Change the "Overwrite" function parameter
290014 The file specified to be imported could not be found. Check:
e The file name
e Ensure that the file is in the specified directory
290020 Alarm reporting that the download of records from the HMI | --
device to the PLC has started.
290021 Alarm reporting that the download of records from the HMI | --
device to the PLC was completed.
290022 Alarm reporting that the download of records from the HMI | Check in the configuration whether:
device to the PLC was canceled due to an error. e The tag addresses are configured in the PLC
e The recipe number exists
e The record number exist
e The "Overwrite" function parameter is set
290023 Alarm reporting that the download of records from the --

PLC to the HMI device has started.
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A.2 System alarms

Number | Effect/causes Remedy
290024 Alarm reporting that the download of records from the -
PLC to the HMI device was completed.
290025 Alarm reporting that the download of records from the Check in the configuration whether:
PLC to the HMI device was canceled due to an error. e The tag addresses are configured in the PLC
e The recipe number exists
e The record number exist
e The "Overwrite" function parameter is set
290026 An attempt has been made to read/write a record although | Set the record status to zero.
the record is not free at present.
This error may occur in the case of recipes for which
downloading with synchronization has been configured.
290027 Unable to connect to the PLC at present. As a result, the | Check the connection to the PLC.
record can neither be read nor written.
Possible causes:
No physical connection to the PLC (no cable plugged in,
cable is defect) or the PLC is switched off.
290030 This alarm is output after you selected screen which Reload the record from the storage location or
contains a recipe view in which a record is already retain the current values.
selected.
290031 While saving, it was detected that a record with the Overwrite the record or cancel the action.
specified number already exists.
290032 While exporting records it was detected that a file with the | Overwrite the file or cancel the process.
specified name already exists.
290033 Confirmation request before deleting records. --
290040 A record error with error code %1 that cannot be Check the storage location, the record, the
described in more detail occurred. "Data record" area pointer and if necessary, the
The action is canceled. connection to the PLC.
It is possible that the record was not installed correctly on | Restart the action after a short time.
the PLC. If the error persists, contact Customer Support.
Forward the relevant error code to Customer
Support.
290041 A record or file cannot be saved because the storage Delete files no longer required.
location is full.
290042 An attempt was made to execute several recipe actions Trigger the action again after waiting a short
simultaneously. The last action was not executed. period.
290043 Confirmation request before storing records. -
290044 The data store for the recipe has been destroyed and is --
deleted.
290050 Alarm reporting that the export of records has started. -
290051 Alarm reporting that the export of records was completed. | --
290052 Alarm reporting that the export of records was canceled Ensure that the structure of the records at the
due to an error. storage location and the current recipe structure
on the HMI device are identical.
290053 Alarm reporting that the import of records has started. -
290054 Alarm reporting that the import of records was completed. | --
290055 Alarm reporting that the import of records was canceled Ensure that the structure of the records at the
due to an error. storage location and the current recipe structure
on the HMI device are identical.
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A.2 System alarms

Number

Effect/causes

Remedy

290056

Error when reading/writing the value in the specified
line/column.
The action was canceled.

Check the specified line/column.

290057

The tags of the recipe specified were toggled from "offline"
to "online" mode.

Each change of a tag in this recipe is now immediately
downloaded to the PLC.

290058

The tags of the specified recipe were toggled from "offline"
to "online" mode.

Modifications to tags in this recipe are no longer
immediately transferred to the PLC but must be
transferred there explicitly by downloading a record.

290059

Alarm reporting that the specified record was saved.

290060

Alarm reporting that the specified record memory was
cleared.

290061

Alarm reporting that clearing of record memory was
canceled due to an error.

290062

The record number is above the maximum of 65536.
This record cannot be created.

Select another number.

290063

This occurs with the system function "ExportDataRecords"
when the parameter "Overwrite" is set to No.

An attempt has been made to save a recipe under a file
name which already exists.

The export is canceled.

Check the "ExportDataRecords" system function.

290064

Alarm reporting that the deletion of records has started.

290065

Alarm reporting that the deletion of records has
successfully completed.

290066

Confirmation request before deleting records.

290068

Security request to confirm if all records in the recipe
should be deleted.

290069

Security request to confirm if all records in the recipe
should be deleted.

290070

The record specified is not in the import file.

Check the source of the record number or record
name (constant or tag value).

290071

During the editing of record values, a value was entered
which exceeded the low limit of the recipe tag.
The entry is discarded.

Enter a value within the limits of the recipe tag.

290072

When editing record values, a value was entered which
exceeds the high limit of the recipe tag.
The entry is discarded.

Enter a value within the limits of the recipe tag.

290073

An action (e.g. saving a record) failed due to an unknown
error.

The error corresponds to the status alarm
IDS_OUT_CMD_EXE_ERR in the large recipe view.

290074

While saving, it was detected that a record with the
specified number already exists but under another name.

Overwrite the record, change the record number
or cancel the action.

290075

A record with this name already exists.
The record is not saved.

Please select a different record name.

290110

The default values could not be set due to an error.
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Number | Effect/causes Remedy
290111 The Recipes subsystem cannot be used. Recipe views Transfer the project to the device again, together
have no content and recipe-specific functions will not be with the recipes (the corresponding check box in
performed. the Transfer dialog must be checked).
Possible causes:
e An error occurred while transferring the recipes.
e The recipe structure was changed in ES. When the
project was downloaded again, the recipes were not
transferred with it. This means that the new
configuration data is not being transferred to the old
recipes on the device.
Table A-31 300000 - Alarm_S alarms
Number | Effect/causes Remedy
300000 Faulty configuration of process monitoring Change the PLC configuration.
(e.g. using PDiag or S7-Graph): More alarms are queued
than specified in the specifications of the CPU. No further
ALARM_S alarms can be managed by the PLC and
reported to the HMI devices.
300001 ALARM_S is not registered on this PLC. Select a controller that supports the ALARM_S
service.
Table A-32 310000 - Report system alarms
Number | Effect/causes Remedy
310000 An attempt is being made to print too many reports in Wait until the previous active log was printed.
parallel. Repeat the print job if necessary.
Only one log file can be output to the printer at a given
time; the print job is therefore rejected.
310001 An error occurred on triggering the printer. The report is Evaluate the additional system alarms related to
either not printed or printed with errors. this alarm.
Repeat the print job if necessary.
Table A-33 320000 - Alarms
Number | Effect/causes Remedy
320000 The movements have already been indicated by another | Deselect the movements on the other display
device. units and select the motion control screen on the
The movements can no longer be controlled. required display unit.
320001 The network is too complex. View the network in STL.
The faulty addresses cannot be indicated.
320002 No diagnosable alarm message (error) selected. Select a diagnostics alarm from the ZP_ALARM
The unit associated with the alarm message could not be | alarm screen.
selected.
320003 No alarm message (error) exists for the selected unit. The | Select the defective unit from the overview screen.
detail view cannot visualize any networks.
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Number | Effect/causes Remedy
320004 The required signal states could not be read by the PLC. | Check the consistency between the configuration
The faulty addresses cannot be found. on the display unit and the PLC program.
320005 The project contains ProAgent elements which are not In order to run the project, install the optional
installed. ProAgent diagnostic functions cannot be ProAgent package.
performed
320006 You have attempted to execute a function which is not Check the type of the selected unit.
supported in the current constellation.
320007 No error-triggering addresses were found on the Switch the detail screen to STL layout mode and
networks. check the status of the addresses and exclusion
ProAgent cannot indicate any faulty addresses. addresses.
320008 The diagnostic data stored in the configuration are not Transfer the project to the HMI device again.
synchronized with those in the PLC.
ProAgent can only indicate the diagnostic units.
320009 The diagnostic data stored in the configuration are not Transfer the project to the HMI device again.
synchronized with those in the PLC. The diagnostic
screens can be operated as usual.
ProAgent may be unable to show all diagnostic texts.
320010 The diagnostic data stored in the configuration are not Transfer the project to the HMI device again.
synchronized with those in STEP7.
The ProAgent diagnostics data is not up-to-date.
320011 A unit with the corresponding DB number and FB number | Check the parameters of the "SelectUnit" function
does not exist. and the units selected in the project.
The function cannot be executed.
320012 The "Step sequence mode" dialog is no longer supported. | Use the ZP_STEP step sequence screen from the
corresponding standard project for your project.
Instead of calling the
Overview_Step_Sequence_Mode function, call the
"FixedScreenSelection" function using ZP_STEP
as the screen name.
320014 The selected PLC cannot be evaluated for ProAgent. Check the parameters of the
The Alarm view assigned to the "EvaluateAlarmDisplayFault" system function.
"EvaluateAlarmDisplayFault" system function could not be
found.
Table A-34 330000 - GUI alarms
Number | Effect/causes Remedy
330022 Too many dialogs are open on the HMI device. Close all dialogs you do not require on the
HMI device.
330026 The password will expire after the number of days shown. | Enter a new password.
Table A-35 350000 - GUI alarms
Number Effect/causes Remedy
350000 PROFIsafe packages have not arrived within the Check the WLAN connection.

necessary period.
There is a communication problem with the F-CPU.

RT is terminated
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A.2 System alarms

Number Effect/causes Remedy
350001 PROFIsafe packages have not arrived within the Check the WLAN connection.
necessary period.
There is a communication problem with the F-CPU.
The PROFIsafe connection is re-established.
350002 An internal error has occurred. Internal error
Runtime is terminated
350003 Feedback concerning the connection established with | --
the F-CPU.
The Emergency-Off buttons are active immediately.
350004 PROFIsafe communication was set and the --
connection was cleared.
The Runtime can be terminated.
The Emergency-Off buttons are deactivated
immediately.
350005 Incorrect address configured for the F-slave. Check and modify the address of the F slave in
No PROFIsafe connection. WinCC flexible ES.
350006 The project has started. At the start of the project, the | Press the two enabling buttons one after another in
enabling buttons must be checked for functionality. the "Enable" and "Panic" positions.
350008 The wrong number of fail-safe buttons was Change the number of fail-safe buttons in the
configured. project.
No PROFlsafe connection.
350009 The device is in Override mode. Exit Override mode.
It may no longer be possible to detect the location
because transponder detection fails.
350010 Internal error: The device has no fail-safe buttons. Send the device back.
Worldwide contact person
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B.1 Abbreviations

ANSI
CPU
CsSv
CTS
DC
DCD
DHCP
DIL
DNS
DP
DSR
DTR
EAP
EMC
EN

Mobile Panel 277 IWLAN

American National Standards Institution
Central Processing Unit

Comma Separated Values

Clear To Send

Direct Current

Data Carrier Detect

Dynamic Host Configuration Protocol
Dual-in-Line (electronic chip housing design)
Domain Name System

Distributed I1/O

Data Set Ready

Data Terminal Ready

Extensible Authentication Protocol
Electromagnetic Compatibility
European standard

Engineering System

Components and modules endangered by electrostatic discharge
Ground

High Frequency

Human Machine Interface

International Electronic Commission
Institute of Electrical and Electronics Engineers
Interface

Input and Output

Internet Protocol

Industrial Wireless Local Area Network
Local Area Network

Light Emitting Diode

Media Access Control

Metal Oxide Semiconductor

Multipoint Interface (SIMATIC S7)
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B. 1 Abbreviations

MS
MTBF
n. c.
OoP
PC
PELV
PG
PLC
PPI
RAM
RJ45
RTS
RxD
SAR
SD Card
SELV
SP
SSID
STN
Sub-D
TAB
TCP/IP
TFT
TKIP
TLS
TxD
UL
USB
WEP
WINS
WLAN
WPA

318

Microsoft

Mean Time Between Failures
Not connected

Operator Panel

Personal Computer

Protective Extra Low Voltage
Programming device
Programmable Logic Controller
Point-to-Point Interface (SIMATIC S7)
Random Access Memory
Registered Jack Type 45
Request to send

Receive Data

Specific absorption rate
Security Digital Card

Safety Extra Low Voltage
Service Pack

Service set identifier

Super Twisted Nematic
Subminiature D (plug)
Tabulator

Transmission Control Protocol/Internet Protocol
Thin Film Transistor

Temporal Key Integrity Protocol
Transport Layer Security
Transmit Data

Underwriter’s Laboratory
Universal Serial Bus

Wired Equivalent Privacy
Windows Internet Naming Service
Wireless Local Area Network
Wi-Fi Protected Access
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"Transfer" mode

An operating mode of the HMI device in which an executable project is transferred from the
configuring PC to an HMI device.

Access point

The access point is a WLAN participant that also performs administrative functions on the
network.

Acknowledge
Acknowledgment of an alarm confirms that it has been noted.

Ad hoc network
Network without access point

Alarm logging

Output of user-specific alarms to a printer, in parallel to their output to the
HMI device screen.

Alarm, acknowledging
Acknowledgment of an alarm confirms that it has been noted.

Alarm, activated
Moment at which an alarm is triggered by the PLC or HMI device.

Alarm, deactivated
Moment at which the initiation of an alarm is reset by the PLC.

Alarm, user-specific

A user-specific alarm designates a certain operating status of the plant connected to the
HMI device via the PLC.
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Automation device

PLC of the SIMATIC S5 series such as the S5-115U

Automation system

Bootloader

Controller of the SIMATIC S7 series such as a SIMATIC S7-300

Used to start the operating system. Automatically started when the HMI device is switched
on. After the operating system has been loaded, the Loader opens.

Configuration software

Configuring PC

Display duration

EMC

Event

Field array

Flash memory

320

Software used to generate projects used for the purpose of process visualization.
An example of configuring software is WinCC flexible.

A configuring PC is a programming device or PC on which plant projects are created using
an engineering software.

Defines whether a system alarm is displayed on the HMI device and the duration of the
display.

Electromagnetic compatibility is the ability of electrical equipment to function properly in its
electromagnetic environment without influencing this environment.

Functions are triggered by defined incoming events. Events can be configured. Events which
can be assigned to a button include "Press" and "Release", for example.

Area reserved in configured screens for the input and output of values.

Non-volatile memory with EEPROM chips, used as mobile storage medium or as memory
module installed permanently on the motherboard.
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Function keys

Key on the HMI device which supports user-specific functions. A function is assigned
to the key in the configuration. The assignment of the keys may be specific to an active
screen or not.

Half Brightness Life Time

Time period after which the brightness reaches 50 % of the original value. The specified
value is dependent on the operating temperature.

Hardcopy
Output of the screen content to a printer.

HMI device

An HMI device is a device used for the operation and monitoring of machines and plants.
The statuses of the machine or plant are indicated by means of graphic elements or by
indicator lamps on the HMI device. The operator controls of the HMI device allow the
operator to interact with the processes of the machine or plant.

HMI device image

A file that can be transferred from the configuring PC to the HMI device. The HMI device
image contains the operating system and elements of the runtime software required to
run a project.

I/0 field

An 1/O field enables the input or output of values on the HMI device which are transferred
to the PLC.

Infotext

An infotext is a configured information on objects within a project. Infotext for an alarm,
for example, may contain information on the cause of the fault and troubleshooting routines.

Infrastructure mode
Network structure with access point

Object

An object is a component of a project. Example: screen or alarm. Objects are used to view or
enter texts and values on the HMI device.
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Operating element

Component of a project used to enter values and trigger functions. A button, for example,
is an operating element.

Plant
General term referring to machines, processing centers, systems, plants and processes
which are operated and monitored on an HMI device.

PLC
A PLC is a general term for devices and systems with which the HMI device communicates,
e.g. SIMATIC S7.

PLC job

A PLC job triggers a function for the PLC at the HMI device.

Process visualization

Visualization of technical processes by means of text and graphic elements. Configured
plant screens allow operator intervention in active plant processes by means of the input and
output data.

PROFINET

Within the framework of Totally Integrated Automation (TIA), PROFINET represents an
enhancement of the following bus systems:

e PROFIBUS DP as well-established fieldbus
® |ndustrial Ethernet as the communications bus for the cell level

The experience gained from both systems has been and continues to be integrated in
PROFINET. PROFINET as an Ethernet-based automation standard from PROFIBUS
International (PROFIBUS Nutzerorganisation e.V.) defines a vendor-independent
communications and engineering model.

PROFINET 10 controller

Device used to address the connected IO devices. That is: The 10 controller exchanges
input and output signals with assigned field devices. The 10 controller is often the controller
on which the automation program runs.

PROFINET IO device

A decentralized field device that is assigned to one of the 10 controllers
(e.g. remote 10, valve terminals, frequency converters, switches)
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PROFINET 10

Project

Project file

As part of PROFINET, PROFINET IO is a communication concept that is used to implement
modular, distributed applications.

PROFINET IO allows you to create automation solutions of the type with which you are
familiar from PROFIBUS.

PROFINET IO is implemented by the PROFINET standard for automation devices on the
one hand, and on the other hand by the STEP 7 engineering tool.

This means that you have the same application view in STEP 7 regardless of whether you
configure PROFINET devices or PROFIBUS devices. Programming your user program is
essentially the same for PROFINET 10 and PROFIBUS DP if you use the expanded blocks
and system status lists for PROFINET IO.

Result of a configuration using a configuration software. The project normally contains
several screens with embedded system-specific objects, basic settings and alarms.
The project file of a project configured in WinCC flexible is saved with the file name
extension *.hmi.

You need to distinguish between a project on the configuring PC and that on an HMI device.
A project may be available in more languages on the configuring PC than can be managed
on the HMI device. The project on the configuring PC can also be set up for different

HMI devices. Only the runtime project that has been generated for the respective HMI device
can be transferred to it.

File generated from the runtime project file for use on the HMI device. The project file is
normally not transferred and remains on the configuring PC.

The file name extension of a source file is *.hmi.

Project file, compressed

Recipe

Compressed format of the project file. The compressed project file can be transferred
together with the runtime project file to the respective HMI device. For this purpose,
backtransfer must be enabled in the project on the configuring PC. The compressed project
file is normally stored on an external memory card.

The file extension of a compressed file is *.pdz.

Combination of tags forming a fixed data structure. The data structure configured can be
assigned data on the HMI device and is then referred to as a record. The use of recipes
ensures that all the assigned data is transferred synchronously to the PLC during the
transfer of a record.

Runtime project file

File generated from the project file for a specific HMI device. The runtime project file is
transferred to the corresponding HMI device and used to operate and monitor plants.

The extension of a compressed file is *.pdz.
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Runtime software

Screen

Screen object

STEP 7

The runtime software is a process visualization software used to test a project on a
configuring PC.

Form of the visualization of all logically related process data for a plant. The visualization of
the process data can be supported by graphic objects.

Configured object used to display or operate the plant, e.g. rectangle, 1/O field or alarm view.

STEP 7 is the programming software for SIMATIC S7, SIMATIC C7 and
SIMATIC WinAC PLCs.

Symbolic 1/O field

System alarm

Tab sequence

Tag

Transfer

Transponder

WLAN

324

A symbolic 1/O field is a field for the input and output of the value. Contains a list of default
entries from which one can be selected.

A system alarm is assigned to the "System" alarm class. A system alarm refers to internal
states on the HMI device and the PLC.

During configuration, this defines the sequence in which objects are activated on pressing
the <TAB> key.

Defined memory location to which values can be written to and read from. This can be done
from the PLC or the HMI device. Based on whether the tag is interconnected with the PLC
or not, we distinguish between "external" tags (process tags) and "internal" tags.

Transfer of a runtime project from the configuring PC to the HMI device.

A transponder is a — normally wireless — communication, display or control device, which
records incoming signals and automatically replies to them. The term transponder is derived
from transmitter and responder. Transponders can be passive or active.

WLAN is a radio-based LAN.
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A

Accessories
Accessory kit, 18, 21, 23
Accessory kit, 18
Charging station, 21
Transponder, 23
Acknowledge
Alarm, 238
Error alarm, 238
Activate
Password protection, 127
Ad hoc mode, 45
Address assignment
TCP/IP network, 150
Addressing, 147
Admin, 230, 231
Agency, 6
Alarm, 233
Acknowledge, 238
Alarm indicator, 235
Display, 235
Editing, 239
Functional scope, 24
Alarm buffer, 234
Functional scope, 24
Alarm class, 234, 237
Alarm event, 233
Alarm group, 234
Alarm indicator, 235
Alarm line, 235
Alarm log, 234
Alarm report, 234
Alarm view, 235
Extended, 236
Simple, 236
Alarm window, 237
ALARM_S, 24
Alphanumerical
Screen keyboard, 205
Alphanumerical value
Changing, 206
Entering, 206
Ambient conditions
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Climatic, charging station, 41

Climatic, HMI device, 40
Climatic, transponder, 41
Mechanical, 39

Tested for, 40

Applications

Mobile Panel 277 IWLAN, [15

Audit, 27
Authorization, 223
Automatic

Automation License Manager, 191

B

Transfer, 171

Backlighting

Reducing, 133
Setting, 117

Backtransfer, 169, 173

Backup, 116, 158, 168, 175, 176, 178, 224
Registry information, 117, 131

Temporary files, 131

to external memory medium, 116
To external storage device, 158

To memory card, 158
With ProSave, 178
With WinCC flexible, 176

Backup time

Internal clock, 276

Bar, 212
Basic knowledge

Required, 4

BAT

LED, 82

BAT 1

LED, 101

BAT 2

LED, 101

Batteries

Charging in the charging compartment, 100

Battery, 209

Application, 209
Charging options, 20
Layout, 209

LED display, 72
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Maintenance cycle, 267
Operation, 209
Purpose, 19
State, 162
Battery charging status
Vibration alarm, 140
Battery status
Display, 72, 117
Booting, 137
Bridging battery, 19
Changing, 74
Insert, 70
Safety instruction, 73, 74, 75
Bridging time, 93
Brightness
Changing, 133
Browser
Homepage, 116
Setting, 116
Bus connection, 27
Byte assignment
Direct keys, 87

C
Calibrating
Touch screen, 125
Care, 267
CE approval, 30
Certificate
Delete, 116, 157
Display, 116

Importing, 116, 157
Certificates, 116
Certifications, 30
Changing
Brightness, 133
Screen setting, 133
User data, 230
Character repeat, 116
Screen keyboard, 123
Setting, 123
Charging
Electrostatic, 286
Charging options
Battery, 20
Charging station, 19
Charging compartment, 100
Clearance, 43
Configuration, 20
EMC-compliant installation, 35
LED display, 101
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Lock, 102
Main dimensions, 273
Mounting location, 42
Mounting position, 50
Charging status of battery
Vibration alarm, 140
Climatic
Transport conditions, 37
Closing
Project, 231
Column sequence
Alarm view, 237
COM
LED, 82
Commissioning engineers, 3
Compeatibility conflict, 176
Configuration phase, 21
Configure
Network, 148
Operating system, 105
Screen keyboard, 116, 121
Configuring PC, 21
Connecting, 62
Connection graphic, 62
Connecting
Configuring PC, 62
PLC, 64
Printer, 65
USB device, 66
Connection, 27
Electrical, 54
Connection graphic
Configuring PC, 62
PLC on Mobile Panel, 64
Printer, 65
Connection to PLCs
Number, 27
Control Panel
Open, 116
Operating, 118
Password protection, 107
Screen keyboard, 118
Cookies, 116, 155
Country code, 110
Creating
Recipe data record, 252, 259
Users, 228
C-Tick mark (Australia), 31
Currency, 117
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D

Data channel
Enabling, 141
Locking, 141
Parameter assignment, 117, 141
Data flow, 245
Data record list, 247, 258
Data transfer rate
to Access Point, 111

Date, 116
Entering, 207
Setting, 128

Synchronizing, 129
Date format, 117, 130
Date/time properties, 116, 128
Deactivating
Password protection, 128
Decimal, 203
Default Gateway, 150
Degree of protection
Safety instruction, 60, 158, 181
Delay time
Setting, 117, 144
Delete
Certificate, 157
Recipe data record, 254, 261
Users, 231
Design variations, 16
Device name
For network operation, 149
Setting, 117
DHCP, 150
Direct key, 86, 197
Bit coding, 88
Byte assignment, 87
Functional scope, 26
Reaction time, 90
Display
Alarm, 235
Battery status, 72
HMI device information, 117
Infotext, 208, 238
Memory information, 140
Specifications, 275
System information, 139
Display format, 203
Disposal, [7
DNS, 1151
Server, 147
Documentation
Conventions, 6
Enclosed, 49
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Getting started, 4
Operating instructions, 5
User manual, 4
Double-click, 116
Setting, 124
Drop down list box, 207

E

EC Declaration of Conformity, 31
Editing
Alarm, 239
Recipe data record, 253, 260
Electrical
Installation, 54
Electrostatic charging, 286
Electrostatic discharge
Precautions, 287
Element list, 247, 258
E-mail
Setting, 117, 153
EMC, 35
Guideline, 30
Emission, 34, 36
Encryption, 155
Entering
Alphanumerical value, 206
By means of function key, 200
Date, 207
Numerical value, 204
Recipe data record, 265
Symbolic value, 207
Text box, 202
Time, 207
Error alarm
Acknowledge, 238
ESD
Abbreviations, 285
Labeling, 285
Safety instruction, 53
Ethernet settings
IP address, 150
Evaluation
Operator control, 80
Exporting
Recipe data record, 263
Extended alarm view, 236
Extended recipe view, 246
Extended user view, 226
External memory medium
Backup to, 158
Restoring from, 158
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F

Factory settings
Resetting to, 181
Feedback
Optical, 199
Front view, 16, 271
Function keys
Global function assignment, 200
Input via, 200
Labeling, 95
Local function assignment, 200
Function test, 77
Functional scope
Alarm buffer, 24
ALARM_S, 24
Alarms, 24
Device-specific, 26
Graphics list, 24
Infotext, 26
Limit value monitoring, 24
Log, 25
Recipe, 25
Safety, 26
Scaling, 24
Screen, 25
Tag, 24
Text list, 24
Functions
Additional, 26

G

Gauge, 213
Graphics list
Functional scope, 24

H

Handwheel
Application, 91
Evaluate incremental values, 91
Operating, 84
Reaction time, 90
High frequency radiation, 30
HMI device
Holding, 98, 99
Information, 117, 138
LED display, 81
Ports, 61
Restart, 137
Restarting, 117
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Specifications, 275
Switch off, 77
Switching on, 76
Testing, 76
HMI Input Panel
Options, 121
Homepage
Internet, 154
Host cable
Safety instruction, 63

Identification, 152
Illuminated pushbutton
Application, 92
Bit assignment, 92
Operating, 86
Importing
Certificate, 157
Recipe data record, 264
Infotext
Display, 208, 238
Functional scope, 26
Initial startup, 169
Input Panel, 116
Input unit, 80
Specifications, 275
Installation
Electrical, 54
EMC-compliant, 35
Installing
Option, 168, 188, 190
Interference
Pulse-shaped, 35
Sinusoidal, 36
Internal clock, 129, 276
Internet
Homepage, 154
Options, 116
Search engine, 154
Security settings, 116
Service, 7, 269
Settings, 117, 153
Support, 7, 269
Internet Explorer, 108
Internet options
Privacy, 156
IP address
Ethernet, 150
Setting, 116, 117
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K

Keyboard
Safety instruction, 80
Keyboard properties, 116, 123
Key-operated switch
Application, 91
Bit assignment, 91
Operating, 85

L

Labeling
Function keys, 95
Labeling strips, 18
Attaching, 97
Dimensions, 96
Exchange, 97
Printing, 95
LAN connection, 116, 117
Language change
Functional scope, 26
Layout
Battery, 209
Slider control, 214
Sm@rtClient view, 220
Trend view, 216
LED
BAT, 82
BAT 1, 101
BAT 2, 101
COM, 82
POWER, 101
PWR, 82
RNG, 82
SAFE, 82
LED display
Battery, 72
Charging station, 101
HMI device, 81
LED function key
Application, 90
Bit assignment, 90
License key, 191
Transferring, 168, 192
Transferring back, 168, 193
Limit value
For password, 224
For user, 224
For user view, 224
Limit value monitoring
Functional scope, 24
Limit value test, 203
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Loader
Buttons, 105
Open, 107
Log
Functional scope, 25
Logbook
WLAN connection, 115
Logoff
Users, 228
Logoff time, 224
Logon
Users, 226
Logon data, 152

M

Main battery, 18, 19
Changing in good time, 73
Insert, 71

Main battery change
Block of USB interface, 66

Main dimensions
Charging station, 273
Mobile Panel 277 IWLAN, 271

Maintenance, 267, 268

Maintenance technicians, 3

Manual
Production sequence, 266
Transfer, 170

Mechanical
Transport conditions, 37

Memory
Specifications, 275

Memory card, 18
Inserting, 94
Restoring file system, 131
Unplug, 95

Memory information, 117
Display, 140

Memory management, 117, 163

Mobile Panel
Applications, 15
Design variations, 16
Front view, 16
Information, 138
Main dimensions, 271
Ports, 61
Rear view, 17
Side view, 17
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Ports, 276

Monitor setting
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Changing, 117
Monitoring mode
Sm@rtClient view, 220
Mounting location
Charging station, 42
Transponder, 47
Mounting position
Charging station, 50
Mouse properties, 116, 124
Multi-key operation, 198, 200
Multimedia card, 18, 93

N

Name server, 151
Setting, 116, 117
Network
Configure, 148
Logon data, 117
Set up, 147
Setting, 150
Network & dial-up connections, 117
Network and dial-up connections, 116
Network ID, 117
Network operation
Device name, 149
Options, 117, 153
Nominal voltage, 44
NOTE
License key, 188
Number format, 117, 130
Numerical
Screen keyboard, 203
Numerical value
Changing, 204
Decimal places, 203
Display format, 203
Entering, 204
Limit value test, 203

o

Offices, 6

Offline
Operating mode, (166
Recipe tag, 250
Test, 174

ON/OFF button, 83

Online
Operating mode, (166
Recipe tag, 250
Test, 174
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OP properties, 117
Device, 138
Memory monitoring, 163
Persistent storage, 131
Touch, 125
Open
Loader, 107
Operating
Control Panel, 118
Feedback, 199
Handwheel, 84
llluminated pushbutton, 86
Key-operated switch, 85
Recipe menu, 258
Recipe screen, 251|, 258
Slider control, 214
Switches, 215
Trend view, 217
With external keyboard, 198
With external mouse, 198
Operating instructions
Purpose of, 3
Scope, 4
Operating mode, 166
Changing, 166
Offline, 166
Online, 166
Transfer, 76, 167
Operating safety
Standards, 32
Operating system
Configure, 105
Update via ProSave, 183
Updating, 180, 181
Updating using WinCC flexible, 182
Operation
Battery, 209
Operation feedback, 199
Operator control
Evaluation, 80
Functions, 80
Recipe view, 251
Selection, 80
Simple recipe view, 257
Operators, 3
Optical feedback, 199
Option
Installing, 168, 188
Installing with ProSave, 190
Installing with WinCC flexible, 188
Removing, 168, 188
Removing with ProSave, 190
Removing with WinCC flexible, 189

Mobile Panel 277 IWLAN
Operating Instructions, 04/2008, 6AV6 691-1DM01-2AB0



Index

Options, 27
Network operation, 117, 153

P

Parameter assignment
Data channel, 117, 141
Password, 224
Backup, 224
Restoring, 224
Specifying, 127
Password list, 224
Password properties, 117, 127
Password protection, 107, 117
Activate, 127
Deactivating, 128
PELV, 33
Peripherals
Rated load, 66
Permission in remote control, 222
Pin assignment
RJ45 socket, 278
USB socket, 278
PLC
Connecting, 64
Connection graphic, 64
Number, 27
Protocol, 27
Reading recipe data record, 255, 261
Transferring recipe data record, 256, 262
PLC_User, 230, 231
Ports, 61
Mobile Panel 277, 276
POWER
LED, 101
Power failure, 176, 180
Power management, 82
Power Save 1, 83, 133
Power Save 2, 83, 133
Power supply, 33
Charging station, 33
Tabletop power supply unit, 34
Precautions
Electrostatic discharge, 287
Printer
Connecting, 65
Connection graphic, 65
Setting, 117
Printer connection
Setting, 135
Printer properties, 117, 136
Printing
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Labeling strips, 95
Via network printer, 148
Production sequence
Manual, 266
PROFINET, 147
Addressing, 147
PROFINET IO
Disabling direct keys, 145
Enabling direct keys, 145
Setting, 117
Project
Closing, 231
Offline testing, 174
Reuse, 167
Testing online, 174
Transferring, 168
Project file, compressed
Memory location, 144
Proper use, 30

Protection against ingress of solid foreign bodies, 44

Protection against water, 44
Protective foil, 18
Protocol
PLC, 27
Proxy
Server, 116, 153, 155
Setting, 116
PWR
LED, 82

R

Radiation
High frequency, 30
Radio interference, 34
Emission, 36
Rate Control, 111
Rated load
USB interface, 66
Reading
Recipe data record, 255
Reading out
Recipe data record, 261
Real-time clock
Internal, 129
Rear view, 17
Recipe, 242
Control, 243
Data flow, 245
Data record, 243
Field of application, 241
Functional scope, 25
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Recipe screen, 246
Recipe view, 246
Synchronizing tags, 254
Recipe data record
Creating, 252, 259
Delete, 254, 261
Editing, 253, 260
Entering, 265
Exporting, 263
Importing, 264
Reading from PLC, 255, 261
Synchronize with PLC, 253
Transferring to PLC, 256, 262
Recipe list, 247, 258
Recipe menu
Operating, 258
Recipe screen, 248
Operating, 251, 258
Overview, 248
Recipe tag
Offline, 250
Online, 250
Synchronizing, 249, 254
Recipe view, 246
Extended, 246
Menu items, 258
Operator control, 251, 257
Simple, 247
Recommissioning, 169
Recycling, 7
Regional and language settings, 117, 130
Regional settings, 130
Registered trademarks, 6
Registry information
Backup, 117, 131
Regulations for the prevention of accidents, 29
Remote control
Forcing permission, 222
Start, 221
Removing
Option, 168, 188, 189, 190
Repairs, 268
Replacement key set, 269
Reset button, 61
Resetting to factory settings with ProSave, 186
Resetting to factory settings with WinCC flexible, 184
Restore, 116, 158
Restoring, 168, 175, 177,179, 224
from external memory medium, 116
From external storage device, 158
From memory card, 131
With ProSave, 179
With WinCC flexible, 177
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Restoring factory settings, 63, 168, 181
Return Center, 268
RJ45 socket
Safety instruction, 61
RNG
LED, 82
Rotary coding switch
Transponder, 51
Ruler
Trend view, 217

S

SAFE
LED, 82
Safe electrical separation, 33
Safety
Functional scope, 26
Standards, 32
Safety instruction
Backlighting, 134
Bridging battery, 73, 74, 75
Changed tag name, 254
Compeatibility conflict, 176
Compressed project file, 169
Data channel, 181
Data loss, 180
Degree of protection, 60, 158
Degree of protection, 181
Direct key, 197
Electrostatic charging, 286
ESD, 53
General, 34
High frequency radiation, 30
Keyboard, 80
Leaving the WLAN coverage area, 197
License keys, 181
Malfunctions, 56, 69, 93
Memory card, first use, 94
Memory distribution, 140
Multi-key operation, 198
Observe grounding measures, 287
Path, 144
Power failure, 176, 180
Power supply, 33
Preventing inadvertent operation, 267
Project file, 144
Recipe data record in the background, 247
Restart, 137
RJ45 socket, 61
Sample cycle time, 90
Storage, 37
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Switching infotext, 208
Time-dependent reactions, 129
Touch screen, 80
Transfer mode, 143
Transfer mode channel 2, 143
Transport, 37
Unintentional action, 200
Unintentional transfer mode, 142
USB connection sequence, 63
USB Host-to-Host cable, 63
USB interface, 66
Safety regulations, 29
SAR, 36
Scaling
Functional scope, 24
Scope of delivery, 49
Screen
Functional scope, 25
Screen keyboard, 116, 201
Adjust size, 120
Alphanumerical, 205
Change layout, 119
Character repeat, 123
Configure, 121
For Control Panel, 118
Keyboard level, 205
Language change, 205
Move, 120
Numerical, 203
Representation types, 119
Screen saver, 117, 134
Setting, 133
Screen setting
Changing, 133
Search engine
Internet, 154
Security settings, 116
Security system, 223
Selection
Operator control, 80
Service
On the Internet, 7, 269
Service pack, 268
Service technicians, 3
Set up
Network, 147
Setting
Backlighting, 117
Browser, 116
Character repeat, 123
Date, 128
Date format, 130
Date/Time, 116
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Delay time, 117, 144

Device name, 117

Double-click, 124

E-mail, 117

E-mail connection, 153

IP address, 116, 117

Language, 201

Name server, 116, 117

Network, 150

Number format, 130

Printer connection, 135

PROFINET 10, 117

Proxy, 116

Regional data, 130

Screen saver, 133

Time, 128

Time format, 130

Transponder ID, 53
Setting language, 201
Settings

Internet, 117

Language, 117

Regional, 117
Side view, 17, 272
Siemens HMI input panel options, 116
SIMATIC Logon, 223
Simple alarm view, 236
Simple recipe view, 247

Menu items, 258

Operator control, 257
Simple user view, 225
Slider control, 214
Sm@rtAccess, 27
Sm@rtClient view, 220, 221

Monitoring mode, 220

Usage, 220
Sm@rtService, 27
SMTP server, 153
Software options, 27
Sort order

Alarm view, 237
Specifications

Display, 275

HMI device, 275

Input unit, 275

Memory, 275

Mobile Panel 277 IWLAN, 276

Supply voltage, 276, 277

Weight, 277
Standard input unit, 80
Start

HMI device, 137
Status Force, 218

333



Index

Touch operation, 219
Subnet Mask, 150
Supply voltage, 277

Specifications, 276
Support

On the Internet, 7, 269
Switch off

HMI device, 77
Switches, 215
Switching on

HMI device, 76
Symbolic value

Changing, 207

Entering, 207
Synchronizing

Date and time, 129

Recipe tag, 249, 254
System, 139
System alarm

Meaning, 287

Parameters, 287
System functions, 86
System information, 117

Display, 139
System properties, 117

Device name, 149

General, 139

Memory, 140

T

Tabletop power supply unit, 19, 61
Connecting, 67
Tag
Functional scope, 24
Task planner
Functional scope, 26
TCP/IP address, 150
Technical support, 7
Temporary files
Backup, 131
Test
For ambient conditions, 40
Test voltages, 44
Testing
HMI device, 76
Text box, 202
Text list
Functional scope, 24
Time, 116
Entering, 207
Setting, 128
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Synchronizing, 129
Time format, 117, 130
Time zone

Setting, 128
Time-dependent reactions, 129
Touch screen

Calibrating, 117, 125

Safety instruction, 80
Training center, 7
Transfer, 167, 168, 169

Automatic, 171

Cancel, 77

Manual, 170
Transfer mode

Unintentional, 142
Transfer settings, 117, 141

Channel, 141
Transfer Settings

Directories, 144
Transferring

License key, 168, 192

Project, 168

Recipe data record, 256, 262
Transferring back

License key, 168, 193
Transponder, 19, 46

Detect, 47, 48

Inserting the battery, 53

Installation, 54

Mounting location, 47

Rotary coding switch, 51
Transponder ID

Setting, 53
Transport conditions, 37
Transport damage, 49
Trend view, 216
Trends

Functional scope, 26

Limit violation, 216

V)

UL approval, 31
Unintentional action, 198, 200
Unintentional transfer mode, 142
Updating

About ProSave, 183

Operating system, 180

Using WinCC flexible, 182
Updating the operating system, 168
Usage

Conditions, 39
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In industry, 34
In residential areas, 34
With additional measures, 39
UsSB
Connection sequence, 63
USB connection sequence
Safety instruction, 63
USB device
Connecting, 66
USB FlashDrive, 18
USB interface
Block during main battery change, 66
Rated load, 66
USB socket, 61
Pin assignment, 278
USB stick, 18
User data
Backup, 224
Changing, 230
Restoring, 224
User group, 223
User manual, 4
User name, 152
User view, 225
Extended, 226
Simple, 225
Users, 224
Admin, 230, 231
Creating, touch operation, 228
Delete, 231
Logoff, 228
Logon, 226
PLC_User, 230, 231

\Y

Value table

Trend view, 216
VBScript

Functional scope, 26
Vibration alarm, 117

Activate, 140
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W

Weight, 277

WinCC flexible internet settings, 117
E-mail, 153

Windows CE taskbar, 105
Password protection, 107

WINS, 151
Server, 147

Wireless approval, 31

WLAN
Authentication, 113
Encryption, 113
Interface, 278
Network key, 113
Password, 113

WLAN connection
Logbook, 115

WLAN network
Connect, 113

WLAN networks
Connection sequence, 114
Creating new, 113
Display available, 112
Parameter assignment, 113

WLAN quality, 210
Application, 210
Operation, 210

WLAN range, 47

Y4

Zone, 45
Calculating quality, 212
Detect, 48

Zone name, 211
Layout, 211
Operation, 211

Zone quality, 211
Application, 211
Layout, 211
Operation, 212

Zones
Testing, 175
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SIEMENS
SIMATIC HMI

Mobile Panel 277 IWLAN

Produktinformation

Giltigkeit

Die vorliegende Produktinformation gilt fir das Bediengerat Mobile Panel 277 IWLAN mit folgenden Bestellnummern:
- 6AV6 645-0DD01-0AX0 - 6AV6 645-0FD01-0AX0

- 6AV6 645-0DE01-0AX0 - 6AV6 645-0FE01-0AX0

Diese Produktinformation enthalt wichtige Hinweise. Die Hinweise erganzen die Betriebsanleitung fiir das Bediengerat und
sind den Aussagen in der Betriebsanleitung, in den Release Notes und in der Online-Hilfe in der Verbindlichkeit
Ubergeordnet.

Powermanagement

ACHTUNG

Meldungen im Energiesparmodus unsichtbar

Im Energiesparmodus wird das Display des Bediengeréats je nach Einstellung abgedunkelt ("Power Save 1") oder
ausgeschaltet ("Power Save 2"). Wenn Meldungen auftreten, wahrend der Energiesparmodus aktiv ist, dann bleibt die
Anzeige abgedunkelt oder ausgeschaltet. In diesem Fall sind Meldungen nur schwer oder nicht erkennbar.

Hinweis

Wenn Sie das Bediengerat mit externer Spannungsversorgung betreiben, dann wird nach zwei Minuten ohne Bedienung
automatisch der Energiesparmodus "Power Save 1" aktiviert. Das Display wird abgedunkelt.

Betriebssystem aktualisieren Giber ProSave

ACHTUNG

Betriebssystem aktualisieren nur (iber Ethernet und USB
Das Aktualisieren des Betriebssystems uber ProSave ist nur tber Ethernet und USB freigegeben.
Verwenden Sie ProSave, Version 7.4.2 oder hoher.

Projektierung

ACHTUNG

HSP Mobile Panel 277 Wireless V1.1 erforderlich
Verwenden Sie zur Projektierung des Bediengerats ausschlieflich die Software "HSP Mobile Panel 277 Wireless V1.1".

Uberbriickungsbatterie

Hinweis
Das Bediengerat wird in der ersten Lieferstufe ohne Uberbriickungsbatterie geliefert.
Um die Hauptbatterie zu wechseln, beenden Sie das laufende Projekt und schalten Sie das Bediengerat aus.

© Siemens ®2009
A5E02098200-04, 04/2009



Umgebungstemperatur

Das Bediengerét ist fiir den Betrieb bei einer Umgebungstemperatur von 0 °C bis 40 °C ausgelegt.

Hinweis
Laden der Batterien

Befindet sich das Bediengerat im produktiven Betrieb, dann werden beide Batterien in der Ladestation bis zu einer
Umgebungstemperatur von 40 °C vollstédndig geladen.

Ist das Bediengeréat eingeschaltet und in der Ladestation eingehéngt, dann gilt:
e Die Ladung der Batterien im Bediengerat bleibt bis zu einer Umgebungstemperatur von 40 °C erhalten.
e Die Batterien in der Ladestation werden bis zu einer Umgebungstemperatur von 35 °C vollstandig geladen.

LED-Anzeigen

Hinweis
Sobald sich das Bediengerét in der Ladestation befindet und Ladekontakt hat, blinkt die LED "BAT". Stellen Sie sicher, dass
das Bediengerat zum Laden der Batterien korrekt in die Ladestation eingehangt ist.

Spezifikation der USB-Schnittstelle

Hinweis
Die USB-Schnittstelle darf ausschlielich zur Inbetriebnahme und fir Wartungszwecke verwendet werden.
Die Leitungslange der angeschlossenen USB-Gerate darf maximal 3 m betragen.

Transponderbetrieb — Frequenzbéander

Hinweis

Beim Transponderbetrieb mit automatischer Zonenerkennung wird das 2,4-GHz-Band exklusiv vom Mobile Panel IWLAN
genutzt.

Fir den WLAN-Betrieb muss das 5-GHz-Band (IEEE 802.11a) verwendet werden.

Der gleichzeitige Einsatz anderer RFID-Systeme im 2,4-GHz-Band ist nicht mdéglich (z. B. MOBY U oder MOBY R-Systeme).

Access Point — drahtlose Kommunikation

Hinweis
Die Kommunikation mit mehr als einem Access Point zur Abdeckung eines groReren WLAN-Bereichs ist nicht
unterbrechungsfrei moglich.

Bei drahtloser Ethernet-basierter Kommunikation, z. B. bei PROFINET IO, HTTP, Sm@rtAccess, Sm@rtService und OPC,
ist der Endnutzer fir die Sicherheit des Datennetzes verantwortlich. Das sichere Funktionieren des Bediengerates kann
nicht unter allen Umstanden garantiert werden. Stérungen, die von aufen auf das Funknetz wirken, kénnen z. B. zu einer
Uberlastung des Bediengerits fiihren.

Die "Storm Threshold"-Funktion beim Siemens Access Point SCALANCE muss aktiviert sein. Diese Aktivierung ist flir einen
stabilen Anlagenbetrieb auch bei hoher Netzlast notwendig. Fiir Broadcast-Telegramme ist Folgendes einzustellen:

® Address Threshold: 255
® Wireless: 255.

PROFINET IO

Hinweis
Um die Sicherheit Ihrer Applikation zu verbessern, fragen Sie in Ilhrer CPU-Applikation das Lebensbit ab.

Ladestation
Die Ladestation entspricht der Schutzklasse Ill nach EN 61131-2:2007 und EN 60950-1:2006

Siemens AG
Industry Sector
Postfach 48 48
90026 NURNBERG
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SIEMENS
SIMATIC HMI

Mobile Panel 277 IWLAN

Product Information

Validity

This product information is valid for the HMI device Mobile Panel 277 IWLAN with the following order numbers:
- 6AV6 645-0DD01-0AX0 - 6AV6 645-0FD01-0AX0

- 6AV6 645-0DE01-0AX0 - 6AV6 645-0FE01-0AX0

This product information contains important information. The notes supplement the operating instructions for the HMI device
and take precedence over statements in the operating instructions, the release notes, and in the online help.

Power management

NOTICE

Alarms not visible in power-save mode

Depending on the setting, the display of the HMI device will either be dimmed ("Power Save 1") or turned off
("Power Save 2"). The display will stay dimmed or turned off in case of alarms while in power-save mode. It will be difficult
or impossible to see any alarms in this case.

Note

If you operate the HMI device with external voltage supply, the device will switch to power-save mode "Power Save 1" after
two minutes without input. The display will be dimmed.

Updating the operating system using ProSave

NOTICE

Update of operating system via Ethernet and USB only
Update of the operating system with ProSave has been approved via Ethernet and USB only.
Use ProSave, Version 7.4.2 or higher.

Configuring

NOTICE

HSP Mobile Panel 277 Wireless V1.1 required
Configure the HMI device only with the software "HSP Mobile Panel 277 Wireless V1.1".

Bridging battery

Note
The HMI device will be supplied in delivery stage 1 without bridging battery.
To replace the main battery, exit the running project and turn off the HMI device.

© Siemens ®2009
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Ambient temperature

The HMI device has been designed for use with ambient temperatures ranging from 0°C to +40 °C.

Note
Charging the batteries

With the HMI device in productive operation, the batteries will be fully charged in the docking station up to an ambient
temperature of 40 °C.

When the HMI device is turned on and resting in the docking station, the following applies:
e Battery charge in the HMI device is retained up to an ambient temperature of 40 °C.
® The batteries in the docking station will be fully charged up to an ambient temperature of 35 °C.

LED display

Note

The "BAT" LED will start flashing as soon as the HMI device is placed in the docking station and charging begins. Make sure
that the HMI device is correctly positioned in the docking station for charging of batteries.

Specification of USB interface

Note
Use the USB interface for commissioning and maintenance only.
The line length of the connected USB devices may not exceed 3 m.

Transponder operation - frequency bands

Note

For transponder operation with automatic zone detection, the 2.4 GHz band will be used exclusively by the Mobile Panel
IWLAN.

WLAN operation requires the 5 GHz band (IEE 802.11a).
It is not possible to operate other RFID systems in the 2.4 GHz band at the same time (z. B. MOBY U or MOBY R systems).

Access Point - wireless communication

Note
Communication with more than one access point to cover larger WLAN areas is not possible without interruption.

For wireless Ethernet-based communication, for example, with PROFINET IO, HTTP, Sm@rtAccess, Sm@rtService and
OPC, the end user is responsible for the security of the data network. The secure operation of the HMI device cannot be
guaranteed under all circumstances. Interference from outside the wireless network can cause an overload of the HMI
device, for example.

The "Storm Threshold" function in the Siemens Access Point SCALANCE must be selected. This option has to be selected
to ensure stable plant operation when the load on the network is high. The following settings have to be made for broadcast
message frames:

® Address threshold: 255
® Wireless: 255.

PROFINET IO

Note
To improve the safety of your application, request the life sign bit in your CPU application.

Charging station
The charging station corresponds to safety class Ill according to EN 61131-2:2007 and EN 60950-1:2006.
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Information produit

Validité

La présente information produit est valable pour le pupitre opérateur Mobile Panel 277 IWLAN avec les numéros de
référence suivants :

- 6AV6 645-0DD01-0AX0 - 6AV6 645-0FD01-0AX0

- 6AV6 645-0DE01-0AX0 - 6AV6 645-0FE01-0AX0

Cette information produit contient des indications importantes. Les remarques complétent les instructions de service du
pupitre opérateur et, en cas de conflit avec les indications des instructions de service, des Release Notes et de l'aide en
ligne, c'est a elle que vous devez vous reporter.

Gestion de I'alimentation

IMPORTANT

Alarmes invisibles en mode d'économie d'énergie

En mode d'économie d'énergie, I'écran du pupitre opérateur est sombre ("Power Save 1") ou éteint ("Power Save 2") selon
le paramétrage. Si des alarmes sont générées pendant que le mode d'économie d'énergie est actif, I'écran est sombre ou
éteint. Dans ce cas, les alarmes sont difficilement ou pas du tout reconnaissables.

Remarque

Quand vous utilisez le pupitre opérateur avec une alimentation externe, le mode d'économie d'énergie "Power Save 1"
s'active automatiquement au bout de deux minutes sans intervention de l'opérateur. L'écran est sombre.

Mise a jour du systéme d'exploitation via ProSave

IMPORTANT

Mise a jour du systéme d'exploitation uniquement via Ethernet et USB
La mise a jour du systéme d'exploitation via ProSave n'est validée que via Ethernet et USB.
Utilisez ProSave, Version 7.4.2 ou une version ultérieure.

Configuration

IMPORTANT

HSP Mobile Panel 277 Wireless V1.1 requis
Utilisez pour la configuration du pupitre opérateur uniquement le logiciel "HSP Mobile Panel 277 Wireless V1.1".

Pile de sauvegarde

Remarque
Le pupitre opérateur est livré sans pile de sauvegarde a la premiére version.
Pour remplacer la pile principale, quittez le projet en cours et mettez le pupitre opérateur hors tension.

© Siemens ®2009
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Température ambiante

Le pupitre opérateur est congu pour une utilisation a des températures ambiantes de 0 °C a 40 °C.

Remarque
Charge des batteries

Si le pupitre opérateur est en mode de production, les deux batteries sont entierement chargées dans le chargeur jusqu'a
une température ambiante de 40 °C.

Si le pupitre opérateur est en marche et accroché dans le chargeur
® | acharge des batteries dans le pupitre opérateur est conservée jusqu'a une température ambiante de 40 °C.
® | es batteries dans le chargeur sont entierement chargées jusqu'a une température de 35 °C.

DEL de signalisation

Remarque

La DEL "BAT" clignote dés que le pupitre opérateur est dans le chargeur et que le contact de charge est établi. Assurez-
vous que le pupitre est accroché correctement dans le chargeur pour la charge des batteries.

Spécification de l'interface USB

Remarque
L'interface USB ne peut étre utilisée que pour la mise en service et a des fins de maintenance.
La longueur de cable maximale des appareils USB connectés est de 3 m.

Mode transpondeur — bandes de fréquence

Remarque

En mode transpondeur avec détection automatique de zone, la bande 2,4 GHz est utilisée exclusivement par le Mobile
Panel IWLAN.

Pour le mode WLAN, il faut utiliser la bande 5 GHz (IEEE 802.11a).

L'utilisation simultanée d'autres systéemes RFID dans la bande 2,4 GHz n'est pas possible (par ex. des systemes MOBY U
ou MOBY R).

Point d'accés — communication sans fil

Remarque

La communication avec plus d'un point d'accés afin de couvrir une zone WLAN plus importante n'est pas possible sans
interruption.

En cas de communication sans fil basée sur Ethernet, par ex. avec PROFINET IO, HTTP, Sm@rtAccess, Sm@rtService et
OPC, c'est I'utilisateur final qui est responsable de la sécurité du réseau de données. Le fonctionnement sir du pupitre
opérateur ne peut pas étre garanti dans tous les cas. Les parasites qui agissent de I'extérieur sur le réseau radio, par
exemple, peuvent provoquer une surcharge du pupitre opérateur.

La fonction "Storm Threshold" doit étre activée pour le point d'accés Siemens SCALANCE. Cette activation est nécessaire
pour que le fonctionnement de l'installation soit stable méme quand la charge du réseau est élevée. Pour les télégrammes
Broadcast, il faut effectuer le paramétrage suivant :

® Address Threshold : 255

® Wireless : 255.

PROFINET IO

Remarque
Afin d'améliorer la sécurité de votre application, interrogez le bit de vie dans votre application CPU.

Chargeur
Le chargeur correspond a la classe de protection Ill selon EN 61131-2:2007 et EN 60950-1:2006.
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Informazioni sul prodotto

Validita

Le seguenti informazioni sul prodotto si riferiscono al pannello operatore Mobile Panel 277 IWLAN con i seguenti numeri di
ordinazione:

- 6AV6 645-0DD01-0AX0 - 6AV6 645-0FD01-0AX0

- 6AV6 645-0DE01-0AX0 - 6AV6 645-0FE01-0AX0

Le presenti informazioni sul prodotto contengono avvertenze importanti. Le avvertenze sono da considerarsi parte integrante
delle Istruzioni operative del pannello operatore e hanno valore di veridicita superiore a quello delle Informazioni contenute
nelle Istruzioni operative, nelle Note di rilascio e nella Guida in linea.

Power Management

ATTENZIONE

Segnalazioni non visualizzate nella modalita a risparmio energetico

Nella modalita a risparmio energetico il display del pannello operatore viene oscurato ("Power Save 1") o disattivato
("Power Save 2") a seconda dell'impostazione. Se appaiono delle segnalazioni quando la modalita a risparmio energetico
e attiva, la visualizzazione rimane oscurata o disattivata. In questo caso ¢ difficile o impossibile riconoscere le
segnalazioni.

Nota

Se si utilizza il pannello operatore con alimentazione di tensione esterna, dopo due minuti di inattivita viene attivata
automaticamente la modalita a risparmio energetico "Power Save 1". Il display viene oscurato.

Aggiornamento del sistema operativo mediante ProSave

ATTENZIONE

Aggiornamento del sistema operativo solo mediante Ethernet e USB
L'Aggiornamento del sistema operativo mediante ProSave ¢ abilitato solo mediante Ethernet e USB
Utilizzare ProSave, versione 7.4.2 o superiore.

Progettazione

ATTENZIONE
Richiesta di HSP Mobile Panel 277 Wireless V1.1
Per la progettazione del pannello operatore utilizzare esclusivamente il software "HSP Mobile Panel 277 Wireless V1.1".

Batteria tampone

Nota
Il primo livello di fornitura del pannello operatore non contiene la batteria tampone.
Per cambiare la batteria tampone terminare il progetto in corso e spegnere il pannello operatore.

© Siemens ®2009
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Temperatura ambiente

Il pannello operatore & adatto al funzionamento con temperatura ambiente di 0 °C ... 40 °C.

Nota
Caricamento delle batterie

Se il pannello operatore si trova in esercizio produttivo, entrambe le batterie vengono completamente caricate nella stazione
di carica fino a una temperatura ambiente di 40 °C.

Se il pannello operatore & attivato e appeso nella stazione di carica vale quanto segue:
e |l caricamento delle batterie nel pannello operatore viene mantenuto fino a una temperatura ambiente di 40 °C.
® | e batterie nella stazione di carica vengono caricate completamente fino a una temperatura ambiente di 35 °C.

LED

Nota

Non appena il pannello operatore si trova nella stazione di carica e ha contatto di carica, il LED "BAT lampeggia. Per il
caricamento delle batterie assicurarsi che il pannello operatore sia correttamente appeso nella stazione di carica.

Specifica dell'interfaccia USB

Nota
L'interfaccia USB deve essere utilizzata esclusivamente per la messa in funzione e a scopo di manutenzione.
La lunghezza dei conduttori dei pannelli operatore USB collegati non deve superare i 3 m.

Bande di frequenza nel funzionamento con trasponder

Nota

Nel funzionamento con transponder con riconoscimento automatico delle zone, la banda a 2,4 GHz viene utilizzata
esclusivamente dal Mobile Panel IWLAN.

Per il funzionamento WLAN deve essere utilizzata la banda a 5 GHz (IEEE 802.11a).
L'utilizzo simultaneo di altri sistemi RFID nella banda a 2,4 GHz non & possibile (ad es. sistemi MOBY U o MOBY R).

Comunicazione wireless mediante access point

Nota
La comunicazione con piu di un access point per la copertura di un campo WLAN piu grande non & possibile senza creare
interruzioni.

Nella comunicazione wireless basata su Ethernet, come PROFINET 10, HTTP, Sm@rtAccess, Sm@rtService e OPC,
I'utente finale & responsabile per la sicurezza della rete di dati. Il funzionamento sicuro del pannello operatore non pud
essere garantito in ogni circostanza. | disturbi esterni che hanno effetto sulla rete radiofonica possono ad es. determinare un
sovraccarico del pannello operatore.

La funzione "Storm Threshold" nell'Access Point SCALANCE di Siemens deve essere attivata. Questa attivazione &
necessaria per un funzionamento stabile dell'impianto anche in caso di elevato carico di rete. Per i telegrammi broadcast
devono essere effettuate le seguenti impostazioni:

® Address Threshold: 255
® Wireless: 255.

PROFINET IO

Nota
Per migliorare la sicurezza dell'applicazione, interrogare il bit di attivita nell'applicazione della CPU.

Stazione di carica
La stazione di carica corrisponde al grado di protezione Ill secondo EN 61131-2:2007 e EN 60950-1:2006.
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Informacion del producto

Validez

La presente informacion de producto es valida para el panel de operador Mobile Panel 277 con las referencias siguientes:
- 6AV6 645-0DD01-0AX0 - 6AV6 645-0FD01-0AX0

- 6AV6 645-0DE01-0AX0 - 6AV6 645-0FE01-0AX0

La presente Informacion de producto contiene indicaciones importantes. Las indicaciones complementan las instrucciones
de servicio del panel de operador y prevalecen sobre lo mencionado en las instrucciones de servicio, en las Release Notes
y en la Ayuda Online.

Power Management

ATENCION

Mensajes no visibles en el modo de ahorro de energia

En el modo de ahorro de energia, la pantalla del panel de operador se oscurece ("Power Save 1") o se apaga ("Power
Save 2") segun cémo esté ajustado. Si aparecen mensajes mientras esta activado el modo de ahorro de energia, la
pantalla permanece mas oscura o apagada. En este caso, los mensajes apenas pueden reconocerse.

Nota

Si utiliza el panel de operador con fuente de alimentacién externa, tras dos minutos sin operacion se activara
automaticamente el modo de ahorro de energia "Power Save 1". La pantalla se oscurece.

Actualizar el sistema operativo mediante ProSave

ATENCION

Actualizar el sistema operativo sélo via Ethernet y USB
La actualizacion del sistema operativo desde ProSave sélo esta liberada via Ethernet y USB.
Utilice ProSave, versioén 7.4.2 o superior.

Configuracion

ATENCION

HSP Mobile Panel 277 Wireless V1.1 necesario
Para configurar el panel de usuario utilice unicamente el software "HSP Mobile Panel 277 Wireless V1.1".

Bateria de puenteo

Nota
El panel de operador se suministra en la primera version sin bateria de puenteo.
Para cambiar la bateria principal cierre el proyecto activo y apague el panel de operador.
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Temperatura ambiente

El panel de operador esta disefiado para utilizarse a una temperatura ambiente de entre 0 °C y 40 °C.

Nota
Cargar las baterias

Si el panel de operador se encuentra en modo productivo, entonces las dos baterias se cargan por completo en la estacion
de carga hasta una temperatura ambiente de 40 °C.

Si el panel de operador esta encendido y colgado en la estacion de carga, rige lo siguiente:
® | acarga de las baterias en el panel de operador se mantiene hasta una temperatura ambiente de 40 °C.
® | as taberias se cargan por completo en la estacion de carga hasta una temperatura ambiente de 35 °C.

LEDs

Nota

ElI LED "BAT" parpadea en cuanto el panel de operador se encuentra en la estacion de carga y hace contacto. Asegurese
de que el panel de operador esta colgado correctamente en la estacidon de carga cuando se disponga a cargar las baterias.

Especificacion del puerto USB

Nota
El puerto USB puede utilizarse exclusivamente para la puesta en marcha y para fines de mantenimiento.
La longitud de cable de los dispositivos USB conectados no debera ser superior a 3 m.

Modo de transpondedor — bandas de frecuencia

Nota

En el modo de transpondedor con deteccién automatica de la zona, la banda de 2,4 GHz es utilizada exclusivamente por el
Mobile Panel IWLAN.

Para el funcionamiento con WLAN tiene que utilizarse la banda de 5 GHz (IEEE 802.11a).

El uso simultaneo de otros sistemas RFID en la banda de 2,4 GHz no es posible (p. ej. sistemas MOBY U o sistemas
MOBY R).

Access Point — comunicacion inaldmbrica

Nota

La comunicacion con mas de un Access Point para cubrir una zona de WLAN mas amplia no es posible sin interrupciones.
En la comunicacion inalambrica basada en Ethernet, p. ej. PROFINET IO, HTTP, Sm@rtAccess, Sm@rtService y OPC, el
usuario final es el responsable de la seguridad de la red de datos. El funcionamiento correcto del panel de operador no
puede garantizarse en cualquier circunstancia. Las interferencias externas sobre red inalambrica podrian p. ej. sobrecargar
el panel de operador.

La funcién "Storm Threshold" tiene que estar activada en el Siemens Access Point SCALANCE. Esta activacion es
necesaria para el funcionamiento estable de la instalacion, incluso a una carga de red elevada. Ajuste lo siguiente para los
telegramas broadcast:

® Address Threshold: 255
®  Wireless: 255.

PROFINET IO

Nota
Para mejorar la seguridad de su aplicacién, consulte el bit de sefial de vida en la aplicacion de la CPU.

Estacion de carga

La estacion de carga cumple la clase de proteccion 11l segin EN 61131-2:2007 y EN 60950-1:2006.
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Produktinformation

Gultigkeit

Diese Produktinformation enthalt wichtige Hinweise. Die Produktinformation ist guiltig fiir folgende Bediengerate:
® Mobile Panel 277 IWLAN, Bestellnummern 6AV6 645-0DD01-0AX0 und 6AV6 645-0DE01-0AX0.
® NMobile Panel 277F IWLAN, Bestellnummern 6AV6 645-0DB01-0AX0 und 6AV6 645-0DC01-0AX0

Funkzulassungen

AVORSICHT

Die folgende Ubersicht informiert Sie (iber die mdglichen Zulassungen.
Fir das Bediengerat selbst gelten nur die jeweils auf der Gerateruickseite angegebenen Zulassungen.

CE-Zulassung

C€

Die Produkte
® Mobile Panel 277 IWLAN, Bestellnummern 6AV6 645-0DD01-0AX0 und 6AV6 645-0DE01-0AX0.
® Mobile Panel 277F IWLAN, Bestellnummern 6AV6 645-0DB01-0AX0 und 6AV6 645-0DC01-0AX0

stimmen in der von Siemens A&D in Verkehr gebrachten Ausfiihrung mit den Vorschriften der folgenden europaischen

Richtlinie tberein:
99/5/EG

Richtlinie des européischen Parlaments und des Rates zur Angleichung der Rechtsvorschriften der Mitgliedstaaten tUber

Funkanlagen und Telekommunikationsendeinrichtungen und die gegenseitige Anerkennung ihrer Konformitét.

Die Konformitat mit den grundlegenden Anforderungen der Richtlinie wird nachgewiesen durch die Einhaltung folgender

Normen:

EN 60950 Sicherheit von Einrichtungen der Informationstechnik

EN 301489-1 Elektromagnetische Vertraglichkeit fiir Funkeinrichtungen und -dienste

EN 301489-17 Spezifische Bedingungen fir Breitband-Datenubertragungssysteme und fur Einrichtungen in lokalen
Hochleistungs-Funknetzen (HIPERLAN)

EN 300328 Elektromagnetische Vertraglichkeit und Funkspektrumangelegenheiten

EN 301893 Breitband-Funkzugangsnetze (BRAN) - 5-GHz-Hochleistungs-RLAN

EN 50371 Ubereinstimmung von elektronischen und elektrischen Geréten kleiner Leistung mit den
Basisgrenzwerten flr die Sicherheit von Personen in elektromagnetischen Feldern (10 MHz bis 300
GHz)

1999/519/EC Empfehlung des Rates zur Begrenzung der Exposition der Bevdlkerung gegeniber
elektromagnetischen Feldern (0 Hz . 300 GHz)

An das System angeschlossene Gerate miissen die relevanten Sicherheitsbestimmungen erfillen.
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EG-Konformitétserklarung

Die EG-Konformitatserklarung wird gemafR den obengenannten EG- Richtlinien fir die zustdndigen Behdrden zur Verfligung
gehalten bei:

Siemens Aktiengesellschaft
Bereich Automatisierungstechnik
A&D AS RD ST

Postfach 1963

D-92209 Amberg

Diese Erklarung bescheinigt die Ubereinstimmung mit den genannten Richtlinien, ist jedoch keine Zusicherung von
Eigenschaften.

Sie finden die EG-Konformitatserklarung zum Download im Internet unter http://support.automation.siemens.com.

UL-Zulassung

Underwriters Laboratories Inc. nach
e UL 508 (Industrial Control Equipment)
® (CSA C22.2 No. 142 (Process Control Equipment)

Die Zulassung wird nur bei Betrieb mit Batterie oder stationér in der Ladestation erfiillt.

FCC-Zulassung
This device complies with Part 15 of the FCC Rules.

Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and
(2) This device must accept any interference received, including interference that may cause undesired operation.

Changes or modifications made to this equipment not expressly approved by SIEMENS may void the FCC authorization to
operate this equipment.

Note

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the
FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment.

This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with
the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential
area is likely to cause harmful interference in which case the user will be required to correct the interference at his own
expense.

This device has been shown to be capable of compliance for localized specific absorption rate (SAR) for uncontrolled
environment / general public exposure limits specific in ANSI/IEEE C95.1-1992 and had been tested in accordance with the
measurement procedures specified in IEEE Std. 1528-2003 December 2003.

IC-Zulassung Kanada
Exposure to Radio Frequency (RF) Signals:

The wireless device is a radio transmitter and receiver. It is designed and manufactured not to exceed the emission limit for
exposure to radio frequency (RF) energy set by the Ministry of Health (Canada), Safety Code 6. These limits are part of
comprehensive guidelines and established permitted levels of RF energy for the general population. These guidelines are
based on the safety standards previously set by international standard bodies. These standards include a substantial safety
margin designed to assure the safety of all persons, regardless of age and health.

This device and its antenna must not be co-located or operating in conjunction with any other antenna or transmitter.

This device has been shown to be capable of compliance for localized specific absorption rate (SAR) for uncontrolled
environment / general public exposure limits specific in ANSI/IEEE C95.1-1992 and had been tested in accordance with the
measurement procedures specified in IEEE Std. 1528-2003.

Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN
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Landerzulassungen

/I\VORSICHT

Die folgende Ubersicht informiert Sie iiber die Funkzulassungen in verschiedenen Léndern.
Fir das Bediengerat selbst gelten nur die jeweils auf der Geraterlickseite angegebenen Funkzulassungen.

Die Funkzulassungen gelten fiir folgende Produkte:
® Mobile Panel 277 IWLAN, Bestellnummern 6AV6 645-0DD01-0AX0 und 6AV6 645-0DE01-0AX0
® Mobile Panel 277F IWLAN, Bestellnummern 6AV6 645-0DB01-0AX0 und 6AV6 645-0DC01-0AX0

Land Kennzeichnung | Zulassung erteilt Land Kennzeichnung | Zulassung erteilt
Australien 0 Luxemburg C€E0681 0O v
Belgien C€0681 O® v Niederlande C€E0681 ® v
Deutschland CE0681 0O v Norwegen C€E0681 0O v
Danemark CE0681 O v Osterreich CE0681 0 v
Finnland CE0681 0O v Portugal CE0681 0O v
Frankreich C€E0681 O v Schweden C€E0681 0O v
Griechenland C€E0681 O v Schweiz C€E0681 ® v
Grofbritannien C€E0681 O v Spanien C€E0681 O v
Irland C€E0681 O v Slidafrika

Island CE0681 0O v Taiwan «((

Italien CE0681 0O v Tschechien C€E0681 0O v
Japan @ Tarkei C€E0681 ®

Kanada Ic Ungarn CE0681 0O
Liechtenstein C€E0681 O v Vereinigte Staaten F@

von Amerika

Siemens AG
Industry Sector
Postfach 48 48
90026 NURNBERG

Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN
A5E01004934-02, 10/2008
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Product Information

Validity

This product information contains important information. This product information applies to the following HMI devices:
® Mobile Panel 277 IWLAN, order numbers 6AV6 645-0DD01-0AX0 and 6AV6 645-0DE01-0AXO0.
® Mobile Panel 277F IWLAN, order numbers 6AV6 645-0DB01-0AX0 and 6AV6 645-0DC01-0AX0

Wireless approvals

A\ caution

The following overview shows the approvals that may be available.
The approvals shown on the rear panel of each device apply to the HMI device itself.

CE approval

C€

The products
® Mobile Panel 277 IWLAN, order numbers 6AV6 645-0DD01-0AX0 and 6AV6 645-0DE01-0AXO0.
® Mobile Panel 277F IWLAN, order numbers 6AV6 645-0DB01-0AX0 and 6AV6 645-0DC01-0AX0

in the version put into circulation by Siemens A&D conform to the regulations of the following European directive:
99/5/EC

Directive of the European Parliament and of the Council relating to Radio Equipment and Telecommunications Terminal
Equipment and the Mutual Recognition of their Conformity.

Compatibility with the basic requirements of the guideline is verified by compliance with the following standards:

EN 60950 Safety of Information Technology Equipment

EN 301489-1 Electromagnetic Compatibility for Radio Equipment and Services

EN 301489-17 Specific requirements for broadband data transmission systems and for equipment in local high-
performance radio networks (HIPERLAN)

EN 300328 Electromagnetic Compatibility and Radio Spectrum Issues

EN 301893 Broadband radio access networks (BRAN) — 5 GHz high-performance RLAN

EN 50371 Compliance of low power electronic and electrical apparatus with the basic restrictions related to

human exposure to electromagnetic fields (10 MHz to 300 GHz)

1999/519/EC Council recommendation on the limitation of exposure of the general public to electromagnetic fields
(0 Hz to 300 GHz)

Devices connected to the system must meet the relevant safety regulations.

© Siemens ®2008
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EC Declaration of Conformity

The EC Declaration of Conformity is available for the responsible authorities according to the above-mentioned EC Directive
at the following address:

Siemens Aktiengesellschaft
Automation & Drives

A&D AS RD ST

PO Box 1963

D-92209 Amberg, Germany

This declaration certifies compliance with the directives named above, but does not guarantee any specific properties.

To download information on the EC Declaration of Conformity, go to http://support.automation.siemens.com.

UL approval

Underwriters Laboratories Inc., to
e UL 508 (Industrial Control Equipment)
® (CSA C22.2 No. 142 (Process Control Equipment)

The approval is only valid in the case of battery operation or when stationary in the charging station.

FCC approval
This device complies with Part 15 of the FCC Rules.

Operation is subject to the following two conditions:
(1) This device may not cause harmful interference, and
(2) This device must accept any interference received, including interference that may cause undesired operation.

Changes or modifications made to this equipment not expressly approved by SIEMENS may void the FCC authorization to
operate this equipment.

Note

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the
FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is
operated in a commercial environment.

This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with
the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential
area is likely to cause harmful interference in which case the user will be required to correct the interference at his own
expense.

This device has been shown to be capable of compliance for localized specific absorption rate (SAR) for uncontrolled
environment / general public exposure limits specific in ANSI/IEEE C95.1-1992 and had been tested in accordance with the
measurement procedures specified in IEEE Std. 1528-2003 December 2003.

IC approval Canada
Exposure to Radio Frequency (RF) Signals:

The wireless device is a radio transmitter and receiver. It is designed and manufactured not to exceed the emission limit for
exposure to radio frequency (RF) energy set by the Ministry of Health (Canada), Safety Code 6. These limits are part of
comprehensive guidelines and established permitted levels of RF energy for the general population. These guidelines are
based on the safety standards previously set by international standard bodies. These standards include a substantial safety
margin designed to assure the safety of all persons, regardless of age and health.

This device and its antenna must not be co-located or operating in conjunction with any other antenna or transmitter.

This device has been shown to be capable of compliance for localized specific absorption rate (SAR) for uncontrolled
environment / general public exposure limits specific in ANSI/IEEE C95.1-1992 and had been tested in accordance with the
measurement procedures specified in IEEE Std. 1528-2003.

Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN
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National approvals

A\ cruton

The following overview shows wireless approvals in a number of different countries.
The HMI device itself is certified in accordance with the wireless approvals shown on the rear panel labels.

The wireless approvals apply to the following products:
® Mobile Panel 277 IWLAN, order numbers 6AV6 645-0DD01-0AX0 and 6AV6 645-0DE01-0AX0
® Mobile Panel 277F IWLAN, order numbers 6AV6 645-0DB01-0AX0 and 6AV6 645-0DC01-0AX0

America

Country Identification Approval granted Country Identification Approval granted
Australia 0 Luxembourg CE0681 0O v
Belgium C€E0681 ® v The Netherlands C€0681 ® v
Germany C€0681 0@ Y Norway C€0681 @ d
Denmark C€0681 @ / Austria C€0681 @ /
Finiand C€0681 @ Y Portugal C€0681 @ d
France C€0681 @ / Sweden C€0681 @ /
Greece C€E0681 ® v Switzerland C€0681 O v
Great Britain C€E0681 O v Spain C€E0681 O v
Ireland C€E0681 ® v South Africa

Iceland CE€E0681 O v Taiwan ((

Italy C€E0681 ® v Czech Republic CE€ (g81 [0) v
Japan @ Turkey C€0681 0O

Canada Ic Hungary C€0681 O
Liechtenstein CE0681 ® v United States of F@

Siemens AG
Industry Sector
Postfach 48 48
90026 NURNBERG

Mobile Panel 277 IWLAN, Mobile Panel 277F IWLAN
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